CONFIDENTIAL INFORMATION

The information herein is the property of Ex Libris Ltd. or its affiliates and any misuse or abuse will result in economic loss. DO NOT COPY UNLESS YOU HAVE BEEN GIVEN SPECIFIC WRITTEN AUTHORIZATION FROM EX LIBRIS LTD.

This document is provided for limited and restricted purposes in accordance with a binding contract with Ex Libris Ltd. or an affiliate. The information herein includes trade secrets and is confidential.

DISCLAIMER

The information in this document will be subject to periodic change and updating. Please confirm that you have the most current documentation. There are no warranties of any kind, express or implied, provided in this documentation, other than those expressly agreed upon in the applicable Ex Libris contract. This information is provided AS IS. Unless otherwise agreed, Ex Libris shall not be liable for any damages for use of this document, including, without limitation, consequential, punitive, indirect or direct damages.

Any references in this document to third-party material (including third-party Web sites) are provided for convenience only and do not in any manner serve as an endorsement of that third-party material or those Web sites. The third-party materials are not part of the materials for this Ex Libris product and Ex Libris has no liability for such materials.

TRADEMARKS

"Ex Libris," the Ex Libris bridge, Primo, Aleph, Alephino, Voyager, SFX, MetaLib, Verde, DigiTool, Preservation, URM, Voyager, ENCompass, Endeavor eZConnect, WebVoyage, Citation Server, LinkFinder and LinkFinder Plus, and other marks are trademarks or registered trademarks of Ex Libris Ltd. or its affiliates.

The absence of a name or logo in this list does not constitute a waiver of any and all intellectual property rights that Ex Libris Ltd. or its affiliates have established in any of its products, features, or service names or logos.

Trademarks of various third-party products, which may include the following, are referenced in this documentation. Ex Libris does not claim any rights in these trademarks. Use of these marks does not imply endorsement by Ex Libris of these third-party products, or endorsement by these third parties of Ex Libris products.

Oracle is a registered trademark of Oracle Corporation.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Ltd.

Microsoft, the Microsoft logo, MS, MS-DOS, Microsoft PowerPoint, Visual Basic, Visual C++, Win32,

Microsoft Windows, the Windows logo, Microsoft Notepad, Microsoft Windows Explorer, Microsoft Internet Explorer, and Windows NT are registered trademarks and ActiveX is a trademark of the Microsoft Corporation in the United States and/or other countries.

Unicode and the Unicode logo are registered trademarks of Unicode, Inc.

Google is a registered trademark of Google, Inc.
# Table of Contents

## Part I  Introduction

**Chapter 1**  Introducing DigiTool ................................................................. 15  
  Staff Features in DigiTool ........................................................................ 15  
  Global Interface Features ........................................................................ 15  
  * Logging On ................................................................................. 15  
  * Context-Sensitive Help ..................................................................... 18  
  * Logging off ................................................................................... 18

**Chapter 2**  Searching in DigiTool ............................................................... 19  
  Resource Discovery Searching ................................................................ 19  
  Repository Searching ............................................................................. 21  
  * Digital Entity - Simple ................................................................... 21  
  * Digital Entity - Advanced ................................................................. 23  
  * Digital Entity - Results ................................................................... 24  
  * Metadata - Simple ......................................................................... 25  
  * Metadata - Advanced ..................................................................... 26  
  * Metadata - Results ........................................................................ 27

## Part II  Depositor

**Chapter 3**  Getting Started with Depositor ............................................ 31  
  Introducing the Deposit Module ............................................................... 31  
  * Features ......................................................................................... 31  
  * Diagram of Deposit Process ............................................................. 32  
  Registration and Logging On ................................................................. 32  
  * New DigiTool User: Request Profile ............................................... 33  
  * Registered DigiTool Users with Profiles ......................................... 35  
  * Entering the Deposit Module ............................................................ 35  
  * Logging Off .................................................................................... 36
Chapter 4  Submitting Deposits ................................................................. 37
  Depositing New Material ................................................................. 37
    Choosing a Workflow – Step 1 ......................................................... 37
    Defining Descriptive Metadata – Step 2 ........................................ 39
    Copyright and Access Rights – Step 3 ........................................... 39
    Uploading Files - Step 4 ................................................................. 40
    Previewing a Deposit – Step 5 ......................................................... 42
Chapter 5  Managing and Editing Deposits ............................................. 43
  Managing and Tracking Deposits ..................................................... 43
    Deposit Information Table .............................................................. 44
    Deposit Folders and Statuses ......................................................... 45
    Deposit Actions ............................................................................. 45
    E-Mail Notifications ....................................................................... 46
    Adding Deposit Notes .................................................................... 46
    Viewing Deposit Notes ................................................................... 47
    Filtering and Sorting Deposits ....................................................... 47
  Editing Deposits .............................................................................. 48
    Editing a Saved Draft .................................................................... 48
    Editing a Returned Deposit ........................................................... 49

Part III  Approver

Chapter 6  Getting Started as an Approver ............................................ 53
  Approval Module Features ............................................................... 53
  Interface Access .............................................................................. 53
    Logging On ..................................................................................... 54
    Context Sensitive Help ................................................................. 54
    Logging off .................................................................................... 54
Chapter 7  Deposit Management and Review ................................................................. 55
  Managing and Tracking Deposits ................................................................. 55
    Table View Setup ........................................................................... 55
    Approver Folders and Statuses .................................................. 56
    Approver Actions ................................................................. 57
    Full View ............................................................................. 57
    E-Mail Notifications .................................................................. 58
    Viewing Deposit Notes ......................................................... 58
    Adding Deposit Notes .......................................................... 59
    Adding Internal Notes .......................................................... 59
    Filtering and Sorting Deposits ............................................... 59
  Reviewing Deposits............................................................................ 60
    Updating Deposits ...................................................................... 60
  Post-Review Staff Decisions.............................................................. 62
    Return Deposits ........................................................................ 62
    Decline Deposits ....................................................................... 63
    Approve Deposits ...................................................................... 63

Part IV  Ingest

Chapter 8  Getting Started with Ingest............................................................... 67
  Ingest Module Features ......................................................................... 67
  Ingest Interface...................................................................................... 68
    Logging On ............................................................................... 68
    Folders View ........................................................................... 68
    Ingest Folders Table View ..................................................... 70
  Available Actions for Ingest Activities............................................. 71
    Edit .......................................................................................... 71
    Delete ....................................................................................... 71
    Activate ..................................................................................... 71
    Rollback ..................................................................................... 71
    View ................................................................................................ 72
    Track Activities .......................................................................... 72

Chapter 9  New Ingest Activity ........................................................................... 73
  Defining a New Ingest Activity .............................................................. 73
Enter Activity Parameters – Step 1 .......................................................... 74
  Name ........................................................................................................ 74
  Ingest Type .............................................................................................. 75
  Scheduling .............................................................................................. 78
  Assign To ............................................................................................... 78
  Note ........................................................................................................ 79
  Auto Rollback ......................................................................................... 79
  Select Task Chain .................................................................................. 79
Create New Task Chain – Step 2 ............................................................... 83
Activity Parameters – Step 3 ................................................................. 84
Upload – Step 4 ....................................................................................... 89
  Local Files – Manual Upload ................................................................. 89
  Server Files (NFS) .................................................................................. 91
  Remote Files ........................................................................................... 92
  Possible Actions After Uploading Files ................................................. 94

Chapter 10  Processing Ingests................................................................. 95
Ingest Flows.............................................................................................. 95
Task Chain................................................................................................. 96
Upload........................................................................................................ 96
Editing an Ingest Activity......................................................................... 97

Part V  Meditor

Chapter 11  Meditor Introduction and Interface ....................................... 101
Meditor Objects and Metadata ............................................................... 101
  Digital Entities ....................................................................................... 101
  Metadata Types .................................................................................... 102
The Meditor Interface .............................................................................. 102
  Title Bar ................................................................................................. 103
  Menu Bar ............................................................................................... 103
  Object Bar ............................................................................................ 104
  Operations Bar ...................................................................................... 104
  Launch Bar ........................................................................................... 105
  Navigation Tree .................................................................................... 105
Accessing the Meditor .......................................................................... 107
Chapter 12  Working with Objects

Creating New Objects

Creating a New Object
Duplicating an Object

Deleting, Refreshing, Closing, and Purging Objects
Delete Object
Refresh Object
Close Object
Purge Local Objects
Remove a Filestream/URL from an Object

Object Services

Navigation Tree
Last Accessed
Open on Local Drive
Manifestations
Includes
Part of

Viewing and Refreshing Objects

Linking Objects to Collections

Chapter 13  Working with Metadata

Creating New Metadata
Insert New Metadata
Open Template
Insert from Local Drive
Search Metadata

Editing Metadata
XML Editor
Editing XML Tags
Editing Functions for the XML Editor
Additional XML Editing Functions

MARC Metadata Editor
Editing Records
Available Editing Functions

Dublin Core Form Editor
Access Rights Form Editor ................................................................. 147

Copyrights ........................................................................................................ 148
Enable/Disable the Access Rights Metadata ...................................................... 148
Negating and Un-Negating a Condition ............................................................... 148
Operators ........................................................................................................... 148
Add New Access Rights Expression .................................................................... 148
Editing the Access Rights Expression ................................................................. 149
Insert Snippets .................................................................................................... 149
Grouping and Ungrouping Expressions .............................................................. 150

Saving Metadata ............................................................................................... 150
Locking/Unlocking Metadata .............................................................................. 151
Lock Metadata .................................................................................................... 151
Unlock Metadata ................................................................................................ 152

Updating, Refreshing, and Deleting Metadata ..................................................... 152
Updating the Metadata Description .................................................................... 152
Refreshing Metadata ........................................................................................... 153
Deleting Metadata from the Server .................................................................... 153

Chapter 14 Searches in Meditor........................................................................ 155
Access to Searches .............................................................................................. 155
Search .................................................................................................................. 155
Collection Management .................................................................................... 155 From Search ........................................................................................................ 156
Search in Repository ........................................................................................... 156
Search in Resource Discovery ............................................................................. 158
Search in External Databases ............................................................................. 158 From Collections ................................................................................................ 160 From Management ............................................................................................... 161

Chapter 15 Services, Administration, and Utilities .............................................. 163
Services ................................................................................................................. 163
Service History List ............................................................................................. 163
Retrieve Records from Silo (ret-01) ................................................................... 164
Print Records ....................................................................................................... 164
Build Indexes to the Silo ..................................................................................... 164
General ............................................................................................................... 165
Part VI Collection Management

Chapter 16 Getting Started with Collections ........................................ 185
About the Collection Management Module .................................. 185
Accessing the Collection Management Module ......................... 186
The Collection Management Module Interface ......................... 187
Collection Map ........................................................................... 188
Sub-Collection View .................................................................. 189
Building Collections .................................................................. 189
Creating Individual Collections or Sub-Collections .................. 190
Linking Objects to Itemized Collections .................................. 191
Linking Objects from the Meditor’s Editor ............................... 194
Working with Logical Collections ........................................ 195
Associating Metadata with a Collection .................................. 197
Managing Collections and Sub-Collections ......................... 201
Editing Collection Attributes ............................................... 201

Chapter 17 Collection Maintenance ................................................. 203
Publishing Collections ............................................................. 203
Creating Collections Based on Metadata Information ............... 205
Prerequisites ............................................................................. 205
Loading a Hard Disk and Creating a Collection ..................... 206
Integrating Collections in Resource Discovery ....................... 209

Part VII Jobs and Reports

Chapter 18 Job Management .......................................................... 213
How Jobs Work ........................................................................ 213
Chapter 19 Viewing Reports ................................................................. 229

Setting up BIRT Reports ................................................................. 229
    New Database Schema: rpt00 .................................................. 229
    Reports Location .................................................................... 230
    Reports Tab Contents .............................................................. 230
    New Report Creation .............................................................. 230

Accessing Reports......................................................................... 231

Global Report Functions.............................................................. 232

Viewing the Collection Distribution Summary Report ............... 233

Viewing the Delivery Usage Statistics Report............................ 235
    Restrictions ........................................................................... 236
    New and Updated Tables ....................................................... 237
    Adding More Tablespace ....................................................... 237
    Command line scripts ......................................................... 237
Updates to This Guide

This guide contains the following updates from DigiTool version 3.3 to DigiTool version 3.4:

Updates to the DigiTool Staff Guide

<table>
<thead>
<tr>
<th>Feature</th>
<th>Change Type</th>
<th>Chapter</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Link to Parent Relation</td>
<td>New Feature</td>
<td>18: Job Management</td>
<td>Job Descriptions on page 215</td>
</tr>
</tbody>
</table>
Part I

Introduction

Part I contains the following:

- Section 1: Introducing DigiTool on page 15
- Section 2: Searching in DigiTool on page 19
Introducing DigiTool

Staff Features in DigiTool

DigiTool staff features consist of Web-based and Windows client-based delivery of modules for uploading records and objects, searching for existing objects, creating and using templates for creating records, and using interfaces to view, organize, approve, and publish library records.

Global Interface Features

This section explains how to log on and off the DigiTool interface and use the context-sensitive online help.

Logging On

Staff users log on to the Web-based interface or the Windows-based Metadata Editor (Meditor) using similar methods, regardless of module.
To log on to the DigiTool Web interface:

1. Enter your institution’s DigiTool URL, which consists of hostname and port.
2. Add a slash and the name or abbreviation for the module following the port.

   http://<hostname>:JBOS_PORT/<modulename>

   For example:

   http://www.university.com:1801/webingest

   If you do not know the name or abbreviation of the module you want to enter, you can enter the main menu (modulename=main) and select from a list of modules (see Figure 1).

   ![Figure 1: Main DigiTool Menu]

When you select a module, the logon box opens with fields for User Name and Password (Figure 2). (Occasionally there will be an additional item requesting unit selection or user confirmation.)
3. Enter your user name and password and click **OK**. DigiTool opens the default page for the module you selected.

**To log on to DigiTool through the Meditor:**

1. Start the Meditor application from your Windows **Start** menu or by double-clicking a Meditor desktop icon if you have one.
   The DigiTool meditor logon dialog box opens (**Figure 3**).

2. Enter your **User Name** and **Password** in the fields.

3. **OPTIONAL:** Clear the **Save Password** check box if you are on a shared machine.
4 Click the OK button.

If your user name and password are valid, the Meditor window opens to the default module, with all modules appearing as buttons on the left-side Launch column and also available through text links in the footer of most pages.

Context-Sensitive Help

In order to assist you in routine workflows and scenarios, each page contains a context-sensitive help file that can be accessed by clicking the question mark button located on the top right side of the toolbar.

Logging off

When you have completed your work in the module, you can log off by clicking the open door button located on the top right side of the toolbar.
Searching in DigiTool

This section includes:
- Resource Discovery Searching on page 19
- Repository Searching on page 21

When you need to find a single object or a set of objects that share characteristics, you can use specific search tools within the DigiTool modules.

Resource Discovery Searching

The Resource Discovery search is available to all users, staff and patron, with access being restricted to some objects/collections according to user group profile and object classification.

The Resource Discovery search pages open under the following conditions:
- An end-user (or patron) accesses their library’s DigiTool application from a link
- A staff user clicks the Resource Discovery link from the main menu on the Web interface
- A user of the Meditor Windows client opens the Resource Discovery interface from within the Meditor

Figure 4 shows the opening Simple Search page for the Resource Discovery search with an overlay of the Advanced Search.
For detailed information about Resource Discovery searching and related features, including rules for using the Advanced search, see the Resource Discovery section of the DigiTool Configuration Guide.
Repository Searching

Repository searching is available to staff members who have been assigned rights to an administrative unit’s repository.

Users of the Management module access the Repository search immediately after logging on. The Repository section of the Management module opens to the Digital Entity Search tab, with the simple search open (as in Figure 5).

![Figure 5: Repository Simple Search](image)

From here, Management module users can conduct four searches of the repository:
- Digital Entity - Simple
- Digital Entity - Advanced
- Metadata - Simple
- Metadata - Advanced

Digital Entity - Simple

The Management module opens to this search when a user logs on (see Figure 5).

The Admin Unit field defaults to the user’s administrative unit.

The Find field is a drop-down box that allows the user to choose a field by which to narrow the search. See Figure 6.
NOTE:
Most selections from the Find field do not change the options of the relational field (default contains) or the text field. A few, however, such as date fields and fixed type fields, do change the values to provide more exact matching. Some allow for multiple selections. See, for example, FX. These values are taken from Meditor configurations.

The relational field defaults to contains, which functions as an any-word (OR) search. To perform an exact word or exact phrase search, select equals from the drop-down menu.
The user enters the remaining information in the text (or selection) field and clicks the **Search** button. Results display in the table below the search form. Sorting options are indicated by underlined fields and an up- or down-facing triangle on the selected field to indicate ascending or descending order. The default is PID ascending.

**Digital Entity - Advanced**

The advanced digital entity search is the same as the simple digital entity search except for the opportunity to enter multiple search criteria. After filling in one search row, users can click the **Add Condition** text link to add another (see **Figure 8**).
A connector field appears on the next line along with the repeated selection fields. The Boolean AND or AND NOT can be selected as the relationship between the previous line and the next.

This can be repeated as needed, and users may also delete a condition by clicking the Delete text in the row containing the condition.

**Digital Entity - Results**

Results for digital entity searches typically include links to the objects themselves in one or more formats and the metadata associated with the objects in a browser laid-out format or in an XML format.

Users can access these links from the results table (see Figure 9).

![Table of results](image)

**Figure 9: Results from Advanced Digital Entity Search**

Clicking either of the icons in the **Delivery** column will open a view of the object in a browser window (Figure 10).
Clicking either of the icons in the **Metadata** column opens a browser window with the object’s metadata formatted as text or as XML.

**Metadata - Simple**

The simple metadata search consists of a one-row search of objects by metadata classification and schema in addition to field. **Figure 11** shows a simple metadata search with the **Name** field drop-down selected. When a user chooses the classification/name, the **Type** field populates with all available types for that classification.
As with all other Repository searches, the Admin Unit field defaults to the unit to which the user belongs.

The user enters a search term in the Find field, the field name to search from the drop-down field, and clicks the Search button to conduct the search.

Results display in the table below the search form. (For an example, see Figure 12).

**Metadata - Advanced**

The advanced metadata search combines the simple metadata search capacity with the ability to add rows containing search terms and fields as many times as needed.

**Figure 12** shows a search of the repository descriptive metadata, Dublin Core, using three search terms for three specific fields. To add another row, click the Add Condition text link. To delete any row (except the first, which cannot be deleted), click the Delete text link.

The results are returned in the table below the search form.
Figure 12: Repository Metadata Search - Advanced - with Results

**Metadata - Results**

Users can sort the results by any field that is underlined. Clicking an underlined field moves the triangular arrow from the current sort field (MID in Figure 12) to the clicked field. Clicking the arrow toggles the sort order from ascending to descending.

Users can open metadata records by clicking one of the icons below the Views column:

- the browser icon for Digital Entity format of the metadata (Figure 13)
- the XML page icon for XML format of the metadata
Figure 13: Metadata in Digital Entity Format

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Circle of Youth (La Ronde)</td>
</tr>
<tr>
<td>Creator</td>
<td>Picasso, Pablo, 1881-1973</td>
</tr>
<tr>
<td>Subject</td>
<td>Dove (in art)</td>
</tr>
<tr>
<td>Subject</td>
<td>Classic Modernism</td>
</tr>
<tr>
<td>Publisher</td>
<td>Cannes,</td>
</tr>
<tr>
<td>Format</td>
<td>WM</td>
</tr>
<tr>
<td>Date</td>
<td>1961.</td>
</tr>
<tr>
<td>Created</td>
<td></td>
</tr>
<tr>
<td>Extent</td>
<td>2.25&quot; Intricate carved detail in gold leaf.</td>
</tr>
</tbody>
</table>

Figure 13: Metadata in Digital Entity Format
Part II contains the following:

- Section 3: Getting Started with Depositor on page 31
- Section 4: Submitting Deposits on page 37
- Section 5: Managing and Editing Deposits on page 43
Getting Started with Depositor

This section includes:
- Introducing the Deposit Module on page 31
- Registration and Logging On on page 32

Introducing the Deposit Module

The Deposit module is designed to support the submission of digital objects by end users and to support the approval of those submissions by staff users for inclusion in the institutional repository (for example, theses, dissertations, and so on).

The Deposit module consists of the following three parts:
- End user deposit interface
- Staff approval interface
- Management interface

This section focuses on the end user deposit interface of the Deposit module.

Features

The following are some of the main features of the Deposit module:
- Deposits are handled through an easy-to-use, wizard style, Web-based interface. The institution can easily create different wizard configurations depending on the type of material to be deposited.
- Form-based deposits for easy entry of descriptive metadata.
- Submissions made by specific Depositors (groups) can be assigned to specific Approvers for review prior to acceptance.
- Depositor profiles determine the size, number, and type of material the Depositors are allowed to submit.
The institution can impose format submission rules (for example, theses can be loaded in PDF format only).

The current status of each deposit is presented to the Depositor and Approver: Draft, Submitted, Returned, Resubmitted, Declined, and Approved.

Diagram of Deposit Process
The following diagram illustrates the deposit process and its variations.

![Deposit Process Diagram](image)

**Figure 14: Deposit Process Flows**

Registration and Logging On
This section consists of the following topics:

- New DigiTool User: Request Profile on page 33
- Registered DigiTool Users with Profiles on page 35
- Entering the Deposit Module on page 35
- Logging Off on page 36

If you are a new DigiTool user, you must register and obtain a deposit profile before logging on. If you are a new DigiTool user and you are authenticated through PDS, you will not have to fill out a registration form but you may need to request a profile and be assigned one by staff before you can log on as a Depositor. If you are a returning DigiTool user with an assigned deposit profile,
follow the instructions in Registered DigiTool Users with Profiles on page 35 for logging on.

**NOTE:**
If your institution has enabled PDS for Depositor logon and registration, you will be automatically registered and assigned a profile when you enter your username and password and select your institute. See Depositors and Deposit Profiles on page 65 of the DigiTool Configuration Guide for details.

**New DigiTool User: Request Profile**

If you are a new DigiTool user, and your institute has not enabled PDS automatic logon and authentication, you must register and obtain a Deposit profile before logging on to make deposits.

**To register as a new DigiTool user:**

1. In the address bar of your Web browser, enter the appropriate URL set by your institution. By default, this URL is:
   
   http://<hostname>:JBOS_PORT/deposit

   For example: http://www.university.com:1801/deposit

   A logon form opens.

![Figure 15: DigiTool Logon Form](image)
2 Click the **Register** button. The registration form opens.

![Registration Form Image]

2

3 Enter your information in the fields and click the **Submit** button. The Profile Request dialog box opens.

![Profile Request Dialog Box Image]

3

4 Select your administrative unit and enter a request note that will enable you to obtain a profile for submitting material to DigiTool through the deposit interface.

5 Click the **Send** button to submit the information.

**NOTE:**

If your institute is using PDS for automatic assignment of profiles, you may be directed to the opening Depositor page immediately. If not, you will have to wait for a staff member to approve your registration.
submission before you can have access to the Deposit module. When you are assigned a profile, you will receive an e-mail notification confirming that you can begin work in the Deposit module.

Registered DigiTool Users with Profiles

If you are already registered and you have a deposit profile, you can log on directly.

To log on to the Deposit module:

1. In the address bar of your Web browser, enter the appropriate URL set by your institution. By default, this URL is:
   http://<hostname>:JBOSS_PORT/deposit
   The logon form opens.
2. Enter your user name and password.
3. If you have the option of selecting an institute from a drop-down field, select your institute.
4. Click OK.

Entering the Deposit Module

After registration is confirmed, the Depositor accesses the Deposit module from the same URL as above, logs on, and sees the Folders view of the deposit interface. From here, the Depositor can choose to perform actions such as edit, delete, or add new information to new or existing deposits.

Figure 18: Depositor Opening View
Folder Navigation
Clicking Folders from any screen within the Deposit module returns you to the list of folders with the Draft folder selected.

Context-Sensitive Help
Each screen contains a context-sensitive help file that can be accessed by clicking the question mark button (?) located in the top right toolbar.

Logging Off
To log off from the Deposit module, click the open door button in the top right toolbar.
Submitting Deposits

This section covers each of the steps involved in the New Deposit Activity wizard.

This section includes:
- Depositing New Material on page 37

Depositing New Material

To submit material for deposit, click New Deposit Activity located on the top left toolbar.

Figure 19: Deposit Module Header

DigiTool lists the available object types/workflow submissions (see Figure 20).

Choosing a Workflow – Step 1

Specific workflows have been designed to accommodate the deposit of specific types of digitized material. The Depositor selects a workflow by choosing the appropriate object type from the list on the left side of the screen. A description of each object type workflow populates the right pane. Each workflow triggers its own wizard.
Choose type of object to be submitted

<table>
<thead>
<tr>
<th>Type of object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Standard</td>
<td>The following wizard will assist you with the submission of standard resources into the Institutional Repository. During the deposit process, you will be asked to fill in some information about the deposited material, e.g. Title, Date of creation, etc. Mandatory information is marked with an asterisk to the left of the field. Currently, we accept standard deposits in any format and up to a maximum of 6 files per deposit. Deposited items will not appear in the Institutional Repository until they have been checked and approved by the institution's staff.</td>
</tr>
<tr>
<td>Book in METS format</td>
<td></td>
</tr>
<tr>
<td>ETD - Thesis or Dissertation</td>
<td></td>
</tr>
<tr>
<td>Image</td>
<td></td>
</tr>
<tr>
<td>Manuscript</td>
<td></td>
</tr>
<tr>
<td>Audio/Video</td>
<td></td>
</tr>
</tbody>
</table>

Figure 20: Object Types/Workflow for Depositor

NOTE:
A highlighted number at the top right of the screen indicates the current step of the submission process.

Once you have chosen the object type, click Next.
Defining Descriptive Metadata – Step 2

Each submission workflow presents the Depositor with a form for entering metadata. Forms may contain mandatory and/or non-mandatory fields. (Fields defined as mandatory appear with an asterisk).

![Figure 21: Object Metadata Form](image)

Once you have entered descriptive metadata, click **Next** to move to the next step in the wizard.

Copyright and Access Rights – Step 3

The assertion of copyright and access rights section is also predefined as part of any given workflow. Typically, you are required to agree to a copyright statement before submitting any material. In addition, the available access rights are displayed. If only one access rights possibility is defined, it is selected automatically.

**NOTE:**

Available access rights are those restrictions that will be set and imposed on the delivery of deposited material once it is loaded into the repository.
Once assertion of copyright and access rights has been set, click Next to continue to the next step in the wizard.

**Uploading Files - Step 4**

In this step of the submission process, you upload the file or files to be deposited into the institutional repository. The institution has defined this step to allow for a specified number of files, file formats, and maximum size of files. For example, an institution may want to receive all theses in PDF format only. This can be defined as part of the thesis workflow that blocks all non-PDF documents from being uploaded.
To upload a file:

1. Click the **Browse** button to open up the drives available for browsing on your local PC.
2. Find the appropriate directory containing the file you would like to upload and select it.
3. Click **Open** in the Windows dialog box to send the location of the desired file to the DigiTool server.
4. You may enter a title or brief description of the file in the **Label** box. This label is displayed with the digital object in the DigiTool search interface.
5. You may enter a brief note concerning this file. The note can be viewed by the staff approver when reviewing the submitted material.
6. Follow steps 1 – 5 until all files have been added for upload.
7. Click **Next** to upload the files you chose.

The Brief Information and Confirmation screen opens.
NOTE:
To delete files after they have been uploaded to the Depositor, click Back. This displays the file name with the option of deleting the file by clicking the delete (X) button.

Previewing a Deposit – Step 5

In the fifth and final step of the deposit workflow, you have the opportunity to review and modify your deposit before submitting it for staff review. From the preview step, you have several options:

- **View uploaded files**: To view uploaded files, click on any uploaded file links at the top of the right side of the preview page. Your local file association application preferences are used to open files in this mode.

- **Save a deposit draft**: Save the deposit as a draft that can be edited at a later point by clicking the Save button. All saved deposits are saved in your Draft folder.

- **Submit a deposit**: Send the deposit for staff approval by clicking Submit. All submitted deposits are automatically designated as read-only.

- **Edit a deposit**: You can go back and edit any of the information that you entered, before saving or submitting the deposit, by clicking Back at any point in the wizard process.

- **Cancel the deposit**: Clicking Cancel at any point in the deposit submission process cancels the wizard and all information related to the deposit is lost.
Managing and Editing Deposits

This section includes:
- Managing and Tracking Deposits on page 43
- Editing Deposits on page 48

Managing and Tracking Deposits

This section contains the following topics:
- Deposit Information Table on page 44
- Deposit Folders and Statuses on page 45
- Deposit Actions on page 45
- E-Mail Notifications on page 46
- Adding Deposit Notes on page 46
- Viewing Deposit Notes on page 47
- Filtering and Sorting Deposits on page 47
When a user logs on to the Deposit module, the Folders view displays all deposit activity for that user.

Each folder name shows the number of user deposits in that state. The pane to the right of the folders displays detailed information on the selected folder to the left.

**Deposit Information Table**

Each row in a folder represents a unique deposit that has been saved or submitted by the Depositor. The column headings are as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Ordinal number of a deposit in the folder.</td>
</tr>
<tr>
<td>ID</td>
<td>Deposit ID Number in the system.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the deposit, taken from the metadata Deposit Form.</td>
</tr>
<tr>
<td>Type</td>
<td>The workflow used for the deposit.</td>
</tr>
<tr>
<td>Created on</td>
<td>The date the deposit was first created.</td>
</tr>
<tr>
<td>Submitted on</td>
<td>The date the deposit was submitted for approval.</td>
</tr>
<tr>
<td>Updated on</td>
<td>The last date the deposit was edited.</td>
</tr>
<tr>
<td>Action</td>
<td>The buttons represent actions that can be performed. Not all buttons are available in all folders</td>
</tr>
</tbody>
</table>
Deposit Folders and Statuses

Previous submissions can be viewed by clicking one of the status folders in the Folders list. (See Figure 25.) The statuses and options for actions are described in Table 2 below.

**NOTE:**
Clicking the **Folders** text link at the top of the folders list returns you to the default **Draft** folder from any page in the Deposit module.

Table 2. Deposit Folders

<table>
<thead>
<tr>
<th>Folder/Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Deposits that have been saved but not yet submitted. They are easily accessible for additional editing.</td>
</tr>
<tr>
<td>Submitted</td>
<td>Deposits that have already been submitted for approval. These deposits are viewable (read-only) but not editable.</td>
</tr>
<tr>
<td>Returned</td>
<td>Deposits that have been submitted by the Depositor, reviewed, and returned by the staff Approver. Once returned, the deposit moves from the <strong>Submitted</strong> folder to the <strong>Returned</strong> folder. Deposits are returned for corrections or additional information. Once any modifications are made, the Depositor resubmits the deposit to the staff Approver.</td>
</tr>
<tr>
<td>Resubmitted</td>
<td>Deposits that were returned by the staff Approver for additional editing and then resubmitted by the Depositor. These deposits can be viewed as read-only.</td>
</tr>
<tr>
<td>Declined</td>
<td>Deposits that have been declined by the staff Approver and can no longer be edited or submitted.</td>
</tr>
<tr>
<td>Approved</td>
<td>Deposits that have been approved by the staff Approver and can no longer be edited.</td>
</tr>
</tbody>
</table>

Deposit Actions

The following buttons indicate that an action can be performed on the deposit where the button appears. A status type may be associated with one or more buttons/actions.

Table 3. Deposit Actions

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eye/View</td>
<td>🕵️‍♂️</td>
<td>Opens corresponding deposit for viewing only</td>
</tr>
</tbody>
</table>
E-Mail Notifications

Each time a deposit changes status (e.g. from draft to submitted, from submitted to approved, etc.) an e-mail notification is automatically generated and sent to the appropriate recipient, either Approver or Depositor, depending on the specific change of status.

Adding Deposit Notes

Both the Depositor and the Approver can add deposit notes at any stage of the deposit lifecycle. Notes are viewable by both parties. This is a useful means of communication between staff Approver and Depositor so that they can relay helpful information to each another throughout the deposit lifecycle.

To add notes to a deposit:

1. Click a deposit to select/highlight it.
2. Click the Split Mode button to allow viewing of notes related to the selected deposit.
3. Click the Add Notes button to display a up a pop-up window where a note can be entered.
4. Click Save to append the note to the deposit-related notes.

NOTE:
In order to return to the non-split results view, click the Full Mode button, located in the top header of the results table.
Viewing Deposit Notes

You can view notes related to a deposit from within any folder. The notes are viewable by both the Depositor and the staff Approver responsible for the deposit.

To view deposit notes:

1. Click a deposit whose notes you wish to view.

2. Click the Split Mode button, located in the top header of the results table, to allow the viewing of notes related to the selected deposit.

Any note related to the deposit is displayed in the lower pane of the results table.

Filtering and Sorting Deposits

From any folder view, the sort and filter options are available from the table header located above the list of deposits. Deposits can be sorted by creation date, title, and type and filtered by dates on which deposits were submitted, created, or updated.

In order to sort the deposits, click the Sort By drop-down menu and choose creation date, title, or type. The folder list is automatically sorted according to the chosen parameter.

![Figure 26: Sort By Drop-Down Menu](image)

In order to filter deposits, click Filter. This displays a pop-up window with a calendar dialog box that can be used to enter date value ranges with which to filter the deposits.

![Figure 27: Depositor Filter Form](image)
For example, you may only want to view those deposits that were submitted between January 1, 2004 and February 15, 2004. This would be specified in the **Submit Date Filter** range. Once **Filter** is clicked, the folder views are filtered according to the date filter specified.

**NOTE:**
Once the filter is no longer needed, clicking **Remove Filter** returns the deposit folder view to the previous non-filtered state in which all deposits in the folder are displayed.

---

**Editing Deposits**

Deposits are generally edited during one of two statuses: Draft and Returned.

**Editing a Saved Draft**

Once the wizard process is complete and a draft deposit has been saved, the Depositor can access the saved draft for editing from the **Draft** folder. Click the **Edit** button (pencil) corresponding to the draft you want to edit.

The following tab-based view appears:

![Draft Deposit Opened for Editing](image)

Each tab represents a step in the original submission workflow:

- Descriptive Information
Within any of the above tabs, information can be updated and modified before submitting, saving, or canceling the deposit.

Within any of the tab steps, you can submit the deposit for approval. When a draft deposit is submitted, the deposit automatically leaves the Draft folder and populates the Submitted folder as read-only.

**Editing a Returned Deposit**

Deposits in the Returned folder have been submitted by the Depositor, reviewed, and then returned by the staff Approver. Once returned, the deposit moves from the Submitted folder to the Returned folder. Deposits are returned for corrections or additional information. Once any modifications have been made, the Depositor resubmits the deposit to the staff Approver.

Procedures for editing a returned deposit are identical to those described in **Editing a Saved Draft** on page 48.

Within any of the tab steps, you can resubmit the deposit for approval. When a returned deposit is resubmitted, the deposit automatically leaves the returned folder and populates the Resubmitted folder as read-only.
Part III

Approver

Part III contains the following:

- Section 6: Getting Started as an Approver on page 53
- Section 7: Deposit Management and Review on page 55
Getting Started as an Approver

This section focuses on the staff approval interface of the Deposit module.

This section includes:
- Approval Module Features on page 53
- Interface Access on page 53

Approval Module Features

Some of the main features of the Approver module are:
- Easy management of deposits.
- Easy workflows and notes, allowing interaction and tracking of the deposit lifecycle.
- Form-based deposits for easy metadata description.
- Depositors (groups) can be assigned to specific Approvers.
- Depositor profiles determine what types of materials the Depositor is allowed to load in addition to file and/or disk space quota.
- The institution can impose format submission rules (for example, theses can be loaded in PDF format only).
- The current status of each deposit is presented to the Approver. The system supports statuses such as Inbox, Approved, Returned, and Declined.

Interface Access

This section explains how to log on and off the Approver interface and use the context-sensitive online help.
Logging On

You must log on to the Approver interface using your Approver credentials.

**To log on to the Approver interface:**

1. In the address bar of your Web browser, enter the appropriate URL set by your institution. By default, this URL is:

   http://<hostname>:JBOS_PORT/approver

   For example:

   http://www.university.com:1801/approver

   A login screen opens.

2. Type an Approver user name and password.

3. Click OK. If the given Approver is authorized, an opening screen with the default view of the Inbox folder appears.

   The opening screen allows the Approver to view the different statuses of the Depositor’s deposits. In addition, the Approver can choose to perform actions such as edit, delete, or approve existing deposits.

Context Sensitive Help

In order to assist you in routine workflows and scenarios, each screen contains a context-sensitive help file that can be accessed by clicking the question mark button located on the top right side of the toolbar.

Logging off

When you have completed your work in the Deposit-Approval module, you can log off from the module by clicking the door button located on the top right side of the toolbar.
Deposit Management and Review

This section explains how to manage, track, and review deposits as an Approver.

This section includes:
- Managing and Tracking Deposits on page 55
- Reviewing Deposits on page 60
- Post-Review Staff Decisions on page 62

Managing and Tracking Deposits

This section explains the interface you see and the actions you can perform as a deposit Approver. It contains the following topics:
- Table View Setup on page 55
- Approver Folders and Statuses on page 56
- Approver Actions on page 57
- Full View on page 57
- E-Mail Notifications on page 58
- Viewing Deposit Notes on page 58
- Adding Deposit Notes on page 59
- Adding Internal Notes on page 59
- Filtering and Sorting Deposits on page 59

Table View Setup

The table view is the default view for viewing deposits in each folder. Each row represents a unique deposit that has been submitted for review by Depositors to the logged-on Approver responsible for these deposits.
The output data headings are described in the following table:

Table 4. Information from Deposits

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Ordinal number of a deposit in the folder.</td>
</tr>
<tr>
<td>ID</td>
<td>Deposit ID Number in the system.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the deposit, taken from the metadata form submitted by the Depositor.</td>
</tr>
<tr>
<td>Type</td>
<td>The workflow used for the deposit.</td>
</tr>
<tr>
<td>Created On</td>
<td>The date the deposit was first created.</td>
</tr>
<tr>
<td>Submitted On</td>
<td>The date the deposit was submitted for approval.</td>
</tr>
<tr>
<td>Updated On</td>
<td>The last date the deposit was edited.</td>
</tr>
<tr>
<td>Re-sub</td>
<td>Yes/No flag determining whether the deposit has been resubmitted</td>
</tr>
<tr>
<td>Action</td>
<td>The buttons represent actions that can be performed. Not all buttons are available in all folders.</td>
</tr>
</tbody>
</table>

**Approver Folders and Statuses**

Previous submissions can be viewed by clicking one of the status folders in the Folders list. (See Figure 29.) The statuses and options for actions are described in Table 5 below.

Table 5. Approver Folders

<table>
<thead>
<tr>
<th>Folder/Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox</td>
<td>Deposits in the Inbox folder have been submitted or resubmitted by any Depositor within the Approver’s group. The Approver has several available action options in the Inbox folder.</td>
</tr>
<tr>
<td>Approved</td>
<td>Deposits that appear in the Approved folder have been approved by the staff Approver and can no longer be edited.</td>
</tr>
<tr>
<td>Returned</td>
<td>Deposits in the Returned folder have been submitted by the Depositor, reviewed, and then returned by the staff Approver. Once returned, the deposit moves from the Inbox folder to the Returned folder. These deposits may no longer be edited by the Approver, but may be viewed as read-only. Deposits are returned for corrections or additional information. Once modifications have been made, the Depositor resubmits the deposit to the staff Approver.</td>
</tr>
</tbody>
</table>
Approver Actions

The following buttons indicate that an action can be performed on the deposit. A status type may be associated with one or more buttons/actions.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve a deposit</td>
<td>![✓]</td>
<td>Approves the corresponding deposit.</td>
</tr>
<tr>
<td>Return a deposit</td>
<td>![✗]</td>
<td>Returns the deposit to the Depositor for possible editing and resubmitting.</td>
</tr>
<tr>
<td>Decline a deposit</td>
<td>![═]</td>
<td>Declines the deposit without the option of editing and resubmitting.</td>
</tr>
<tr>
<td>Edit/update a deposit</td>
<td>![◉]</td>
<td>Allows the Approver to edit the deposit.</td>
</tr>
<tr>
<td>Delete a deposit</td>
<td>![✗]</td>
<td>Deletes the deposit from the database.</td>
</tr>
</tbody>
</table>

Full View

In addition to the default table view within folders, you may want to take advantage of the full view when reviewing deposits. The full view allows most of the relevant information related to the deposit to be viewed in a single window. Descriptive metadata, access rights, copyright information, and the file list are just a few of the pieces of information that may be viewed in the full view.

To view deposits in the full view mode:

1. Click to highlight the row corresponding to the deposit you want to view.
2. Click Full View located in the top table header.

From the full view, you can perform the following actions:

- Navigate through the folder’s deposits by clicking the Previous/Next links.
- Enter **Edit** mode and update the deposit.
- Return the deposit.
- Decline the deposit.
- Approve the deposit or approve and assign it.

![Figure 29: Full View of Deposit](image)

### E-Mail Notifications

Each time a deposit changes status (for example, from Inbox to Returned, or from Returned to Approved), an e-mail notification is automatically generated and sent to the appropriate recipient—either Approver or Depositor—depending on the specific change of status.

### Viewing Deposit Notes

You can view notes related to a deposit from within any folder. The notes can be viewed by both the Depositor and the staff Approver responsible for the deposit.

**To view deposit notes:**

1. Click a deposit to select/highlight it.

2. Click the **Split Mode** button located in the top header of the results table to view any notes related to the selected deposit.

   Any note related to the deposit is displayed in the lower pane of the results table.
Adding Deposit Notes

Both the Depositor and the Approver can add deposit notes at any stage of the deposit lifecycle. Notes can be viewed by both parties. This is a useful means of communication between staff and Depositors so that they can relay helpful information to each another throughout the deposit lifecycle.

**To add notes to a deposit:**

1. Click a deposit to select/highlight it.
2. Click the Full-Split Mode button to view notes related to the selected deposit.
3. Click the Add Notes button to open a window in which a note can be entered.
4. Click Save to append the note to the deposit-related notes.

**NOTE:**

Notes added to deposits submitted via Fast Track are not be seen by the Depositor.

In order to return to the non-split results view, click the Full-Split Mode button located in the top header of the results table.

Adding Internal Notes

To add internal notes to a deposit, follow the steps for entering information in the Note field, but enter the information in the Internal Note field instead.

**NOTE:**

Internal notes can be viewed only by staff Approvers and not by the Depositor. Standard notes can be viewed only by the Depositor who submitted the deposit and all staff Approvers in a certain approval group.

Filtering and Sorting Deposits

From any folder view, the sort and filter options are available from the table header located above all listed deposits. Deposits can be sorted by ID, creation date, title, type, and Depositor and filtered by Depositor and by dates on which deposits were submitted, created, or updated.

To sort the deposits, click the Sort by drop-down menu and choose ID, Creation date, Title, Type, or Depositor. The folder list is automatically sorted according to the chosen parameter.
To filter deposits, click **Filter** to open a dialog box that can be used to enter date ranges by which to filter the deposits. For instance, you may want to view only those deposits that were submitted between January 1, 2004 and February 15, 2004. This would be specified in the **Submit Date Filter** range. When you click **Filter**, the folder views are filtered according to the date filter specified.

Use the **Depositor** field on the Filter form to view all the deposits from a specific Depositor.

![Filter Form for Approver Deposit Viewing](image)

**NOTE:**
Once the filter is no longer needed, clicking **Remove Filter** returns the **Deposit** folder view to the previous non-filtered view where all deposits in the folder are displayed.

## Reviewing Deposits

All of the Approver’s deposits (submitted or re-submitted) appear in the Inbox. The Inbox review stage is where the staff Approver is most involved in the review process and decides on the destination of the deposit.

Deposit views other than those in the Inbox represent deposits that have been reviewed and acted upon (approved, returned, or declined). These deposits have read-only access, though the Approver has the ability to enter notes.

## Updating Deposits

All Inbox deposits can be opened for reviewing and/or updating. The review/update mode can be entered using either one of the following methods:
Chapter 7: Deposit Management and Review

- Clicking the deposit’s **Edit** button
- Selecting the deposit’s Full View by clicking **Full View** from the top table header, followed by clicking **Edit**.

Once a deposit has been opened for update, the following page opens to the **Preview** tab.

![Figure 31: Approver’s Edit/Update View](https://example.com/figure31.png)

From this page, the Approver can perform any of the following tasks.

**From the Preview Tab**

- View information on updated deposits on the Preview tab.
- View uploaded files by clicking links on the right side of the Preview tab page. (The user’s file association defaults are used to open files in this mode.)

**From the Files Tab**

- Review, replace, delete, and upload additional files to the Deposit, depending on the rules specified in the deposit workflow.
- To delete a file, click the **Delete** button next to the file name.
To upload a new file:

a. Click the Browse tab to open up the drives available for browsing on your local PC.
b. Find the appropriate directory containing the file you want to upload.
c. Click the file you want to upload.
d. Click Open in the dialog box in order to send the relevant PC path location of the required file to the DigiTool server.
e. Follow steps 1-4 until all required and relevant files have been chosen for upload.
f. Click Save to upload all files chosen.

Other Tabs

- Click the Descriptive Information tab to edit the deposit’s descriptive metadata. You have full access over the content of all metadata fields, which the Depositor has filled in as part of the object submission workflow.
- View the Copyright tab statement included with the object type submission and any related access-right language.

All Tabs

- Click Cancel at any point in the update mode to exit the Deposit module and erase any updated information you have added.
- At any stage within any tab step, you can save the deposit and the deposit remains in your Inbox for further review. At a later point, you can continue with the review process and ultimately decide the action to take in relation to the specific deposit.

Post-Review Staff Decisions

There are three definitive actions you can perform once deposits have been reviewed:

- Return Deposits
- Decline Deposits
- Approve Deposits

Return Deposits

Returned deposits are not yet appropriate for addition to the DigiTool repository and require some edits from the Depositor. When you return a
deposit, the deposit is moved from your Inbox folder to your Returned folder. The Depositor also sees the deposit in the Depositor’s Returned folder, where editing capability and ownership of deposits can be regained.

To return a deposit, perform any one of the following actions:

- Click the deposit's **Return** button.
- Select the deposit’s full view by clicking the **Full View** link located on the top table header, and then click Return.
- Click **Return** from within any of the updateable tabs.

**NOTE:**
Deposits submitted via Fast Track cannot be returned.

### Decline Deposits

Declined deposits are not appropriate for the DigiTool repository. When an Approver declines a deposit, the deposit is moved from the Approver’s Inbox folder to the Approver’s Declined folder. The Depositor also sees the deposit in the Depositor’s Declined folder, where the deposit and any related deposit notes can be viewed. The only action that can be performed from here is to delete the entry.

To decline a deposit, perform any of the following actions:

- Click the deposit's **Decline** button.
- Select the deposit’s Full View by clicking **Full View** located on the top table header, and then click **Decline**.
- Click **Decline** from within any of the updateable tabs.

### Approve Deposits

Approved deposits are ready to be added to the DigiTool repository. Once approved, the deposit begins a new cycle in the repository through the Ingest module (see **Ingest** on page 65). Depending on the predefined workflow used by the Depositor, different post-approval settings are defined.

When an Approver approves a deposit, regardless of the post-approval settings, the deposit is moved from the Approver’s Inbox folder to the Approver’s Approved folder. A Depositor also sees the deposit in the Depositor’s Approved folder, where the Depositor can view the deposit and any related deposit notes and ultimately delete the deposit from the folder view.

In order to approve a deposit, the Approver can perform any one of the following actions:

- Click the deposit's **Approve** button.
To select the deposit’s full view, click **Full View** located on the top table header, and then click **Approve**.

- Click **Approve** from within any of the updateable tabs.

**Automatic Post-approval**

Once a deposit is approved (manually), it is automatically ingested in the Ingest module.

**Manual Post-approval**

Once a deposit is manually approved, it is passed to a staff member for review in the Ingest module.
Part IV

Ingest

Part IV contains the following:

- Section 8: Getting Started with Ingest on page 67
- Section 9: New Ingest Activity on page 73
- Section 10: Processing Ingests on page 95
Getting Started with Ingest

This section introduces the staff Ingest module.

This section includes:
- Ingest Module Features on page 67
- Ingest Interface on page 68
- Available Actions for Ingest Activities on page 71

Ingest Module Features

An ingest is an activity that represents the submission of digital objects and/or metadata into the DigiTool repository. Typically, an ingest consists of various parameters and workflows, such as scheduling, assignment to staff users, use of background tasks, and the upload of objects and/or metadata to the server.

The staff Ingest module is designed to support the ingest, or loading, of digital objects into the DigiTool repository. The outcome of the ingest activity is Digital Entities (PID) in the repository.

The staff Ingest module consists of five sections: Folders, New Ingest Activity, Ingest Flows, Task Chain, and Upload.

The main features of the staff Ingest module are:
- Scheduling of ingest activities
- Assignment of ingest activities to staff users
- Assignment of tasks to ingest activities
- Upload of digital objects and metadata for load to the repository
Ingest Interface

This section explains how to log on to the Ingest interface and contains information on the folder view and table view of the module.

Logging On

You log on to the Ingest module using staff user credentials.

To log on to the Ingest interface:

1. Enter the staff ingest URL set by your institution in the address bar of your Web browser: http://<hostname>:JBOSS_PORT/webingest
   For example:
   http://www.university.com:1801/webingest
   A login form opens.
2. Type a valid staff user name and password.
3. Click OK.

The DigiTool Ingest page opens to the default view of your Ingest folders, which display the different statuses of your ingest activities and allow you to perform actions such as editing, scheduling, or activating ingest activities. See Figure 32 for details.

Folders View

The staff Ingest interface opens to the default folder view.
The following are the folders that describe the specific statuses of the items in the staff Ingest module.

**Not Scheduled**

The *Not Scheduled* folder contains all the ingest activities that were defined without determining a specific schedule for the activities being performed. These ingest activities are not performed until a schedule has been added. The staff Ingest user can pick activities from this folder in order to add a schedule. The edited activities are transferred to the *Scheduled* folder.

An ingest activity started directly from the upload step (the fifth option in the main menu) also appears in this folder. The activity name is the date and time of the file upload.

In this section, you also find deposits that have been approved and for which the post approval material flow was defined as *Manual*. To get these activities running, they must be assigned—if they are not yet assigned—and activated by a staff Ingest user.

The ingest ID syntax of such activities is: `dep<deposit_id>_ing<ingest_id>`, where `<deposit_id>` is a consecutive number given to each deposit and `<ingest_id>` is a consecutive number given to each ingest.

**Scheduled**

The *Scheduled* folder contains all ingest activities that were defined with a specific schedule for being run. Currently, the scheduling of ingest activities is a one-time schedule. For recurring ingests, see *Ingest Flows* on page 95. These activities are performed automatically at the time the activity was scheduled. A staff Ingest user can pick activities from this folder to edit the parameters of these activities or to activate them immediately.

In this section you also find deposits after approval, when the post-approval of the material flow used was defined as *Automatic*. These activities immediately move to running, as their scheduling is *As soon as possible*.

The ingest ID of such activities is: `dep<deposit_id>_ing<ingest_id>`, where `<deposit_id>` is a consecutive number given to each deposit and `<ingest_id>` is a consecutive number given to each ingest.

**Running**

The *Running* folder contains all ingest activities that are currently being performed by the system. There is a dynamic log file that can be tracked and viewed while an ingest activity is in running status by selecting the running ingest activity, clicking the Full/Split View button, and choosing one of the lower pane log files to view/track.
When the activity run is over, the activities are transferred either to the Success or Failed folder.

**Success**

The Success folder contains all ingest activities that were performed successfully. The details of every ingest activity can be checked by viewing its associated log file. Successful ingests can also be rolled back, which deletes any successfully loaded digital entities from the repository and returns the ingest to unscheduled status.

**Failed**

The Failed folder contains all ingest activities that were not performed successfully. The details and reasons for failure can be checked by viewing the folder’s associated log file. Failed ingests can also be rolled back, which deletes any potentially successfully loaded digital entities from the repository and returns the ingest to unscheduled status.

By editing the activity parameters, failed ingest activities can be resubmitted.

**Ingest Folders Table View**

For each ingest folder, the corresponding activities are listed in a table view. The following information displays in this view:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>This column contains the ID of the ingest activity. This ID is assigned automatically by the system.</td>
</tr>
<tr>
<td>Activity Name</td>
<td>This column contains the ingest activity’s name. This name must be specified by the staff user as part of the ingest activity’s parameters. In case activity is initiated by an upload, activity name is assigned by system, containing upload time and date.</td>
</tr>
<tr>
<td>Task Chain Name</td>
<td>This column contains the name of the task chain selected for the ingest activity.</td>
</tr>
<tr>
<td>Assign to</td>
<td>This column contains the name of the staff user to which the ingest activity is assigned.</td>
</tr>
<tr>
<td>Action</td>
<td>This column contains the actions that can be selected for the specific ingest activity (see Available Actions for Ingest Activities on page 71 for details).</td>
</tr>
</tbody>
</table>
Available Actions for Ingest Activities

The following activities are available for ingest entries.

Edit

The Edit button allows you to edit the parameters of the ingest activity. The Edit button is only available in the Not scheduled, Scheduled, and Failed folders. A staff user cannot edit a running activity or an activity after it was run successfully.

You can change the parameters and click Finish on the last screen to save your changes.

If you want to perform the ingest activity immediately, click Activate on the last screen of the ingest activity.

Delete

By clicking the Delete (x) button, the staff user can delete an ingest activity from the folder. The Delete button is available in all folders except for the Running folder. Deleting an activity in the Scheduled, Not Scheduled, or Failed folders means that it does not run. Deleting an activity from the Success folder does not affect the run that is already finished successfully or the resulting digital entities. It only erases the activity from the display of the folder.

Activate

By clicking the Activate button, the staff user can activate an ingest activity. The ingest activity is performed immediately and is transferred to the Running folder.

The Activate button is only available in the Not Scheduled and Failed folders. To activate a scheduled activity, you must edit the activity and choose As Soon As Possible in Scheduling.

Rollback

By clicking the Rollback button, the staff user can roll back an ingest activity. The ingest activity is rolled back immediately, any successfully loaded digital entities that are part of that activity are deleted, and the activity is transferred to the Not Scheduled folder for potential editing or re-activation. The Rollback button is available only in the Success and Failed folders.
View

By clicking the View (eye) button you can view, but not edit, information. The View button appears on the Ingest Flow tab and in the Parameters window in Edit view.

Track Activities

Ingest activities are tracked as tasks.

To check the log files and other information connected to an ingest activity:

1 Highlight an ingest activity to select it.
2 Click the split table (Full/Split Mode) button.
3 Select one of the following:
   - Task list to check the syntax of parameters sent to the server.
   - Task log to check the status of the running ingest.
   - Task summary to view a summary of the ingest activity.

NOTE:
Logs may be opened in a dedicated window by clicking Open Logs in new window.
New Ingest Activity

This section explains how to initiate and move through a new ingest activity.

Defining a New Ingest Activity

Click New Ingest Activity to define an ingest activity along with its files, transformers, and tasks. You are led through a 4-step process to define the activity before it is ready for running. You can move between steps using the Next and Back buttons to correct your selections prior to activation.

If the activity is not immediately processed, it is also possible to change your selections later using the Edit feature.
Enter Activity Parameters – Step 1

After a user clicks **New Ingest Activity**, the Enter Activity Parameters page opens.

![Enter Activity Parameters Page](image)

Enter information in the following fields:

- **Name**
- **Ingest Type**
- **Scheduling**
- **Assign To**
- **Note**
- **Auto Rollback**
- **Select Task Chain**

### Name

Assign a name to the ingest activity. This field is required. The ingest activity can be retrieved in the repository by searching for this name in DigiTool's
Management module. The ingest name is stored and associated with the digital entity in the repository once ingested.

**Ingest Type**

Use this option to select the type of ingest—that is, the type of data input and transformation process—to be provided and performed.

The following are the options available:

- **File stream(s) that will be loaded with no relationships** – Use this option to ingest multiple digital objects that have the same metadata into the repository. This is defined in a template that is selected from a drop-down list on a different screen. When this ingest type is used, there is no relationship between the primary objects loaded.

- **File stream(s) that will become part of one parent record** – Use this option to ingest multiple digital objects into the repository that are part of a group and that should be viewed together and related to one another.

  These objects’ relation to the parent object and each other is recorded in the repository as a result of this ingest. In addition, a parent digital entity of the type **Complex** is created. All the items are related to the parent digital entity with a “part of” relation. This group represents a one-level hierarchy and can be converted into METS format as part of the ingest process. All files can be viewed together in the default DigiTool delivery system.

**NOTE:**

This transformer is frequently used only by deposits.

- **File stream(s) utilizing the DigiTool file name convention** – Use this option to create an ingest directory that is similar to the METS transformer output. Use naming conventions to generate hierarchically structured objects by having DigiTool generate XML out of the syntax and structure of the file names provided. To use this option, the following syntax for file names is mandatory. Note that the syntax is case sensitive.

  \[pg<#>_ut<code>_m<#>_toc<#.#.#>_lbl<page_label>.<file_extension>\]

  Following is an explanation of this syntax:

  - **pg:** contains the page number, 1...n
  - **ut:** contains the usage_type (view, thumbnail, index, archive)
  - **m:** manifestation number
  - **toc:** table of Content ID (for example, 2.3.1)
- **lbl**: the page label underscores as spaces

Only the first manifestation should have the toc and lbl setting.

For example:

```
pgl_utview_ml_toc1.0_lblCover Page.jpg
gl_utthumbnail_m2.jpg
gl.utindex_m3.txt

pg2_utview_ml_toc1.0_lblSecond Page.jpg
g2_utthumbnail_m2.jpg
g2.utindex_m3.txt
```

**NOTE:**

**Concat TOC to label** – This is a special parameter that can be defined when using this ingest type. **True** means that the system-generated automatically numbered table of content value for hierarchical structures is displayed in the viewer.

The following is an example of an output when the value of the parameter is true:

3.1.2 How the West Was Won.

The following is an example of an output when the value of the parameter is false:

How the West Was Won.

- **MARC XML file and associated file stream(s)** – Use this option to create digital entities that contain descriptive metadata in MARCxml format. For this purpose, an XML file is used that may contain one or more MARC records which may also reference one or more file streams. As a result of this ingest, digital entities are created for each MARC record with or without file stream references.

**NOTE:**

Choose the MARCXML file to upload from your local PC or from a data source NFS location, as well as a relevant processing instructions template which defines which field file stream references are located and how to load them.

- **Dublin Core XML file and associated file stream(s)** – Use this option to create digital entities that contain descriptive metadata in Dublin Core XML format. For this purpose, an XML file is used that may contain one or more Dublin records which may also reference one or more file streams. As a result of this ingest, digital entities are going to be created for each Dublin Core record with or without file stream references.
NOTE:
Choose your DC XML file for upload from your local PC or from a data source NFS location, as well as a relevant processing instructions template which defines in which field any file stream references are located and how to load them.

- **Comma separated value (.csv) file** – Use this option to create digital entities specified in a comma separated value (csv) input file. This method requires two input files: `values.csv` and `mapping.xml`. The `values.csv` file contains multiple records, one record per line/row. Each record contains values in a set order separated by commas. The system creates digital entities for each record in the `values.csv` file. The `mapping.xml` file contains definitions on how the CSV file should be mapped (converted) into specific fields within the resulting digital entities. Both files are uploaded from the staff user's PC or from a predetermined NFS data source.

NOTE:
Choose your `mapping.xml` and `values.csv` for upload from your local PC. For more information on these files, see Comma Separated Value (.csv) File on page 151 of the DigiTool Configuration Guide.

- **METS XML file and associated file stream(s)** – Use this option to ingest objects that are structured in a METS file. As part of the objects to be ingested, an XML file containing the METS structure is mandatory for using this option. As a result of this ingest, the compound METS object is broken down into its basic elements.

NOTES:
- Choose your `METS.xml` for upload from your local PC.
- To ingest multiple METS files, name each METS file `mets.xml`, then save each file and associated filestreams as a `.zip` file. Select Yes on the Multifile METS Upload Option on the third step of the wizard, and select your METS `.zip` files for upload on the fourth step.

- **Exported DigiTool repository elements for ingest/re-ingest** – Use this option to ingest files created by a DigiTool export action into the repository. When choosing this transformer type, the following parameters are required: Location of directory to import, and keep original objects IDs (true/false).

NOTE:
Choose the server location of your exported digital entities and streams for re-ingest. Keeping original object IDs set as true means that the pid and mid values originally in place are retained. False means new system-generated pid and mid values are created.
File stream(s) that will be loaded with manifestation relationship – Use this option to ingest objects that are all manifestations or representations of one another. Manifestations have manifestation relationships built within the repository upon load. An example of manifestations might be three images—a high-resolution, medium-resolution, and low-resolution image.

**NOTE:**
This transformer is frequently used only by deposits.

MODS XML file and associated file stream(s) – Use this option to create digital entities that contain descriptive metadata in MODS XML format. For this purpose, an XML file is used that may contain one or more MODS records which may reference one or more file streams. As a result of this ingest, digital entities are created for each MODS record with or without file stream references.

**NOTE:**
Choose your MODS XML file for upload from your local PC or from a data source NFS location, as well as a relevant processing instructions template which defines which field any file stream references are located and how to load them.

### Scheduling

Use the Scheduling option of the Enter Activity Parameters screen to determine whether an ingest should be performed immediately or whether it is run according to a predefined schedule.

When the **As Soon As Possible** option is chosen, the ingest is performed immediately after all parameters have been set and completed by the staff user.

With the **Scheduled** option, a staff user is able to determine the time when an ingest activity is performed. This option is useful, for example, for managing server usage and performance by allowing the scheduling of a massive upload for late evening hours.

Note that **am** or **pm** has to be selected when using **Scheduling**.

### Assign To

If you have the staff user level permissions to ingest/assign activities to staff users, then you can assign an activity to other staff users. Otherwise you may only assign them to yourself.

The ingest activity is editable and able to be activated by the staff user to whom the activity is assigned.

A user can activate an ingest activity only if it is assigned to him. If the user has assign permissions the user can assign the activity to himself and then activate
it. By default, all new ingest activities are assigned to the user who is working on them.

**Note**

The **Note** field allows you to add a note to the ingest activity. For example, when assigning an ingest activity to another staff user, you can use this option to add a comment on the ingest activity. The note field is only used within the ingest process and is not stored or associated with the loaded digital entities in the repository after successful completion.

**Auto Rollback**

Select the Auto Rollback checkbox to have DigiTool automatically roll back the ingest activity if the Ingest fails.

The ingest activity is rolled back immediately. Any successfully loaded digital entities that are part of the activity are deleted, and the activity is transferred to the Not Scheduled folder for potential editing or reactivation. Note that the dynamic log file is not cleared after the automatic rollback is performed, but only after reactivating the Ingest.

For more information on setting the default value of the Auto Rollback checkbox, refer to the **Auto Rollback** section of the *DigiTool Configuration Guide*.

**Select Task Chain**

A task is a routine that is performed during ingest (such as **thumbnail creation**, **full text indexing**, or **technical metadata extraction**). As part of the ingest activity, you may run more than one task. You can assign either predefined task chains (system or user defined) or manually create new task chains.

The **Task Chain** option is mandatory:

NOTE: If you do not want any task to be performed during an ingest, select **Empty Chain** from the drop-down list of template task chains.

Following are the options for selecting task chains:

- Template Task Chain
- New Task Chain
- User Defined Task Chain

You can select either a single task or a chain of tasks that is part of the drop-down list. Use **Template Task Chain** to select a task chain from the drop-down list of pre-defined task chains. Additionally, individual tasks may be selected, defined, and ordered from the set of tasks described below. (See parameters for each task in **Activity Parameters – Step 3** on page 84.)
**Empty Chain**

Since the Select Task Chain option is mandatory, the Empty Chain option is designed for those ingest activities that are going to be performed without any task chain.

**Thumbnail Creation Only**

Thumbnail Creation Only manages the creation of thumbnails from image-based file streams. For each derivative thumbnail created, a uniquely identified digital entity is created that has a manifestation relationship to the source original. The thumbnail parameter for filtering by file extension can be changed in step 3 of an ingest activity. The default is no filtering.

**Technical Metadata Extraction Only**

Many digital objects already contain technical metadata embedded that can be extracted during ingest. The Technical Metadata Extraction Only task chain extracts this metadata. For this purpose, the JHOVE utility of Harvard University is used. The extracted metadata is both stored with the ingested object and mapped to the appropriate technical metadata category that DigiTool supports (text_md, MIX, VMD and AMD).

**Add Metadata Only**

As part of metadata management, DigiTool supports the ability for metadata to be copied or shared by different digital objects. Each metadata record has its own unique ID (MID) that objects can link to/copy from. Add Metadata Only allows either an existing repository MID to be linked/copied, or an individual local XML-based metadata record to be added and associated with the loaded objects as part of the ingest activity.

**NOTE:**
Metadata can be shared only within the same administrative unit. Attempting to share metadata across administrative units will result in a copy of the metadata being created and a new MID issued for the copied material.

**HINT:**
- **Shared = True** – is generally for linking to existing MID # in repository. Note that when you direct Meditor to delete shared metadata, the metadata itself does not get deleted from the server; only the connection of the object to the metadata is severed.
- **Shared = False** – is generally for locally provided metadata (.xml) records. In this case, choose the appropriate type: access rights, MARC, DC, and so forth.
Filter by extension is inclusive—that is, only add \texttt{md} to the extension \texttt{jpg}.

Filter by file size smaller than is in bytes.

\textbf{Attribute Assignment Only}

Use this task to assign attributes to the control section of the digital entity. This may be useful, for instance, to set a certain preservation level, entity type, and so forth.

\textbf{Full Text Extraction Only}

Use this task to perform a full-text extracting routine of text-based objects as part of the ingest. For each derivative index file created, a uniquely identified digital entity is created which has a manifestation relationship to the source original. The object created by this task is used for full-text indexing in discovery systems such as the Resource Discovery or Primo, or, in the case of METS, allows searching pages within the METS viewer.

Out-of-the-box supported text-based file extensions are: pdf, doc, rtf, ppt, txt, htm(l), and xml.

\textbf{Tiff to JP2000}

Using this task, JPEG2000 derivatives are created out of TIFFs during ingest. For each derivative JPEG2000 created, a uniquely identified digital entity is created which has a manifestation relationship with the source original. The JPEG2000 gets a VIEW usage type. If there was descriptive metadata in the source TIFF file, the derivative usage copy JPEG2000 shares the metadata as well.

\textbf{Premis Metadata Creation with PI}

Use this task to create a Handle/URN unique identifier in association with the Handle or URN systems. This task requires being set up with an external Handle/URN provider in order to use.

\textbf{Remote Stream Download}

Use this task only in conjunction with remotely stored URL file streams. The Remote Stream Download task should be defined first within the task chain and has three potential purposes:

- Use Remote Stream Download with Store Link Locally = \texttt{False} in order to enrich the stream reference section of the digital entity with relevant mimetype and file extension information and subsequently have the URL remain linked to the remote source. This ensures correct classification and treatment within DigiTool after the URL is loaded.
Use Remote Stream Download with Store Link Locally = False in order to run other tasks on the URL stream in question. For instance, in this case, you may want the resultant URL stream to remain remotely linked once loaded to the DTL repository. However, in any case, certain stream related tasks, such as thumbnail creation or full text extraction, are desired.

- Use remote stream download with Store Link Locally = True in order to download the remote file from its URL location to ultimately store and manage the file locally in DigiTool.

**Add History Event Only**

Use the history event task to create new history event metadata. Note that by default, the ingest automatically produces a history metadata record for each and any event that is carried out—for example, thumbnail creation, fixity check, and so forth.

This task allows you to add a history event and specify the relevant parameters.

**NOTE:**
From the Select Chain drop down list, you can also select task chains that are combinations of the tasks described above.

When you select a task chain, the Create a New Task Chain page opens. This page allows you to change the order of the tasks to be performed. You can also add or delete tasks from the chain.

**New Task Chain**

In addition to the template task chains, you can create your own task chain using the New Task Chain option. The Create a New Task Chain screen appears when this option is selected. Use the options on this screen to build a new task chain.

**User-Defined Task Chain**

New task chains, created by a staff user and saved, automatically appear in the User-Defined Task Chain drop-down list whenever the staff user logs on to the DigiTool Ingest interface. User-defined task chains are saved for future use with other ingest activities.

**NOTE:**
Selecting between Template Task Chain, New Task Chain, and User-Defined Task Chain only defines what tasks you start with in your list. You can always change the list and its order in the next stage, even when working with a template. If you like the chain, save it as a user-defined task chain.
Create New Task Chain – Step 2

After you select one of the task chain types (template, new, or user-defined) and click **Next**, the Create a New Task Chain page opens. This page allows you to choose and order the tasks that run in the activity. You can add or delete tasks as well as change their relative order in the chain.

To create a new task chain:

1. Under **All Tasks**, select a task.
2. Click the right arrow button to transfer the task to the right pane (under **Selected Tasks**).
3. Repeat steps 1 and 2 for each task you would like executed as part of the ingest activity.
4. Use the up and down arrows to change the order of the tasks in the list to the order in which you want them run in the ingest activity.
5. To remove a task from the chain, select the task from the right pane and click the left arrow to transfer it back to the left pane.
6. When you are finished, click **Next**.

The Parameters page opens.
Activity Parameters – Step 3

The Parameters page allows you to add parameters specific to the transformer and tasks chosen on the previous two pages.

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transformers</td>
</tr>
<tr>
<td>Digital Entity Template: simple_entity.xml (File has not been uploaded to server!)</td>
</tr>
<tr>
<td>Please select file location: Local Files</td>
</tr>
<tr>
<td>Descriptor file: Browse... (File has not been uploaded to server!)</td>
</tr>
<tr>
<td>Tasks</td>
</tr>
<tr>
<td>Thumbnail Creation File Extension: .jpeg,.jpg,.jp2,.tif,.tiff,.gif,.pdf</td>
</tr>
<tr>
<td>Loading</td>
</tr>
<tr>
<td>Core Digital Entity Loader</td>
</tr>
</tbody>
</table>

Figure 35: Parameters Page

An example of a transformer-sensitive parameter is when the CSV transformer in step 1 requires you to provide a CSV and associated mapping.xml file in step 3. Choosing the Dublin Core transformer in step 1 requires you to provide the Dublin Core XML file and relevant processing instruction file in step 3.

The Descriptor File is for assigning labels and notes in order to load file streams by using a file. It can also be used to structure the order of a complex object. Use the order attribute to pre-define the display order of children. For example,
Chapter 9: New Ingest Activity

load the XML file in step 3, and load the file streams globe1.jpg and globe2.jpg in step 4:

```xml
<?xml version="1.0" encoding="UTF-8"?>
  <fd><key>0</key><fileType>FILE</fileType>
    <order>1</order>
    <file_name>globe1.jpg</file_name><label>1st file</label><note/></fd>
  <fd><key>1</key><fileType>FILE</fileType>
    <order>2</order>
    <file_name>globe2.jpg</file_name><label>2nd file</label><note/></fd>
</file:fds>
```

For details about tasks and parameters, see Table 8.

Table 8. List of Task Parameters

<table>
<thead>
<tr>
<th>Task</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnail Creation</td>
<td>File extension</td>
<td>The file stream extensions on which to run the thumbnail creation task. Default file extensions supported: jpeg, jpg, jp2, tif, tiff, .gif, .bmp, .pdf.</td>
</tr>
<tr>
<td>Add Metadata</td>
<td>Shared</td>
<td>This option enables you to create a link to existing metadata in the repository by choosing true. Used in conjunction with linking to an existing repository MID.</td>
</tr>
<tr>
<td>MD Description</td>
<td></td>
<td>Metadata name and type, for example: Access Rights MD.</td>
</tr>
<tr>
<td>MD File</td>
<td></td>
<td>This option enables you to upload an XML-based metadata file from your local drive. Used in conjunction with Shared set to False.</td>
</tr>
<tr>
<td>Mid</td>
<td></td>
<td>You can specify the metadata ID number here if you chose to link your object to an existing metadata (see Link parameter).</td>
</tr>
<tr>
<td>Add metadata to COMPLEX/METS parent only</td>
<td></td>
<td>You can specify whether or not the metadata being added should be added only to the parent object. By default, the metadata is attributed to all digital entities formed as part of the ingest.</td>
</tr>
<tr>
<td>Filter on File Extension</td>
<td></td>
<td>Attach the metadata to files only with certain extensions, for example – tif and jpg.</td>
</tr>
<tr>
<td>Filter on Files smaller/ greater than File Size</td>
<td></td>
<td>The MD is attached to files that are smaller/greater than this number.</td>
</tr>
</tbody>
</table>
### Table 8. List of Task Parameters

<table>
<thead>
<tr>
<th>Task</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Metadata Extraction</td>
<td>Filter on Files greater than File Size</td>
<td>The size of the metadata file must be greater than this number.</td>
</tr>
<tr>
<td></td>
<td>Text MD</td>
<td>Allowed file extensions for technical text metadata extraction.</td>
</tr>
<tr>
<td></td>
<td>Image Niso</td>
<td>Allowed file extensions for technical image NISO metadata extraction.</td>
</tr>
<tr>
<td></td>
<td>Audio MD</td>
<td>Allowed file extensions for technical audio metadata extraction.</td>
</tr>
<tr>
<td></td>
<td>Video MD</td>
<td>Allowed file extensions for technical video metadata extraction.</td>
</tr>
<tr>
<td></td>
<td>Overwrite</td>
<td>Yes/No – This is relevant for exported digital entities being re-ingested. The question is whether to overwrite and re-extract technical metadata or to leave it in place if the digital entity already has technical metadata.</td>
</tr>
<tr>
<td></td>
<td>File Extension</td>
<td>Metadata file extension.</td>
</tr>
<tr>
<td>Premis Metadata Creation with PI</td>
<td>Profile</td>
<td>The profile of persistent identifiers, Handle or URN type, to use when creating new persistent identifiers for the ingest activity’s ultimately loaded digital entities.</td>
</tr>
</tbody>
</table>
### Add History Event

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EventIdentifierType</td>
<td>This field is mandatory. A designation of the domain in which the event identifier is unique, for example: system repository.</td>
</tr>
<tr>
<td>EventIdentifierValue</td>
<td>This field is mandatory. The value of the event identifier, for example: PID identifier in the repository.</td>
</tr>
<tr>
<td>EventType</td>
<td>This field is mandatory. Description of the event carried out. Possible values: compression, capture, deletion, fixity check, ingestion, migration, normalization, validation, virus check, and so forth.</td>
</tr>
<tr>
<td>EventDetail</td>
<td>Additional information about the event.</td>
</tr>
<tr>
<td>EventOutcome</td>
<td>The outcomes of the event. Maps to Premis object metadata eventOutcomeInformation/eventOutcome.</td>
</tr>
<tr>
<td>SoftwareUsed</td>
<td>Any software used to complete the event. Maps to linkingAgentIdentifier/linkingAgentIdentifierType (Hard coded: software_used) and linkingAgentIdentifier/linkingAgentIdentifierValue.</td>
</tr>
<tr>
<td>EventDate</td>
<td>The date on which the even occurred. Maps to EventDateTime.</td>
</tr>
<tr>
<td>Add For File Extensions</td>
<td>File extensions to apply the Add History event.</td>
</tr>
</tbody>
</table>

### Tiff to Jp2 converter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

### Remote Stream Download

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Locally</td>
<td>Relevant only for URL file streams. After downloading stream for any usage (other tasks, enrichment, etc) determine whether stream should be saved locally or should remain an external link. If you choose true, the stream is not treated as an external URL anymore and a copy of it is saved and subsequently administered locally within DigiTool.</td>
</tr>
<tr>
<td>Filter on file extension</td>
<td>Optional: File extensions on which to perform the remote stream download task. Default is all. Comma-separated file extensions for multiple file extensions.</td>
</tr>
</tbody>
</table>
The metadata input for the transformer can be uploaded by browsing your local PC or, if defined, by choosing NFS locations.

Transformer-sensitive parameters are selected in the Transformers section of the Parameters page.

Task-sensitive parameters, such as the file types upon which tasks should be performed, might include information on what types of files to run for particular tasks or which file streams to filter a task. This is available for definition, if change from the default is needed, under the Tasks section.

**After adding the parameters to each task, do one of the following:**

- From the Parameters screen, click Next. The Upload Files page opens. If a new task chain was created, it is not saved.
- Click Save Chain. Enter a name for the new task chain. The task chain is saved as a user-defined task chain. Click Next.
- Click Cancel to erase the changes you have made.
Chapter 9: New Ingest Activity

Upload – Step 4

The Ingest module provides manual uploading capabilities from local drives, server drives, and remote sources.

Local Files – Manual Upload

For an efficient and convenient upload of objects to the server, DigiTool uses the Aurigma Image Loader browser plug-in (Java applet). To make sure the browser can install this plug-in automatically when you enter this stage, you should check and, in some cases, change your browser’s settings:

To modify your Internet Explorer browser settings:

1. In the Internet Explorer window, open the Tools menu.
2. Select Internet Options.
3. Click the Security tab.
4. Click the Trusted Sites image button and then click the Sites button.
5. Clear the Require server verification (https:) for all sites in this zone check box at the bottom of the window.
7. Click OK.

NOTE:

The Java applet plugin for file uploads is supported only by Internet Explorer versions 5.0 and later.

The plug-in is loaded in the left pane of the Upload Files page. Once the plug-in is loaded, you can browse the local drives to select the files you want to upload.
To upload files:

1. Select the files to upload.
2. Click the Send button. The selected files are transferred to the server. A status bar displays the status of the copying process.

When the upload is completed, a status box informs you of its success.

3. Click OK to close the box. The uploaded objects are listed in the right pane, under the Uploaded to Server heading.

4. Click the Save Chain button to save as a user-defined chain for future use.

**NOTE:**
To upload all files in a directory, enter the directory and click the Select All button, then select any one of the check boxes to make them all selected for uploading. To clear all the check boxes, click the Select All button and clear any one of the check boxes to clear them all.
Server Files (NFS)

You can upload files from an NFS server source, which is a data source that has been predefined by your repository/system administrator.

To upload files from an NFS server source:

1. Choose the relevant path location where your files reside.
2. Use the text box to choose subdirectories of the data source path in order to further move through the personal directories that may store your file streams.

3. Click the Add Files button to choose the path location. The files are acquired only once the ingest is activated, not at the time of clicking the Add Files button.

**NOTE:**
Using server file “acquiring” allows you to save a recurring ingest flow. See Ingest Flows on page 95 for details.
Remote Files

You can upload remote files individually or in batches. To load remote files (URLs) in batch mode, use the Batch section of the Remote Files tab. (See the following figure.)

![Figure 38: Upload Remote Files](image)

**To upload remote files in a batch:**

1. Create a file that contains the list of URLs you want to upload. The list file must be a simple text file, and each URL should be on a separate line. This text input file should reside on your local PC.

2. Use the Browse button to locate the file, if necessary, or enter the file name directly in the URL File box.

3. Click the Add button to add all files in list to the upload.

4. If the download of the URL from the server requires authentication and you are using batch mode, in each line of the URL list the name, user name, and password after the URL name, all separated by commas.

**NOTE:**
This option can only be used if you are going to download immediately. Postponed downloading (at activation time) does not support authentication.
To upload remote files individually:

1. In the **One by One** section of the **Remote Files** tab, in the **URL** box, enter the URL you want to upload. You have the option of providing the URL with a name.

2. If authentication is needed to get files from the remote server, check this option and provide a user name and password.

3. Click the **Add** button to add the URL to files to be uploaded.

4. If you want to upload more than one file, repeat steps 1-3 until you have completed your URL list.

**Download Remote Files Now**

With both methods of remote upload, you can select the **Download Remote file(s) now** check box to download the file to the server when you click the **Add** button. The file is then treated as a local file and is stored in DigiTool. If the check box is not selected, the file is not actually downloaded and is treated as an externally linked URL.

**NOTE:**

If you want to store the objects as URLs, but you would also like to gain a derivation of them (such as getting a thumbnail or full-text extraction), do not select **Download Remote file(s) now** in this screen. Return to the **Create a New Task Chain** screen and choose the task **Remote Stream Download**. Under the task parameters, choose false for **Store Link Locally**. The thumbnail creation of full-text extraction must be listed after remote stream download in the task order. This creates the derivative file to store in DigiTool, but the source file remains linked remotely.

**Ensure Availability of URLs**

Make sure that the URLs you are trying to upload to your system can be accessed. This means that the URL should be accessible from the system running the DigiTool server and not only from the PC from which you are browsing.

Firewall configurations of sites and open/closed ports should be considered. This applies to all URLs. Most URLs are open on port 80, so outgoing port 80 access is essential for DigiTool’s interaction with the URLs.
Possible Actions After Uploading Files

- To view an object that you have uploaded, click its link in the **Uploaded to Server** pane. This is for local files only.

- To delete an uploaded file or file reference location, click the **Trash Can** button.

- To complete preparations for the ingest activity, click the **Finish** button. This transfers the activity to the **Not Scheduled** folder. Even if scheduling was **As Soon As Possible**, the activity does not run on schedule unless activated by clicking on the **Activate** button in the **Actions** column.

- To run the activity on schedule, click the **Activate** button. This transfers the activity to the **Running** or **Scheduled** folder, depending on the scheduling you configured.

- If a metadata data source was chosen in step 3 and a server data source chosen in step 4, an additional option, **Save as Ingest Flow**, is available to the staff user. See **New Ingest Activity** on page 73 for more details.
Processing Ingests

This section describes tasks and activities that allow you to complete the processing of inests.

This section includes:

- Ingest Flows on page 95
- Task Chain on page 96
- Upload on page 96
- Editing an Ingest Activity on page 97

Ingest Flows

The Ingest Flows section of the Ingest module allows you to set up recurring automated ingest activities and to view existing definitions for ingest flows.

Clicking Ingest Flows from the top toolbar opens a list of saved ingest flows that have been defined within the current administrative unit and that have source data in a fixed location.

<table>
<thead>
<tr>
<th>Ingest Name</th>
<th>Activity</th>
<th>Ingest Flows</th>
<th>Task Chain</th>
<th>Upload</th>
</tr>
</thead>
<tbody>
<tr>
<td>complex 1.1</td>
<td>Ingest_Server_Files_2008.03.12_11.07.32</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>OAI ACQUIRE</td>
<td>media_25_dc</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>OAI ACQUIRE</td>
<td>media_25_marc</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>complex 2</td>
<td>Ingest_Server_Files_2008.03.10_12.07.17</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>complex 1</td>
<td>Ingest_Server_Files_2008.03.10_11.36.52</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

Figure 39: Ingest Flows
An ingest flow can be defined only if all relevant “acquiring” or data sources are defined. This means that an ingest activity with files chosen from your local PC cannot be run in a recurring manner and therefore is not a candidate for being an ingest flow. DigiTool requires information and access regarding the location of any relevant metadata and/or file streams in order to enable an ingest flow to be defined and ultimately activated once again in the future.

Each time an ingest flow that deals with network file system files is run successfully, the source files are backed up and moved aside to ensure that files uploaded from this location the next time are not duplicated in the repository.

**Task Chain**

Choosing **Task Chain** from the top toolbar displays the list of task chains defined by the currently logged-on staff user. Currently, the only option available is to delete the task chain by clicking the **Delete** button to the right of the task chain you want to delete.

**Upload**

Choosing **Upload** from the top toolbar opens the Upload page for uploading files from local, server, or remote sources. This allows you to perform the upload stage first, before defining the transformer and task chain to use for ingesting files. You may choose to do this when you have a large upload that you want to make sure is uploaded before you set the details of transformer and tasks.

On the Upload page, you are presented with the standard tabs: **Local Files**, **Server Files**, and **Remote Files**. These options are generally meant for local file upload as performed from the New Ingest Activity page (see **Upload – Step 4** on page 89). The Upload page differs from the New Ingest Activity page in that you can only upload files from this page. You cannot view them or delete them from the list.

After the files are uploaded the **Folders** view is displayed. You now see the upload activity listed in the **Not Scheduled** folder. The same view is seen by other administrative staff users until and after the upload is completed.

The activity is named with the following syntax: *Files upload at WeekDay Month DayOfMonth Hour TimeZone Year*, with values describing the time upload started.

To edit this activity, click the **Edit** button. You can also delete it, but you cannot yet activate it until further definitions regarding transformers and tasks are provided.
In order to activate an activity initiated as an upload, you must edit the activity and click **Save** for each of the three other tabs the activity has (**Activity Info**, **Task Chain**, and **Parameters**).

It is recommended that you change the name of the ingest activity to a descriptive name prior to activating the activity.

**Editing an Ingest Activity**

In all activity folders except for the **Running** and **Success** folders, you have the option to edit an activity by clicking the **Edit** button  

The Edit Activity screen is used to set and change different activity data, such as name and transformer type, tasks in the task chain, activity parameters, and files uploaded in the activity. This screen is divided into four tabs, each parallel to the four initial activity steps.

- **Activity Info** – Identical to **Enter Activity Parameters** – Step 1 on page 74.
- **Task Chain** – Identical to **Create New Task Chain** – Step 2 on page 83.
- **Parameters** – Identical to **Activity Parameters** – Step 3 on page 84, except that the **Save Chain** button appears, enabling you to save any changes that you have made.
- **Upload** – Identical to **Upload** – Step 4 on page 89.

The following are the differences between the steps in the New Ingest Activity page and the tabs in the Edit Activity screen:

- Saving changes does not happen automatically in the Edit Activity screen. If you made changes in any tab, you must click the **Save** button before moving to a different tab; otherwise, your changes are lost.
- Moving between steps is not achieved by clicking **Next** or **Back**, but rather, by clicking a different tab. To exit the Edit Activity page and return to the Folders view, click **Back**.
Part V

Meditor

Part V contains the following:
- Section 11: Meditor Introduction and Interface on page 101
- Section 12: Working with Objects on page 109
- Section 13: Working with Metadata on page 121
- Section 14: Searches in Meditor on page 155
- Section 15: Services, Administration, and Utilities on page 163
Meditor Introduction and Interface

This section introduces Meditor tasks and activities.

This section includes:
- Meditor Objects and Metadata on page 101
- The Meditor Interface on page 102
- Accessing the Meditor on page 107

Meditor Objects and Metadata

The Meditor enables you to create and edit digital objects and various types of related metadata.

Digital Entities

Digital entities contain the following main components:
- a persistent DigiTool internal ID (PID)
- metadata of various types that describe the object
- a stream_ref section that points to the contents of an object
- a network file system location where the objects/entities are stored

NOTE:

In the event that the object represents a simple file (for example, a JPG file), the data stream is the file itself. If the object is more complex (a book, a METS file, and so forth), the data stream would be an XML file pointing to other objects in the repository.
Metadata Types

Four types of metadata are supported by the Meditor:

- Descriptive metadata: includes bibliographic information about the digital object, such as title, name, and subject. Metadata formats available for editing in DigiTool are MARC 21, MODS, and Dublin Core.

- Technical metadata: includes information about the physical description of the digital object. Creating a new digital object (for example, a JPEG image) automatically creates the relevant technical metadata fields that can be taken from the object stream.

- Administrative metadata: contains administrative information concerning the object’s history of changes (history metadata) and preservation information (preservation metadata).

- Access rights metadata: includes information on the user’s access rights, object’s copyrights, and object’s usage rights. This information is used to set up rules relating to the objects’ view, edit, and ownership rights.

All types can be created, updated, and deleted using the Meditor.

The Meditor Interface

The Meditor interface was designed with an emphasis on usability and efficient metadata editing. Designated editors (such as MARC, XML, access rights, and so forth) and forms enable easy editing of the metadata and are key components of the Meditor.
The various interface elements in the Meditor are explained in the following sections.

**Title Bar**

The title bar shows the name of the program, the administrative unit in use and the server name. It also displays status messages relating to the program and to user commands:

![Figure 41: Meditor Title Bar](image)

**Menu Bar**

The menu bar is laid out conventionally:

![Figure 42: Meditor Menu Bar](image)

Click a menu name (for example, **Metadata**) to display the commands available from the cascading menus.
Object Bar

The object bar contains brief information about the object being edited, such as the administrative unit, PID, metadata name, and number:

![Figure 43: Meditor Object Bar](image)

The following table describes the buttons on the object bar.

<table>
<thead>
<tr>
<th>Image</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Get" /></td>
<td>Get</td>
<td>Retrieves the record whose PID was entered in the text field. (Also use Enter on the keyboard.)</td>
</tr>
<tr>
<td><img src="image" alt="Save Metadata on Server" /></td>
<td>Save Metadata on Server</td>
<td>Saves the current record to the server.</td>
</tr>
<tr>
<td><img src="image" alt="Close Object" /></td>
<td>Close Object</td>
<td>Closes the current record.</td>
</tr>
<tr>
<td><img src="image" alt="Open Template" /></td>
<td>Open Template</td>
<td>Allows the user to select a predefined template for the creation of new metadata.</td>
</tr>
<tr>
<td><img src="image" alt="Full Screen" /></td>
<td>Full Screen</td>
<td>Displays the current record on the entire screen. This option can also be used to display content in the lower pane on the entire screen. (Click the lower pane to select it, then click the Full Screen button.)</td>
</tr>
<tr>
<td><img src="image" alt="Activate Keyboard" /></td>
<td>Activate Keyboard</td>
<td>Activates a keyboard in the GUI that enables you to enter characters that are not integrated into your standard keyboard. Several alternative languages can be used with this option or you can configure your own option(s).</td>
</tr>
</tbody>
</table>

Operations Bar

The operations bar shows you the status of the connection to the server (on the left). Using the buttons on the right, you can change the printing mode, change your password and logon information, change the language, and connect as a different user or to another administrative unit.

![Figure 44: Meditor Operations Bar](image)
launch bar

Using the launch bar, you can open different modules in DigiTool:

Table 10. Launch Bar Buttons

<table>
<thead>
<tr>
<th>Image</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editor</td>
<td>Editor</td>
<td>Used to edit objects and metadata. (Keyboard shortcut: Ctrl + R)</td>
</tr>
<tr>
<td>Search</td>
<td>Search</td>
<td>Used to search for objects in Resource Discovery and the repository, and for descriptive metadata in external databases. (Keyboard shortcut: Ctrl + K)</td>
</tr>
<tr>
<td>Collections</td>
<td>Collections</td>
<td>Opens the Collection Management module. (Keyboard shortcut: Ctrl + O)</td>
</tr>
<tr>
<td>Deposit</td>
<td>Deposit</td>
<td>Opens the Approver module, where you can approve/decline material submitted by patrons. (Keyboard shortcut: Ctrl + G)</td>
</tr>
<tr>
<td>Ingest</td>
<td>Ingest</td>
<td>Opens the Ingest module, where you can upload objects to the system. (Keyboard shortcut: Ctrl + I)</td>
</tr>
<tr>
<td>Management</td>
<td>Management</td>
<td>Opens the Management module, where you can manage various aspects of objects and their metadata. (Keyboard shortcut: Ctrl + M)</td>
</tr>
</tbody>
</table>

navigation tree

The navigation tree enables you to view information about objects, including:

- objects that were Last accessed by the user.
- unsaved Objects Open on local drive.
- object Manifestations.
- lower and higher level objects related to the object being edited (Includes and Part of relations).

![Figure 45: Navigation Tree](image-url)
Accessing the Meditor

The Meditor is a Windows-based client that opens from your Start > Programs > DigiTool menu. Once you access the client and log on, you must make sure you are connected to the administrative unit to which your objects and data belong before you can start working with objects. Once you are connected to the correct administrative unit, all new records and existing records retrieved through PIDs are delivered from the administrative unit.

To connect to an administrative unit:

1. Right-click the button at the bottom right of the screen or click the Connect to command from the DigiTool menu. A menu similar to the following is displayed:

   ![Menu - Connecting to Administrative Unit](image)

   **Figure 46: Menu – Connecting to Administrative Unit**

2. Select your administrative unit from the list.
Working with Objects

This section describes Meditor tasks and activities related to object management.

Creating New Objects

When a new record is created, it is automatically saved on the server with a unique Persistent Identifier DigiTool number (PID), which displays on the object bar, the object navigation tree, and anywhere else in the system that the unique identifier is needed.

There are two ways to create a new object using Meditor:

- Adding a New Object on page 109
- Duplicating an Object on page 112

Adding a New Object

When you add a new object, you enter all new information about an object and its metadata.
To create a new object:

1. From the **Object** menu, click **Insert New Object**.
   
   A New Object Information form opens

   ![New Object Information Form](image)

   Figure 47: New Object Information Form

2. Enter information in the relevant fields and click the **Create** button.
   
   The form refreshes with two tabs: the **Control** tab (displaying the information you just entered) and the **Stream Ref** tab. In the bottom pane, the **Browser** tab and **Collections** tab display.
In the **Control** tab, edit and update the object's information as required.

To upload the file or the URL reference, click the **Stream Ref** tab and select the **Attach File**, **Attach URL**, or **Copy URL** button.
NOTE:
From the Stream Ref tab, you can also download objects by clicking the Download button.

5 To download an object package (consisting of zipped stream and metadata records), click **Download Object** from the **Object** menu. When you do, a list of all available items for download opens.

![Figure 50: Download Object List Box](image)

6 Select or clear the check boxes and click **OK** to begin the download process. (You will be prompted for a local directory.)

**Duplicating an Object**

You can duplicate the object you are currently working on and save it under another unit.

**To duplicate an object:**

1 From the **Object** menu, click **Duplicate Object**.

   The Select Unit dialog box opens with a list of available units.

2 Click the unit in which you want the new duplicated record to be saved and click **OK**.

   After you have selected a unit, the duplicated record will be displayed and you can edit the copy. The new record will be located on your local drive.
Deleting, Refreshing, Closing, and Purging Objects

This section describes the following actions that can be performed on objects:

- Delete Object on page 113
- Refresh Object on page 113
- Close Object on page 113
- Purge Local Objects on page 114
- Remove a Filestream/URL from an Object on page 114

Delete Object

To delete an object from the repository, select Delete Object from Server from the Object menu.

**NOTE:**
After deleting an object, you will not be able to search and find the object in the repository. However, the object will remain viewable in Resource Discovery until the next harvesting service is performed.

Refresh Object

The refresh object function retrieves the object from the server.

To refresh an object, select Refresh Object from the Object menu. This function can be used to discard your changes and reload the original object from the server.

You can also use this option when an object is locked by another user. By refreshing the object, you can discover whether the object is released from locking.

Close Object

This option enables you to close the object that is currently open.

To close an object, select Close Object from the Object menu. The object will no longer be displayed on screen.

**NOTE:**
Closing or refreshing an object that has not been saved may cause loss of information.
Purge Local Objects

This option enables you to close all objects that are open on the local drive and have not yet been saved on the server.

To purge an object, select Purge Object from the Object menu. You receive a prompt asking if you are sure you want to purge the unsaved objects. Click Yes to continue purging the objects.

NOTE:
After purging the objects from your local drive, you will still be able to reopen the objects from the repository. However, recent changes you have made will not be saved.

Remove a Filestream/URL from an Object

If an object has a File or URL attached to it, you can remove the filestream/url from the digital entity using the Meditor. This will remove the object’s related stream file without impacting the object itself.

To delete an object’s file stream:

1. Access the object in the Meditor using a search or browse.
2. Click the Stream Ref tab.
   The tab opens with the Delete Stream button active.

NOTE:
If the Delete Stream button is disabled, your object is not associated with a file or URL, and there is no stream to be deleted.
Chapter 12: Working with Objects

3 Click the **Delete Stream** button.
   A confirmation message opens.
4 Click **Yes** to confirm the deletion, **No** to discard the action.
   The **Stream Ref** tab in Meditor is refreshed; it shows an empty Stream Ref
   and a disabled **Delete Stream** button.

### Object Services

The **Object Services** menu enables you to perform maintenance services on an
object. This option is available only when an object is open in the Meditor. The
list of services available is sensitive to the object type, which means that only
relevant services will be presented for a specific object.

The following is a full list of services:

- **Extract Technical Information into Technical Metadata** – This service is
  available for objects with streams. It performs technical metadata extraction
  from the stream itself and creates read-only JHOVE metadata aside from the
  relevant technical metadata.

- **Checksum Validation** – This service is available for objects with checksum
  information. It performs a validation of the checksum information.

- **Full-Text Extraction for Index Creation** – This service is available for objects
  with streams that have a text file extension (for example, `.txt` or `.doc`).
  This service creates a new object with a manifestation relation that is related
  to the original object. Its usage type value is **Index**. This index file contains
  the full-text that was extracted from the original stream.

- **Create Image Thumbnail** – This service is available for objects with streams
  that have an image file extension (for example, `.jpg` or `.tif`). It creates a
  new object related to the original object with a usage type value of
  **Thumbnail**. The thumbnail file contains the thumbnail image that was
  created from the original stream.

- **Create Persistent Identifier Within PREMIS Metadata** – This service is
  available for all objects that do not already have a persistent identifier
  within the preservation metadata (PREMIS Object Entity). This service
  generates a persistent identifier according to default rules and profiles set in
  the persistent identifier configuration files. The persistent identifier is saved
  in the preservation metadata (`preservation_md`).

- **Jp2000** – Tiff to Jp2 derivative creation. This service is available for objects
  with streams that have an image file extension of `.tif` or `.tiff`. It creates a new
digital entity related to the source `.tiff` digital entity via manifestation
relationship. The derivative `jp2` will attain usage type VIEW and a file
format of Jpeg2000 (`.jp2`).
NOTE:
The persistent identifier generated and placed within the preservation metadata is different from the DigiTool PID, which is a DigiTool-unique identifier within the Digital Entity metadata.

Navigation Tree

The navigation tree is located in the lower left pane of the Meditor interface.

![Navigation Tree]

From here you can navigate to the following items:
- Last Accessed objects
- Objects Open on Local Drive
- Object Manifestations
- Child Objects (Includes)
- Parent Object (Part of)

Last Accessed

In the Last Accessed section, you can perform the following actions:
- Open the object in the Editor pane. To do this, double-click the object’s PID.
- Create a manifestation link to the current object. This option enables you to create a manifestation link between the current object open in the Editor pane to the object selected in the Last Accessed section. To use this option, right-click the object’s PID and click Create Manifestation Link to the current object.
Create a “part-of” link to the current object. This option enables you to create a “part-of” link between the current object open in the Editor pane to the object selected in the Last Accessed section. To use this option, right-click the object’s PID and click Create Part of Link to the current object.

Open on Local Drive

In the Open on Local Drive section, you can view objects that have been saved on your local drive and that have not yet been saved on the server. In this section, you can perform the following actions:

- Open the object in the Editor pane. To do this, double-click the object’s PID.
- Delete the selected local object. To do this, right-click the object’s PID and click Delete Selected Local Object.
- Create a manifestation link to the current object. This option enables you to create a manifestation link between the current object open in the Editor pane to the object selected in the Last Accessed section. To use this option, right-click the object’s PID and click Create Manifestation Link to the current object.
- Create a “part-of” link to the current object. This option enables you to create part-of link between the current object open in the Editor pane to the object selected in the Last Accessed section. To use this option, right-click the object’s PID and click Create Part of Link to the current object.
links from a Parental PID to sets of objects, use the Create Link to Parent Relation job in the Management module.

![Image: Open on Local Drive Options](figure54.png)

**Figure 54: Open on Local Drive Options**

### Manifestations

In the **Manifestations** section, you can view the object’s manifestations. In this section, you can perform the following actions:

- Open the object in the Editor pane. To use this option, double-click the object’s PID.
- Delete a manifestation link. To do this, from the **Object** menu, select **Detach manifestation relations**.

### Includes

In the **Includes** section, you can view the object’s descendant objects. In this section, you can perform the following actions:

- Open the object in the Editor pane. To use this option, double-click the object’s PID.
- Delete links. To use this option, click the **Object** menu and select the remove from object’s manifestation group.

### Part of

In the **Part of** section, you can view the object’s parent object. In this section, you can perform the following actions:

- Open the object in the Editor pane. To use this option, double-click the object’s PID.
- Delete links. To use this option, right-click the object’s PID and click **Delete Links**.
Viewing and Refreshing Objects

From the Meditor interface lower right pane you can view or refresh the object using the Browser tab’s View/Refresh Object option.

![Figure 55: Browser View of Object](image)

Linking Objects to Collections

You can link the current object you are working on to an existing collection.

**NOTE:**
You can link collection metadata in the same way using entity type. See Associating Metadata with a Collection on page 197.
To link an object to a current collection:

1. Click the **Collections** tab in the lower right pane.

![Figure 56: Collections Tab for Object Linking](image)

2. Click the **Link** button.

   The Collection Map opens in a DigiTool browser window.

![Figure 57: Collection Map for Linking](image)

3. Select the collection you want to link your object to and click **OK**. The object is linked to this collection.

You can link the object to multiple collections by repeating the above steps.

**NOTE:**

To be able to access the Collection Management from the Meditor interface, you must have the appropriate permissions.
Working with Metadata

This section describes Meditor tasks and activities related to metadata management.

This section includes:
- Creating New Metadata on page 121
- Editing Metadata on page 126
- Editing XML Tags on page 127
- MARC Metadata Editor on page 131
- Dublin Core Form Editor on page 146
- Access Rights Form Editor on page 147
- Saving Metadata on page 150
- Updating, Refreshing, and Deleting Metadata on page 152

Creating New Metadata

There are four ways to create new metadata records:
- Insert new metadata – For details, see Insert New Metadata on page 122.
- Predefined templates – For details, see Open Template on page 123.
- Insert from a local drive – For details, see Insert from Local Drive on page 124.
- Search metadata – For details, see Search Metadata on page 125.
Insert New Metadata

You insert new metadata using the **Insert New Metadata** menu option.

**NOTE:**
Descriptive metadata types (MARC, MODS, and Dublin Core) can be used more than once on a single object. All other metadata types can be added only once.

To insert new metadata

1. From the **Metadata** menu, select **Insert New Metadata**. The following list is generated:

   ```
   descriptive : marc
   descriptive : dc
   descriptive : mods
   technical : text_md
   technical : image_rico
   technical : audio_md
   technical : video_md
   accessrights : rights_md
   copyrights : copyrights_md
   changehistory : changehistory_md
   preservation : preservation_md
   rights : prems_rights
   mets_section : structMap
   mets_section : metaHdr
   mets_section : fileSec
   ```

   Figure 58: Metadata List

2. Select the metadata type you want to add. The metadata is displayed in the Editor with the root element tag.

**NOTE:**
New metadata is initially created with root tag only. More tags/nodes can be added using the Edit functions.
Open Template

Use this option when you want to use predefined metadata templates.

**To use a predefined template:**

1. From the Metadata menu, select Open Template. The List of Templates window opens.
2. Choose a metadata type (for example, Technical: video_md). The selected template opens with the full XML.

3. Click the Open button. In the upper section of the Meditor’s main pane, the Metadata Editor opens with the relevant metadata tags.
Insert from Local Drive

Use this option when you want to upload metadata from your local drive.

To insert metadata from your local drive:

1. From the Metadata menu, click Insert from Local Drive. The Open Local Metadata dialog box opens:

![Figure 61: Browse for Local Metadata](image)

2. Choose a metadata type and browse for the file path on your local drive.
3. Click OK to open the metadata in the Editor.
Search Metadata

The Search Metadata function enables you to locate metadata records by keyword search within your current unit. You can copy the metadata record or you can link the metadata record to an object.

To locate metadata records using the Search Metadata function:

1. From the Metadata menu, select Search Metadata. The Search for Metadata dialog box opens.

![Search for Metadata Dialog Box](image)

2. Select your metadata type from the Choose metadata drop-down list (for example, descriptive: dc).
3. Select a code (for example, title) from the Search code drop-down list.
4. Type an entry in the Search query box (for example, Bonds) and click the Find button.

DigiTool returns the matching records.

You can copy the metadata to your current object or link the metadata to your object. To do this, highlight the metadata you want to use and click Copy to Object or Link to Object. The metadata is attached to the current object and is opened in the editor for further editing.
Editing Metadata

An object’s metadata is displayed under the object tree. To open the metadata in the Editor, double-click it. To display the metadata menu, right-click the metadata name.

When you make changes to metadata, its representation is changed by a preceding asterisk, red color, and italic font style: *text_md - 1.*

When saved on your local drive, the asterisk is removed: text_md - 1.

When saved on the server, the record representation appears without any formatting: text_md – 1.

Two types of metadata editors are available, XML and MARC. The MARC editor is used for editing descriptive MARC metadata and is described in MARC Metadata Editor on page 131. The XML editor is a user-friendly tool for editing XML tree-based metadata.

You can view the metadata in the object’s navigation tree.

**HINT:**

The Metadata Editor (upper pane) must be in focus for editing purposes.
XML Editor

The XML editor is a tree-based editor that enables free editing of the metadata tags.

![XML Editor](image)

Figure 64: XML Editor

A single tag can contain attributes, nested tags or data. For example, in the figure above, the Checksum tag contains one attribute (ID) and two nested tags (Checksum Method and Checksum Value).

Each branch of the tree is displayed in a delineated box. You can collapse and expand each branch using the collapse/expand buttons.

In addition, you can narrow and widen the box frames by placing your cursor on a frame and, when an arrow appears, dragging the frame to the right or to the left.

Editing XML Tags

The XML tags are displayed in a tree-based editor. Each tag is also a node on the tree. A node can have parent, sibling, and/or child nodes.

From the Edit menu you can add new tags, move a tag to another location on the tree using copy, cut and paste, insert snippets, and delete tags.
Editing Functions for the XML Editor

The table below contains the full list of available editing functions for the XML editor. Most of these can be found in the Edit menu of the Meditor. More complicated functions (for example, Add New Node and Insert Snippets), are described in more detail below the table.

Table 11. XML Editor Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo (ShrtctKy: Ctrl+Z)</td>
<td>Reverses your last action. Each click reverses one additional action.</td>
</tr>
<tr>
<td>Redo (ShrtctKy: Ctrl+Y)</td>
<td>Restores the last action that was undone using the Undo function.</td>
</tr>
<tr>
<td>Add New Node</td>
<td>Allows you to add a new sibling node to the XML tree.</td>
</tr>
<tr>
<td>Add New Sub Node</td>
<td>Adds a new sub-node to the XML tree.</td>
</tr>
<tr>
<td>Cut Selected Node</td>
<td>Moves the selected nodes to the Windows clipboard, where they can be deleted or moved to somewhere else in the XML tree.</td>
</tr>
<tr>
<td>Copy Selected Node</td>
<td>Copies the selected nodes to the Windows clipboard.</td>
</tr>
<tr>
<td>Paste Selected Node</td>
<td>Inserts the copied nodes below the current node. The tags, attributes, and contents are also pasted.</td>
</tr>
<tr>
<td>Delete Selected Node</td>
<td>Deletes the current nodes.</td>
</tr>
<tr>
<td>Insert Snippet</td>
<td>Allows you to insert a predefined snippet of the XML tree.</td>
</tr>
<tr>
<td>Expand All</td>
<td>Expands all tree nodes.</td>
</tr>
<tr>
<td>Collapse All</td>
<td>Collapses all tree nodes.</td>
</tr>
<tr>
<td>Expand/Collapse All in the Selected Node</td>
<td>Expands/collapses only the selected node of the tree.</td>
</tr>
<tr>
<td>Help on Field</td>
<td>Enables you to automatically select the Tag Information tab from the lower pane. This tab provides a guide to the use of valid indicators, subfield codes, and values for the field selected in the upper pane. To receive help on a field, place your cursor on the field of interest. The tab will automatically display the relevant tag information.</td>
</tr>
<tr>
<td>Find</td>
<td>Enables you to find text in the current record. You can specify case-sensitive and whole-word searches.</td>
</tr>
</tbody>
</table>
Table 11. XML Editor Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace</td>
<td>Enables you to find and replace one character string with another string in the current record, wherever the first string appears. This option has two replace modes. In the first mode, all replacements are done automatically (Replace All). In the second mode, each replacement requires you to click Replace. You can specify case-sensitive and whole-word searches.</td>
</tr>
<tr>
<td>Check Record (ShrtctKy: Ctrl+U)</td>
<td>For the current tag, this function:</td>
</tr>
<tr>
<td></td>
<td>■ Checks that the attributes and/or contents are valid for the tag.</td>
</tr>
<tr>
<td></td>
<td>■ Checks that mandatory tags are present.</td>
</tr>
<tr>
<td></td>
<td>■ Checks that non-repeatable tags are not repeated.</td>
</tr>
<tr>
<td></td>
<td>■ Checks dependencies between the selected tag and other tags in the metadata.</td>
</tr>
<tr>
<td>Browse headings of external databases</td>
<td>When adding contents to a tag of descriptive metadata (Dublin Core or MARC), you can choose from a list of headings in external databases. For example, you could search for Title in the MARC 21 field 245.</td>
</tr>
<tr>
<td>View Record’s Editors</td>
<td>Displays the list of editors who have edited the selected record. The Editor Level of each person is provided, along with the date and hour that each editor edited the metadata.</td>
</tr>
</tbody>
</table>
Additional XML Editing Functions

The following additional functions can be performed using the XML editor:

- **Adding a new node** – To add a new tag (tree node) as a sibling, right-click the tag to which you want to attach the node and click **Add New Field**. A list of available tags appears. A list of available tags appears.

![Figure 65: Available XML Tags for Selection](image)

Select the field you want to add and click **OK**. The new node is added as a sibling below the node you selected.

- **Adding a new sub-node** – To add a new sub-node, right-click the tag to which you want to attach the sub-node and click **Add New Sub Field**. The new tag is added as a child to the tag you selected.

- **Inserting snippets** – In some cases, you might want to add only a small segment (a “snippet”) of a large XML file. Predefined snippets are available for the Access Rights Metadata. To insert a snippet, right-click the parent tag and select **Insert Snippet**. The snippet is added under the tag on which you placed your cursor.
Viewing tag information – To view a definition of a specific tag in a record, select the tag in the upper XML pane and click the Tag Information tab in the pane below. A definition for the tag displays in the Tag Information tab.

![MIME Type](image)

**Figure 66: Tag Information for XML Editor**

Editing record contents in the XML Editor – To edit the contents of a record, use basic Windows commands for typing over text and for cutting, copying, and pasting sections of text on the clipboard. Note that some of the tags have an enlarged text area (for example, the Title tag in Dublin Core) for easy editing. Each metadata record (excluding descriptive MARC metadata) is limited to 90,000 bytes.

**MARC Metadata Editor**

MARC metadata can be edited using the MARC Record Editor. From the Editor, you can add, edit, and delete fields.

The figure below shows a sample MARC metadata record in the Editor environment. To access the Editor environment, open a record that contains MARC metadata or add your own MARC data to a record. Then click the MARC link in the left column’s Descriptive node.
Editing Records

To edit a MARC record, use the following Windows conventions for moving around the record:

- **Up/Down arrows** - moves up/down by one line
- **Left/Right arrows** - moves left/right by one space
- **Tab** - moves from field to field
- **Page Up** - moves up by one page
- **Page Down** - moves down by one page
- **Home** - moves to the beginning of the line where the cursor is positioned
- **End** - moves to the end of the line where the cursor is positioned
- **Ctrl+Home** - moves to the beginning of the record
- **Ctrl+End** - moves to the end of the record

Editing the Tag

The tag works in overwrite mode only. To change the tag, type over it. To delete a character, use the spacebar (not the **Delete** key).
Chapter 13: Working with Metadata

**Editing the Indicator**

The indicator works in overwrite mode only. To change the indicator, type over it. To delete a character, use the spacebar (not the Delete key).

**Editing the Subfield Code**

The subfield code works in overwrite mode only. To change the code, type over it. It is not possible to delete a character with either the spacebar or the Delete key. To delete a subfield, press Ctrl+F7 or click Delete Subfield from the Delete submenu of the Edit menu. This will delete both the subfield code and its contents.

**Editing the Contents**

The content area is set to work in insert mode. To work in overwrite mode, press the Insert key. Note, however, that when using the spacebar to enter a blank space while working in insert mode, you may enter only one blank space at a time. You are prevented from inserting a number of blank spaces in a row.

To delete a single character while working in insert mode, use the Delete key (not the spacebar). To delete a group of characters, select the text, then use the Delete key or the spacebar.

Use basic Windows commands to edit the contents (for example, to cut text, press Ctrl+X or click Cut from the Edit menu).

**NOTE:**

You cannot enter consecutive dollar signs ($$), as the system uses two consecutive dollar signs to define subfields. Consecutive dollar signs should be entered with spaces in between. However, two consecutive dollar signs ($$) can be used to enter new subfields without opening a new subfield code line when you use the New Subfield command from the Edit menu.

Fields are limited to 2000 bytes. Records are limited to 5000 bytes and subfields to 45000 bytes.

For this reason, the system does not allow you to enter more than 2000 bytes per field. When long fields are imported, if the text for a single field is more than 2000 bytes, the system splits the text into separate (repeated) fields. Split fields are prefaced by $$9. For export purposes, you can use this method to edit long fields.
Available Editing Functions

The following table contains the full list of available editing functions for the MARC editor. The more complicated functions, such as Fix Record and Derive New Record, are described in more detail below the table.

Table 12. Available Editing Functions for the MARC Editor

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
<td>Enables you to reverse your last action. Each click reverses one more action.</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
<td>Enables you to redo the last action that was undone using the Undo function.</td>
</tr>
<tr>
<td>Open Form</td>
<td>Ctrl+F</td>
<td>Opens a form that enables you to edit the contents of a field. If no form is available, the system will open the subfields for you to edit directly in the metadata record.</td>
</tr>
<tr>
<td>Expand from Template</td>
<td>Ctrl+E</td>
<td>Adds fields and subfields from a template to your current record.</td>
</tr>
<tr>
<td>Help on Field</td>
<td>None</td>
<td>Enables you to automatically select the Tag Information tab from the lower pane. This tab provides a guide to the use of valid indicators, subfield codes, and values for the field selected in the upper pane. To receive help on a field, place your cursor on the field in question. The tab displays the relevant tag information.</td>
</tr>
<tr>
<td>Change Record’s Format</td>
<td>None</td>
<td>Enables you to change the record’s format. Changing the record’s format will also change the forms (for entering field data) and the checks that are performed on the record.</td>
</tr>
<tr>
<td>Enter Unicode Values</td>
<td>F11</td>
<td>Enables you to enter Unicode values for characters not present on your keyboard. The Unicode values can be entered after selecting the Enter Unicode Values command from the Edit menu or using the F11 shortcut key. To finish, select the Enter Unicode Values command again or use the F11 shortcut key. The status bar displays a message to indicate that the user is currently working with the Enter Unicode Values option.</td>
</tr>
<tr>
<td>New Field (choose from list)</td>
<td>F5</td>
<td>Enables you to add a new field by choosing from a list of fields.</td>
</tr>
<tr>
<td>New Field (user-defined)</td>
<td>F6</td>
<td>Enables you to add a field whose tag, indicator, and subfields you may define by yourself.</td>
</tr>
</tbody>
</table>
Table 12. Available Editing Functions for the MARC Editor

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Direction (Alpha)</td>
<td>None</td>
<td>Enables you to change the text direction of the current field.</td>
</tr>
<tr>
<td>New Subfield</td>
<td>F7</td>
<td>Opens a new subfield below the current subfield.</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>Deletes the selected text and places it on the Windows clipboard for possible pasting elsewhere in the record or in another record.</td>
</tr>
<tr>
<td>Cut Subfield(s)</td>
<td>None</td>
<td>Enables you to move the selected subfields to the Windows clipboard. This option can be used for deleting the subfields or, together with the Paste subfield command, for moving the subfields from one place to another (cut-and-paste).</td>
</tr>
<tr>
<td>Cut Field(s)</td>
<td>None</td>
<td>Moves the selected fields to the Windows clipboard. This option can be used for deleting the fields or, together with the Paste field, for moving the fields from one place to another (cut-and-paste).</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>Copies highlighted text to the Windows clipboard.</td>
</tr>
<tr>
<td>Copy Subfields</td>
<td>Ctrl+S</td>
<td>Copies the selected subfields to the Windows clipboard. Both the subfield codes and contents will be copied.</td>
</tr>
<tr>
<td>Copy Field(s)</td>
<td>Ctrl+T</td>
<td>Copies the selected fields to the Windows clipboard. The tags, indicators, subfield codes, and the contents will all be copied.</td>
</tr>
<tr>
<td>Copy Record</td>
<td>Ctrl+D</td>
<td>Copies the entire contents of the current record to the Windows clipboard. Together with Paste Record, this option can be used to merge records.</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>Inserts the text that has been copied to the Windows clipboard.</td>
</tr>
<tr>
<td>Paste Subfield(s)</td>
<td>Alt+S</td>
<td>Inserts the copied subfields below the current subfield. Both the subfield codes and the contents will be pasted.</td>
</tr>
<tr>
<td>Paste Field(s)</td>
<td>Alt+T</td>
<td>Inserts the copied fields below the current field. The field’s tags, indicators, letters of the subfields, and the contents will all be pasted.</td>
</tr>
<tr>
<td>Paste Record</td>
<td>Alt+D</td>
<td>Pastes the entire contents of the copied record into the current record. This option can be used to merge records. Note that duplicated fields will appear one after the other if a sorting procedure is defined by your system librarian for the pasting routine.</td>
</tr>
</tbody>
</table>
Delete Subfield Ctrl+F7 Deletes the subfield where your cursor is placed (either in the subfield or in the contents of the subfield).

To delete a group of subfields from the field, highlight the desired subfields to select them. Then press Ctrl+F7 or select Edit > Delete > Delete Subfield(s).

Note that if only an "a" subfield is remaining, you can delete its contents, but not the letter "a." If any other subfield is the only remaining subfield (for example, only a "c" subfield remains), you can delete both the subfield code and its contents. In their place, an "a" subfield with empty contents is displayed.

Delete Field Ctrl+F5 Deletes the current field.

To delete a field, place the cursor anywhere in the desired field (on the tag, the indicator, the code of any subfield, or the contents of any subfield).

To delete a group of fields, highlight the desired fields to select them. Then press Ctrl+F5 or select Edit > Delete > Delete Field(s).

Delete Record from Server Ctrl+R Deletes the current record from the server. Note that the record will not actually be deleted, but all fields except the LDR field will be removed. In addition, all links from the record to the Resource Discovery indexes will be removed. It is possible to set up the system so that when an editor tries to delete a record, the system checks to see if there are any links from the record to another record or if there are any associated items, subscriptions, orders, loans, photocopy requests, or hold requests.

Find None Performs a text search of the record. You can find text with the same capitalization style as the text you type and whole words instead of parts of words.

Replace None Performs a search and replace of a character string in the current record. This option has two replace modes: Replace All for automatically replacing all strings and Replace for replacing each instance of the string individually, one click at a time. You can use whole-word and case-sensitive features for both modes.
### Table 12. Available Editing Functions for the MARC Editor

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Field</td>
<td>Ctrl+W</td>
<td>For the current field, this function verifies:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- that the indicators and/or subfield codes are valid for the tag.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- that mandatory subfields are present.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- that non-repeatable subfields are not repeated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- dependencies between the selected field and other fields in the record.</td>
</tr>
<tr>
<td>Check Record</td>
<td>Ctrl+U</td>
<td>For the current record, this function verifies that:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- the indicators and/or subfield codes are valid for the tag.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- the required fields and subfields are present.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- non-repeatable fields and subfields are not repeated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- all dependent fields are present.</td>
</tr>
<tr>
<td>Browse headings of external databases</td>
<td>None</td>
<td>Allows you to browse a list of headings in external databases when you are adding contents to a tag of a descriptive metadata (Dublin Core or MARC)</td>
</tr>
<tr>
<td>Sort Record</td>
<td>Ctrl+M</td>
<td>Sorts the fields of the current record according to the order defined in the table of codes. However, for MARC 21 collections, within the 5xx, 6xx and 7xx groups of fields, the order of the fields remains as they were entered by the editor. Fields that do not have any content are deleted. In an authority collection, all fields are sorted according to the order defined in the table of codes.</td>
</tr>
<tr>
<td>Fix Record</td>
<td>None</td>
<td>Automatically fixes the current record according to standard collection-defined procedures that make changes such as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- inserting punctuation into the MARC record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- changing tags—for example, for translation from MARC 21 codes to UNIMARC codes.</td>
</tr>
<tr>
<td>View Record's Editors</td>
<td>None</td>
<td>This option enables you to view the list of editors who have edited the selected record. The Editor Level of each person is given, along with the date and hour that each editor edited the record.</td>
</tr>
</tbody>
</table>
A form enables you to edit the contents of a field. If no form is available, the system will open the subfields for you to edit directly in the metadata record.

To open a form:

1. Place the cursor on the field you want to edit.
2. From the Edit menu, select Open Form or press Ctrl+F. The form for editing the field is displayed. The form lists the subfields and provides spaces for you to type in the contents.

The form below is an example of the form for the MARC 21 field for the imprint (260).

![Figure 68: MARC 21 Field Form](image)

3. Edit the contents of the fields. You may move from space to space by using the Tab key. Note that the spaces of the form are of fixed length. You may not enter text that is longer than the space provided on the form. Click OK. The contents of the field will automatically be inserted into the metadata record.

For fixed-length fields, each line of the form is not a separate subfield, but rather part of one field. A single string of text is created from the data you enter, with fixed locations for each data element.
The form below is an example of the form for the 008 MARC 21 field.

![008 MARC 21 Field Form](image)

If the form has been set to be verified for correctness, after you click **OK**, the system checks for potential errors. If errors are found, the error messages are shown in the Messages tab of the lower pane. The system displays warnings and asks you if you are sure that you want to close the form.

If you click **No**, you can go back to correct the form. Click **OK** when you have finished correcting the form.

### Expand from Template

The Expand from Template function adds fields and subfields from a template to your current record.

**To add fields from a template to your current record:**

1. From the **Edit** menu, select **Expand from Template** or press **Ctrl+E**. This function is the same as the **Open Template** function in the **Metadata** menu.

   A dialog box opens, from which you can select the template of your choice.

2. Select an appropriate template from the dialog box and click **Open**.

   The current record is enhanced with the fields and subfields in the template. Note that the subfields are not sorted in alphanumerical order. For example, if a subfield is repeated, the subfield is placed at the end of the field. In other words, $a$a$b$c are sorted as follows: $a$b$c$a$ and not $a$a$b$c.

### Help on Field

When you are positioned on a field or subfield, the Tag Information tab in the lower pane provides a guide to using the field. This tab gives a description of
the currently highlighted field, along with information regarding the indicators, valid subfields, and a description of the subfields.

![Image of Tag Information Tab]

Figure 70: Tag Information Tab

Note that the Help on Field option from the Edit menu enables you to automatically select the Tag Information tab when other tabs are in focus.

**Change Record Format**

This function changes the record’s current format. The Change Record Format option will also change the forms (for editing fields) and the checks that are performed on the record.
To use the Change Record Format option:

1. From the Edit menu, select Change Record Format. The Choose Record Format dialog box opens.

   ![Figure 71: Choose Record Format Dialog Box](image)

2. Highlight the format of your choice and click OK.

   Forms and checks that are format-sensitive will match the new format of the record.

Add New Fields from a List

You can open a new field below the current field by selecting a field from a standard collection-defined list. To do this, use the F5 shortcut key or select New Field (choose from list) from the Edit menu. A dialog box with the list of fields will open.

To add a new field, press the first character of the field code. The relevant section of codes is displayed. Select the required field and click OK. If subfields have been defined, the tag and its subfields will be displayed. If subfields have not been defined, by default only subfield “a” will be displayed.

To change the text direction of the field, highlight the field and click Alpha. Select the required language direction (Left-to-Right /Right-to-Left) from the box that opens and click OK.
Search Headings and Options
Several types of search functions are available to help you fill in the contents of a field.

To find specific text in the current record:
1. From the Edit menu, select Find. The Find window opens:
2. In the Find what field, type the text you want to find in the record. To find only text with the same capitalization style as the text you type, select the Match case check box. To find only whole words instead of parts of words, select the Match whole word only check box.
3. Click Find Next. To find more occurrences of the text, click Find Next again.
   The direction of the Find command in the record is defined according to the selected option in the Direction section of the window (Up or Down).

Replace Text
You can replace a string of text with different text.

To find and replace text with another string:
1. From the Edit menu, select Replace. The Replace window opens:
2. In the Find what field, type the text you want to replace in the record. To find only text with the same capitalization style as the text you type, select the Match case check box. To find only whole words instead of parts of words, select the Match whole word only check box.
3. In the Replace with field, type the replacement text.
4. Click Find Next to find the string you entered and then click Replace to replace the first occurrence of the text with the new string. To automatically replace all occurrences of the text in the record with the new string, click Replace All.

Check Field and Check Record
To check the current field, place the cursor on the tag of the relevant field or in the content area and select Edit > Check Field or press Ctrl+W.

To check the current record, select Edit > Check Record or click the Check Record button from the object bar.

Either check causes the system to display the potential problems in the Messages tab in the lower pane. If no problems are found, the Messages tab is left empty.

The View Related button becomes enabled when the highlighted message is related to a check routine that performs checks associated with another record.
connected to the one that is being checked. When this button is clicked, the system retrieves the related record.

**Fix Record and Derive New Record**

The **Fix Record** option automatically fixes the current record according to standard collection-defined procedures (fix routines). The **Derive New Record** function enables you to use fix routines in order to create a new record rather than fix the current one. The **Fix Record** and **Derive New Record** options are available from the **Edit** menu.

Routines that have been set to fix the current record appear under the **Fix Record** option. Routines that have been set to create a new record appear under the **Derive New Record** option. For both functions, the fixing procedures are listed in the Choose Fixing Routine window.

![Choose Fixing Routine Window](image)

**View Record’s Editors**

This option enables you to view the list of editors who have edited the current record. To do this, select **View Record’s Editors** from the **Edit** menu. A list box
displays all the editors who have edited the selected record. The editor’s level is listed, along with the editing hour and date.

![Figure 73: List of Editors for Object](image)

**Edit Text Mode**

This option functions as a toggle switch. When it is activated (either via the Edit menu or via a shortcut key, CTRL + F12), the system is ready to receive input. The input is displayed on the status bar as it is typed in.

The input is in the form of command-like language. The following are examples of input:

- search tag=100
- search sf=a
- search text=revolution

In the first example above, search is the operation code, tag is the parameter (that is, which element to search for), and 100 is the value (in this case, the tag) to be searched for.

When you have finished typing text, select **Enter Text Mode** again in order to end the text mode, execute the command, and return to the regular edit mode.

The following rules apply to the Text Mode mechanism:

- The only operation code supported is search for tags (tag), subfields (sf) and text (text).
- The operation code and parameters are not case-sensitive.
- There must be at least one space between the operation code and the parameters.
- No spaces are allowed on both sides of the "=" sign positioned between a parameter and its value.
- When searching for text, the search is not case-sensitive. In addition, if the text contains spaces, type ^ (caret) instead of a space.
When searching for a tag or text, the record is scanned cyclically. That is, if the tag or text is not found by the end of the record, the search continues from the beginning of the record up to the cursor’s location.

When searching for a tag, use a hash (#) as a wildcard. That is, to search for 10010 or 10000 enter 100##. To search for 200 or 220 enter 2##.

When searching for a subfield, the search scope is from the location of the cursor up to the end of the current tag.

**Browse Headings in External Database**

When adding contents to a tag of a descriptive metadata record (Dublin Core or MARC), you can choose from a list of headings in external databases. For example, you could search for Title in the MARC 21 field 245.

**To browse for headings in an external database:**

1. Place your cursor on the 245 tag or in the content area and enter the initial text of the subfield.
2. Select Edit > Browse. A pop-up window appears with headings for the relevant field.
3. Highlight the desired heading to select it and click OK. The highlighted heading is copied into the content area of the field.

**Search Headings**

You can search specific parts of the Headings list.

**To search another portion of the Headings list:**

1. Click Jump to.
2. Enter the starting text for the required heading and click OK. The list redisplay from the text requested.
3. Highlight a heading to select it and copy it to the Editor draft.

**Change Scan Code**

You can change the scan code dynamically (on-the-fly) through the Jump to window.

**To change the scan code:**

1. Select a new scan code from the drop-down list.
2 Enter the starting text for the heading and click **OK**. The new Headings list is displayed.

**NOTE:**
You can also use the **Including text** field to jump more efficiently if you have long headings. For example, if you reach a section of long headings with the same initial text, using the **Including text** field, you can enter the text specific to the required heading. Click **OK** to redisplay the list and highlight the relevant heading.

When there is more than one subfield in the Search subfield heading of the current/other collection window, all of the text in the subfields will be retrieved. You can edit it later.

**Dublin Core Form Editor**

Dublin Core metadata tags can be edited using the Dublin Core metadata form. This form enables fast editing mode and displays the tags in a list view. The following options are available.

**NOTE:**
Use the **Tab** or arrow keys to move from node to node.

- **Adding a new node** – To add a new node, select **Edit**, then **Add New Field**. This will automatically move your cursor to the tag drop-down list box. From here, you can select the DC tag name, tag attribute, and you can enter the value of the tag. To add the tag, click the **Add** button. To cancel the new field, click the **Cancel** button.

- **Editing the tag value** – To edit a tag, select the tag from the list of tags and click the spacebar. This will automatically move your cursor to the data text field. To update your changes, click the **Update** button. To restore your changes, click the **Cancel** button.

- **Sort** – To sort the display of the fields according to the tag (defined in `rep_editor_conf_eng.xml`) select **Edit**, then **Sort Record**. Note that this option sets the DC field order only in the display and not in the database. Therefore, after refreshing or saving the record, the order of the fields are displayed in their original order.

- **Inserting snippets** – Use the **Insert Snippet** command to add a pre-defined set of tags. To do so, select **Edit**, then **Insert Snippet**. A list of available snippet types appears. Select a snippet that you want to insert.

- **Viewing the full screen** – The **Full Screen** command enables you to display as much as possible of the metadata record currently being edited on the screen. To view the current metadata record in Full View mode, select View > Full Screen or click the Full Screen button from the object bar. This
hides the lower pane and the navigation pane so that the cataloging record is displayed in the entire window. To restore the previous view, repeat your previous action.

**Access Rights Form Editor**

The Access Rights metadata form enables you to create access rights expressions and conditions and to add a copyright declaration to an object. The Access Rights metadata form opens when you select Metadata > Insert New Metadata and add accessrights:rights_md. To add fields (or conditions) to rights for an object, select Add New Field from the Edit menu or right-click anywhere in the gray, inactive part of the header and select Add New Field.

An Access Rights metadata form can consist of as few as one field or condition.

![Access Rights Metadata Form](image)

**Figure 74: Access Rights Metadata Form**

The following options are available for the Access Rights Metadata form:
Copyrights

To add a copyright declaration to your object, select the **Copyrights Required** check box. Select the file containing the copyright declaration from the **Copyrights File Name** drop-down list.

![Copyrights](Object: DTL08 - 4721 / accessrights.rights_md [9901])

Enable/Disable the Access Rights Metadata

To enable/disable the access rights metadata, select or clear the **AR Metadata Enabled** check box accordingly. Access rights metadata marked as disabled will not be checked by the system.

Negating and Un-Negating a Condition

To negate an access rights condition, select the condition you want to negate, right-click, and select **Negate/Unnegate Selected Group**. (Or click to highlight the condition and select or clear the **Negate** checkbox.) To undo an access rights negation, perform the same action.

Operators

To specify that a condition must be either equal to or contained within a value or set of values, use the **Within** or **Equals** radio buttons below the **Negate** checkbox.

**NOTE:**

Combining negation with Within/Equals operators allows for the following variations in the **Operations** field: within, not within, equals, not equals.

Add New Access Rights Expression

To add a new access rights expression, select **Edit > Add New Field**. This moves your cursor to the definition box. From here, you can select the expression and
values. To add the expression, click the Add button. To discard your changes, click the Cancel button.

![Figure 76: Add Field to Access Rights](image)

**Editing the Access Rights Expression**

To edit an expression, select it from the list of expressions and press the spacebar. This will automatically move your cursor to the Value field. To update your changes, click the Update button. To discard your changes, click the Cancel button.

**Insert Snippets**

Use the Insert Snippet command to add a predefined set of conditions. To do so, select Insert Snippet from the Edit menu. A list of available snippet types appears. Select a snippet to insert.
Grouping and Ungrouping Expressions

To group several expressions under one access rights condition, select the expressions you want to group together, right-click, and select **Group Selected Items**.

![Figure 77: Group Selected Expressions](image)

The selected expressions are grouped together in one group, and the remaining unselected expressions are grouped together in another group.

To ungroup an access rights condition, select the expression, right-click, and select **Group Selected Items**. Perform this action for every condition you want to ungroup.

Saving Metadata

Metadata can be saved in the following ways:

- on the server – You may want to save all changes you have made to a single metadata type on the server. To save metadata on the server, select **Metadata > Save Metadata on Server**.

- on a local drive – You may want to save single metadata on your local drive either to continue working on it later or because communication links with the server have been severed. You can save your record on your PC’s hard disk, making it unavailable for anyone else to find in the Meditor or Resource Discovery. To save the current record on your local drive, select **Metadata > Save on Local Drive**. You can immediately continue editing the metadata. No updates will be registered unless the metadata is saved again.

- as a template on a local drive – You may want to save the metadata you created as a template for future use. This way, you can save your metadata record in the list of templates on your PC’s hard disk, making it unavailable for anyone else to find in the Templates list. To save the current metadata
record as a template on your local drive, select Metadata > Save metadata as template on local drive.

- all changed metadata types on the server – To save all changed metadata types on server, select Metadata > Save all metadata types on server.

- all changed metadata types on a local drive – You may want to save all changes you have made to all metadata types on your local drive either to continue working on them later or because communication links with the server have been severed. You can save all your metadata record types on your PC’s hard disk, making it unavailable for anyone else to find in the Meditor or the Resource Discovery. To save all changed metadata types on a local drive, select Metadata > Save all metadata types on local drive.

**NOTE:**

If you attempt to close an object without saving it locally or to the server, the Meditor opens an alert box telling you that your updates will be saved locally and not to the server. To continue with a local save only, click the Yes button on the alert box. To save changes to the server, click the No button on the alert box and use one of the above save options.

---

**Locking/Unlocking Metadata**

You can lock or unlock the metadata from editing.

**Lock Metadata**

The system does not allow you to save metadata to the server if another editor has retrieved and saved it before you.

In addition to this automatic security, you can lock a metadata record so that only your changes can be saved on the server until you unlock the metadata. No one else can save this edited version on the server.

To lock the current record, select Metadata > Lock Metadata. The record will be locked and the phrase **Locked by current user** displayed in the object bar.

![Figure 78: Locked by Current User](image)

You can immediately continue editing the metadata record.

Note that when you lock a record, someone else may call up the metadata record from the server. When an editor loads a locked metadata record from the server, a warning message is displayed.

Another user can read the record, and even edit it, but this user cannot save any changes on the server while the record is locked. In addition to the warning
message displayed when the record is first called up, the phrase **Locked by another user** is displayed in the object bar.

![Locked by Another User](image)

**Unlock Metadata**

To unlock a record that you have previously locked, select Metadata > Unlock Record. The record is unlocked and the message in the object bar informing you that the record was locked disappears.

If you save changes on the server and then unlock the record, another editor will not be able to save changes on the server (this is due to the design of the system that ensures that if you update a record while someone else is holding it, the other person’s changes will not be saved). If, however, you unlock the record without saving any changes on the server, the other user can then save changes on the server.

**Automatic Unlocking**

Locked records are automatically unlocked after a period defined by your system librarian. When an editor activates any functions that involve the server (such as Save on Server, Fix, Sort, or Check), the record is locked for an additional period. For example, if the locking period is one hour and the user activates the Fix function after 20 minutes, the record will be locked for a total of 1 hour and 20 minutes.

**Updating, Refreshing, and Deleting Metadata**

You can update the metadata description, refresh metadata, and delete metadata from the server.

**Updating the Metadata Description**

The Update Metadata Description option allows you to attach a name or description to the current metadata with which you are working.

**To update the metadata description:**

1. From the Metadata menu, select Update MD Description. The Update Metadata Description box opens.
2. In the Enter Description field, enter a name and description for the metadata and click OK.

The description can then be used in a search query from the repository.
Chapter 13: Working with Metadata

**Refreshing Metadata**

From the **Metadata** menu, select **Refresh Metadata** to reload the metadata record from the server so that it reflects changes that have occurred since you first opened the pane.

**Deleting Metadata from the Server**

The **Delete metadata on server** function enables you to delete the metadata record from the server permanently. To delete the metadata from the server, open the metadata in the Editor or put your cursor on the metadata name on the record navigation bar. Select **Metadata > Delete Metadata on Server**. A warning message will be displayed. If you click **Yes**, the metadata will be deleted from the server and you will not be able to restore it.

**NOTE:**

If the metadata is shared, it will only be unlinked from the object and not deleted from the server.
Searches in Meditor

This section describes the available search options in the Meditor module.

This section includes:
- Access to Searches on page 155
- From Search on page 156
- From Collections on page 160
- From Management on page 161

Access to Searches

Meditor provides the following searches from the following areas of the module.

Search
- Repository digital entity simple/advanced
- Resource Discovery
- External

Collection
- Advanced object search

Management
- Repository digital entity simple/advanced
- Repository metadata simple/advanced
From Search

The **Search** button opens a pane with three tabs for conducting three different types of searches: repository, resource discovery, and external. The repository and resource discovery searches return digital object records and links to the objects themselves, provided they exist in an internal database. The external search returns records matching your search terms from the location you select.

**NOTE:**
The repository search accessed through the Search section does not provide access to the metadata search. To access the metadata search, you must enter through the Management section.

Search in Repository

You can search for objects in the repository using the Meditor’s digital entity searches or metadata searches.

**NOTE:**
These searches are all available in the Web-based Management module as well.

**Repository Simple Search**

The simple search is the default search when you initially enter a repository search.
To search the repository using the Meditor simple search:

1. From the navigation pane, click the **Search** button (magnifying glass) and select the **Repository** tab. The repository search pane opens.

![Figure 80: Repository Search Pane](image)

2. Enter search terms in the **Find** field, select the fields to search in the **By** field drop-down list, and change the **Search Base** if you want to narrow your search by unit.

   The query results display on the page.

![Figure 81: Repository Search Results](image)

From the query results, you can view the object’s details, open the object’s stream, and navigate within the object’s manifestations and related objects.

To open the object in Meditor, click the **Edit** (pencil) button to the left of its PID.
Repository Advanced Search

Conduct an advanced search when you want to use multiple rows of search terms connected by Boolean operators.

To access the advanced search, click the Advanced search text in the upper right of the search form. Use the Add Condition and Delete text links as needed to build your search.

Results display in the same format as results for simple searches (see Figure 81).

Search in Resource Discovery

You can search for objects in the Resource Discovery and open objects in the Meditor for further editing.

In the navigation pane, click the Search button and select the Resource Discovery tab. In this tab, you can search for objects that have already been harvested and indexed. You can open objects in the Meditor by clicking the Edit (pencil) button in the query results.

NOTE:
If you are not connected to the same unit to which the object belongs, the Meditor opens an alert box asking if you want to change the unit to which you are connected. Click the Yes button to change your connection so that you can edit the object.

Search in External Databases

The external search allows you to locate bibliographic records from external databases (for example, Library of Congress) and copy the MARC metadata to the object on which you are currently working.
To search an external database:

1. From the launch bar, click the **Search** button.
2. Click the **External** tab. The external search pane opens.

![External Search Pane](image)

3. Enter the external base, heading list type, and your query for the search.
4. Click the **Search** button. The list of results displays in the lower pane.

![External Search Results](image)

5. Highlight one or more entries and click **Copy to Object**.
   The MARC metadata is copied to the object and the Editor is opened for further editing.
From Collections

The Collections button opens a list (or tree) of collections in one column. When a user clicks a folder or collection containing items, the items display in the left column and a complex search pane opens in the right (Figure 85).

![Figure 85: Search from the Meditor Collection Manager](image)

You can perform a search for objects in the administrative unit that you have access to. Select fields and enter search terms and connectors, then enter any other specifications. When you click the Go button, DigiTool conducts the search and returns results on the Results tab (Figure 86).
To add the current object to the collection on the left, click the left arrow button (circle in Figure 86).

**From Management**

The Management button opens a Repository search form with the default Digital Entity Search open on the subnavigation bar. Users can perform this search as a simple, one-row search or as an advanced search (by clicking the Advanced search text link in the upper right corner of the form).

To perform a search that returns metadata only, click the Metadata Search subnavigation text. A similar form opens with the same advanced search option for users requiring more than one row of parameters.

Figure 87 shows the comparison of the two search types.
Figure 87: Digital entity and metadata search forms from the Meditor

See **Repository Searching** on page 21 for more detailed information on these search types.
Services, Administration, and Utilities

This section describes the available services, administrative options, and utilities in the Meditor.

This section includes:
- Services on page 163
- Administration on page 166
- Utilities on page 172

Services

Each service is identified in the Batch Log and Batch Queue by its procedure name.

The following Meditor services exist:
- Service History List on page 163
- Retrieve Records from Silo (ret-01) on page 164
- Print Records on page 164
- Build Indexes to the Silo on page 164
- General on page 165

Service History List

The Service History List service displays a list of services that were previously submitted. Only services whose Add to History field is selected will be included in the Service History List. Select a line and click Open to display the job and parameters. You can change the parameters and submit the service again. To delete a particular service from the list, select the desired entry and click Delete.
Retrieve Records from Silo (ret-01)

This service enables you to retrieve particular descriptive metadata record or object PIDs from the silo. The document numbers can be saved in a file and printed out at a later time. To see the entire descriptive record, use one of the Print services.

You may want to run this service to retrieve records for the purpose of statistics. You could determine, for example, the number of documents each librarian is editing per week. Or you may want to use this function after you run the Global Changes Service (manage-21). The output file produced by this service can be used as input for retrieving records from the silo.

You would often use this service as the first step in a process to save (in a file), or print out, the entire descriptive record for a group of documents. Such a file could also then be used in other services, such as Global Changes (manage-21).

Print Records

The following print record services exist:

- **Custom Format (print-01)** – This service enables you to save in a file or print out the entire descriptive metadata record for a group of documents that have been found using the Retrieve Records from Silo (ret-01) service. You run this service when you want to see a number of complete descriptive metadata records placed one after the other.

- **Print Records (print-04)** – This service enables you to print records, one after the other, on regular-sized sheets of paper that can then be bound together and used for reference.

Build Indexes to the Silo

The following services keep the silo current:

- **Update Word Index (manage-91)** – This service contains a list of words that appear in specific fields of the descriptive metadata records of the database. When the Search function in the Resource Discovery is used, the system checks the Word Index to retrieve all documents containing the keywords entered by the user. It then updates the Word Index of the database. This procedure locks the DigiTool system and should only be run when the load on the system is likely to be low.

Every institution can decide which fields of the descriptive metadata record will be searched by the system. For example, you might decide to provide keyword access to the Publisher field of the descriptive metadata record. To
make this change, add the Publisher to the tab11_word table of the silo’s and/or administrative unit’s tab directory, and then run this service.

You run this service after you have made a change in the tab00.lng table or tab11_word table of the silo’s and/or administrative unit’s tab directory that affects word indexing.

- **Update Sort Index (manage-27)** – This service updates the Sort Index of the database. This procedure locks the DigiTool system and should only be run when the silo is closed.

- **Harvest Repository into Silo (harvest-02)** – This service performs harvesting to objects that are linked to a descriptive metadata or objects with relation type “includes” (parent objects). The service allows you to harvest (collect) objects and metadata from your repository to the silo. You can choose to update the silo with the changes, report on the changes, or recreate the silo from scratch.

  The harvesting_schema.xml file defines the fields of the descriptive record that is the basis for the search function. This file is located in the silo’s data_tab directory.

  This service also updates changes made in the collections and collection’s item count (formerly, p_media_35 and p_media_36). It updates the collection display in Resource discovery. When the service is running in scratch mode, the collection information in Resource Discovery is fully rebuilt. When the service is running in update mode, the collection information in Resource Discovery is updated incrementally.

  You run this service when you make a change in the collections through the Collection Management module or whenever you need to update the Resource Discovery module with the changes made to the repository.

**General**

The following general services maintain the search functionality and database:

- **Create Filing Keys for Names (manage-64)** – This service recreates name keys for borrower data. It should be run if a change has been made to the filing values/rules for the BORROWER_NAME_KEY.

- **Confirm Users (com-03)** – This service produces a report on the updated confirmed users.

- **Global Changes (manage-21)** – This service enables you to change all descriptive metadata records that meet your selection criteria. Alternatively, you can choose not to change the records at this time, but only produce a report of metadata records that are eligible to be changed according to the criteria you enter in this form.

- **Harvesting Records using OAI (media-25)** – This batch service allows you to harvest (collect) metadata from your repository (network server) in

Administration

For detailed information on managing users, refer to the “User Management” section of the DigiTool Configuration Guide.

This section describes:
- Staff Privileges on page 166
- Patron on page 168
- Web Profiles on page 170

Staff Privileges

To access the Staff Privileges form, select DigiTool > Administration > Staff Privileges. The Staff Privileges form opens.

Figure 88: Staff Privileges Form
This form lists the users in the system. To find a user, use the scroll bar or enter part of the user name in the blank text field and press Enter. The list automatically scrolls to the first matching user name.

**NOTE:**
To display only users with the same User Collection as the connected user, select the check box at the top of the screen. If the check box is not selected, users for all collections will be displayed. The buttons on the right side of the window will be activated only when the highlighted user in the list is assigned to the same unit as the connected user.

**Adding a New User**
To add a new staff member to the list of users, click New. The User Password Information form opens, enabling you to fill in the user name, password, cataloger level, and so forth. When you are finished filling in the form, the new user appears in the list of users. To assign access rights to this user, select the name in the list and click Access Rights.

**Modifying a User**
To modify a user’s password or cataloger level, select the name in the list and click Modify User. The User Password Information form opens.

**Duplicating a User**
To add a new user by copying an existing user’s details, highlight a user in the list and click Duplicate User. The User Password Information form opens, enabling you to enter new user information. The new user is assigned the same privileges as the user selected for duplication.

**Deleting a User**
To delete a user, select the user and click Delete. A warning message appears. If you click Yes, the staff user will be removed from the list.

**WARNING!**
Do not delete the DIGITOOL user unless you have first created another user with the access rights to assign passwords. The only way to reinstate the DIGITOOL user is to delete the files that contain user names and passwords, using UTIL A/17/1 (see the DigiTool System Administration Guide). Consult Ex Libris before doing this.
**Access Rights**

To view or modify a user’s access rights to various functions in the system, select the user’s name and click *Access Rights*. Choose the collection you are interested in, and click *OK*. The User’s Access Rights window is displayed.

**Summary**

To view the complete list of collections, functions, and sub-functions to which a user has access, select the user’s name and click *Summary*.

**Patron**

A patron is a non-staff user with access permissions to DigiTool modules. New user registration in the Resource Discovery or the Deposit modules automatically creates a new entry in the Patron List.

To access the Patron List form, select **DigiTool > Administration > Patron**. The Patron List form opens.

![Patron List Form](image)

The Patron List offers a number of options to search for patrons and update patron records. **Table 13** describes these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by... selection box</td>
<td>Determines how the list of patrons is sorted: by patron name, ID, or barcode number.</td>
</tr>
</tbody>
</table>
### Table 13. Options on the Patron List Form

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-confirmed patrons only check box</td>
<td>Displays only those patrons who are non-confirmed (newly registered). To display all patrons, clear this check box.</td>
</tr>
<tr>
<td>Enter Starting Point text box</td>
<td>Jump to a particular point in the list by typing text in the space provided and pressing <strong>Enter</strong>. Text for Patron ID can only be entered in uppercase.</td>
</tr>
<tr>
<td>Modify button</td>
<td>Opens the Global Patron Information form (see Figure 90) for the selected patron, which allows you to edit patron information.</td>
</tr>
<tr>
<td>New button</td>
<td>Opens the Global Patron Information form for a new patron profile. When you are finished filling in the form, the new patron will appear in the list of patrons.</td>
</tr>
<tr>
<td>Duplicate button</td>
<td>Copies an existing patron’s details for use in a new patron’s Global Patron Information form. The new patron is assigned the same privileges as the those of the duplicated patron.</td>
</tr>
<tr>
<td>Delete button</td>
<td>Deletes the selected patron from the Patron List following confirmation through a warning message.</td>
</tr>
</tbody>
</table>
Required fields include **Barcode**, **Verification**, **Expiry Date**, and **Profile ID**.

To confirm the registration of a new registered patron, select the **Confirm Registration** check box located at the bottom of the form. The patron will automatically receive a notification by e-mail and will be able to enter the system as a registered user.

**Web Profiles**

The Web Profiles option enables you to control the Resource Discovery module profiles, such as setting the default search base, e-shelf permissions, personal collection definitions, and so forth.
To access the Profile List, select **DigiTool > Administration > Web Profiles**. The Profile List form opens.

![Profile List Form](image)

Figure 91: Profile List Form

For long lists of IDs, jump to a particular point in the list by typing text in the **Enter Starting Point** text box and pressing **Enter**.

**NOTE:**
Text for Profile ID can only be entered in uppercase letters.

To modify a profile’s information, select the name in the list and click **Modify**. The Profile Information form opens (see **Figure 92**).
(For detailed information on additional button options in the Profile List form, see the identical button names in Table 13 on page 168.)

Utilities

The following utilities are available from the DigiTool menu:

- **Version Check** on page 172
- **Task Manager** on page 173
- **Print History** on page 179
- **Keyboard** on page 180
- **Customize** on page 181
- **Printing** on page 182

**Version Check**

Version Check is a tool used to distribute Meditor client files from a central server to an individual workstation. Integrated inside the Meditor module, it automatically informs you about the latest updates and replaces the older files by the new ones on your request.
For detailed information about the files used in the Version Check, see the documentation on Service Pack installations on the DigiTool Documentation portal.

There are two ways of accessing the Version Check:

- Automatically – The DigiTool Version Check message appears when a new session is started.
- Manually – Using the **Version Check** selection from the DigiTool **Utilities** menu.

### Updating Files from the Version Check

When a new session is started, the system checks if new files have been added to the server and if so, whether they are newer than the corresponding files on the local PC. If new files have been detected on the server and they are newer than the corresponding files on the local PC, an additional check is made in order to detect whether an update has already been performed on the current day. Only one update is allowed per day. If no update has been performed on the current day, the system generates the DigiTool Version Check message.

**To update files:**

1. If the Version Check message does not appear automatically when you start a session, select **DigiTool > Utilities > Version Check**.
   
The Update Version window opens with a list of all the files you need to update.

2. To update all the new files that the system has detected, click **Update All**.
   
   To update selected files, click **Advance**. This opens a list of new files on the server. Select the files that you want to update, and click **Update**.
   
   Both update operations will close the Meditor interface and open it again with the selected files updated.

### Task Manager

The Task Manager is used for monitoring batch reports, processes, and printing.

The Task Manager window has four tabs, one for each function:

- **File List** - View and/or print files.
- **Batch Log** - View the log of a batch procedure.
- **Batch Queue** - View the Batch Queue.
- **Print Daemon** - Set up and activate or deactivate the Print Daemon.
**File List**

To access the File List, open the Task Manager by selecting **DigiTool > Utilities**. By default, the Task Manager opens to the **File List** tab.

![Task Manager - File List Tab](image)

To view a list of print files, choose an administrative unit from the **Connect to** drop-down list at the bottom of the window. The files in the collection’s print directory on the server are displayed in the lower pane. Files that have been copied to the local workstation are displayed in the upper pane.

To change the sort order of files, choose from the **Sort By** drop-down list that is displayed at the bottom of the pane.

To display and/or print a file, the file must be copied from the server list (in the lower pane) to the local list (in the upper pane).
To copy a file:

1. Select the line that corresponds to the file you want to copy from the lower pane.

2. Click the arrow button in the center of the window (or double-click the line corresponding to the file). The Copy Remote File to Local Directory dialog box opens:

   ![Copy Remote File to Local Directory](image)

   Figure 94: Copy Remote File to Local Directory

3. In the Local Filename field, type a new file name for the copied file.

   **NOTE:**
   This enables you to give the copied file a new name in the local directory.

4. Click OK. The file is displayed in the list of local files.

   Four options are now available for viewing and/or printing the file:
   - **Normal Printing** - The file is sent to the workstation’s printer.
   - **Preview** - The file is displayed, after which it can be sent to printing. From Preview, it is possible to print (but not to send e-mail messages).
   - **Raw XML** - Displays the full XML data in Notepad.
   - **Browse XML** - Displays the full XML data in a browser window.

5. Choose the view/print mode from the **Print Configuration** drop-down list at the bottom of the window. Then select the file from the local list (upper pane) and click **Print**.

   The following additional functions are available in the File List:
   - **Delete**: The **Delete** button is functional only for local files. It enables you to delete one local file at a time. You will be prompted to confirm.
   - **Rename**: The **Rename** button is functional only for local files. It enables you to rename a file in the local directory.
   - **Refresh**: The **Refresh** button is functional only for remote files. It refreshes the list from the server.
   - **Mailing a File**: You can choose whether a file is to be printed, sent via e-mail, or both. For example, to print a file, you would select the file, set the
**Print Configuration** to Normal printing, choose an option in the **Setup type** box, and click **Print**.

**NOTE:**
In order for a file to be sent by e-mail, it must be addressed to a specific person (for example, an overdue letter to the patron) with person’s e-mail address specified in this file. Otherwise, the file will be printed and not mailed.

**Batch Log**

The Batch Log lists the batch processes that have run or are currently running.

To view the Batch Log, click the **Batch Log** tab from the Task Manager window.

The upper half of the Batch Log shows the name of the procedure, the PID (that is, the process ID, a unique ID assigned by the system), and the Target Print ID. For each entry highlighted in the upper half of the window, the lower half shows information such as start and end times and log file text.

To filter the list of batch processes for a particular Print ID, choose the relevant Print ID from the **Filter** drop-down list at the bottom of the window.

**Batch Queue**

The Batch Queue lists the batch processes that are waiting in line, ready to be run. To view the Batch Queue, click the **Batch Queue** tab.
A Status line at the top of the window indicates whether or not the queue is running.

To delete an entry from the queue, highlight the entry and click **Delete**. You receive a prompt asking if you are sure you want to delete the entry.

To change an entry’s run time, highlight the entry and click **Change Runtime**. You receive a form for entering the new date and hour for running the procedure.

To stop or start the batch queue, you need to use UTIL C on the server.

The status of the queue (Running or Not Running), and the list of entries in a running queue is dynamic on the server. However, when the Task Manager window is open, the content of the Batch Queue tab does not automatically change. To show the current status, click **Refresh**.

### Print Daemon

The purpose of the Print Daemon is to transfer print files from the server to the workstation for printing. When the daemon is activated on the PC, it periodically looks for files in the print directory of a particular collection that has a specific Print ID, transfers the files to the PC, and prints them on the PC’s default printer. The Print Daemon tab contains the tools for setup and activation of the Print Daemon.

![Print Daemon Tab](image)

*Figure 96: Print Daemon Tab*

Print files created on the server can have a Print ID extension. This extension is determined by the operator in a service or in the `print.ini` file of the Meditor
GUI. Print IDs can be used to identify the file as belonging to a particular person, department, or type of printout, or to identify the printer on which the file should be printed.

**To set up and activate the Print Daemon:**

1. Define the PC workstation’s default printer using the standard Windows procedure for this task.
2. Add the Print IDs that you want to be recognized by the workstation. To do this, click **Setup**. The Print ID Setup dialog box opens:

   ![Print ID Setup dialog box](image)

3. To add a Print ID, place the cursor in the **New Target** field at the bottom of the window and enter a Print ID. Then click **Add**. If you do not want to make any additional changes to the list, click **Close**.

   Remember that the Print ID is the extension of the report name.

   To remove a Print ID from the list, highlight it and click **Delete**. If you do not want to make any additional changes to the list, click **Close**.

4. Choose the collections and Print IDs that will be directed to the workstation's printer. To do this, select the relevant options in the upper and lower panes of the **Print Daemon** tab. After you have made changes, click **Apply**.

   You can choose any combination of print IDs and collections. You can also choose more than one Print ID and collection. In this manner, you can direct all files from a particular collection to the default printer.

5. Activate the Print Daemon by clicking **Activate** on the Print Daemon tab.

   When the Print Daemon is active, the system will look periodically for files of a particular collection that have a particular Print ID and will print them on the PC’s default printer.

   Note that when the Print Daemon is inactive, you can still print a file by viewing a list of files and selecting **Print File**.
Following is an explanation of other options in the Print Daemon tab of the Task Manager window:

- **Lookup Interval** – Instructs the system as to how often it should look for files that need to be printed by the Print Daemon. Enter a number between 001 and 300 (seconds). For example, if you enter 120, the system will check for files every 120 seconds. Values under 100 need leading zeroes (030 for a 30 second interval).

- **View Log** – Click View Log to read the log of print jobs that have been processed by the Print Daemon or errors that have occurred.

- **Clear Log** – Click Clear Log to clear the log display.

- **Show PC/Server Transaction Log** – The PC/Server Transaction Log window shows the activity log. To access it, select DigiTool > Utilities > Show PC/Server Transaction Log. Information on transactions opens in a separate window.

**Print History**

All files that are printed in the Meditor Interface are saved in a history section in the operator’s profile. The Print History function is used to view and/or reprint all files that were printed from the GUI.

To access the print history function, select DigiTool > Utilities > Print History. The Print History window opens.

![Print History Window](image)

The left pane is a navigation tree that lists all the dates and rounded hours of printed files. Each day is a separate node, and each rounded hour is a separate sub-node. Highlight the relevant node to list the names of all the files that were produced in this time period.
The upper right pane lists each of these files and their size. Highlight a file in this list to see the beginning of its contents in XML format in the lower right pane.

Table 14 describes additional fields on the Print History window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh button</td>
<td>Clears the bottom pane of XML.</td>
</tr>
<tr>
<td>Print Configuration drop-down list</td>
<td>Provides the following options.</td>
</tr>
<tr>
<td></td>
<td>■ Normal Printing: Print the file as it was originally printed.</td>
</tr>
<tr>
<td></td>
<td>■ Preview: Preview the printout. You can then click <strong>Print</strong> to print the file.</td>
</tr>
<tr>
<td></td>
<td>■ View Raw XML: View the file in raw XML format in an editor window. This mode can be used for debugging.</td>
</tr>
<tr>
<td></td>
<td>■ Browse XML: View the file in raw XML format in the browser window. This mode can be used for debugging.</td>
</tr>
<tr>
<td>Print Setup drop-down list</td>
<td>Select Y to have the Print Setup window appear before printing. Otherwise select N.</td>
</tr>
<tr>
<td>Setup Type</td>
<td>This field is only enabled when <strong>Normal Printing</strong> is selected in the <strong>Print Configuration</strong> field. Select P to print the file, M to send it by e-mail, or B for both.</td>
</tr>
<tr>
<td>E-Mail Address</td>
<td>Enter the e-mail address here if you are sending the file by e-mail. If the print file includes an e-mail address, it will be displayed here.</td>
</tr>
</tbody>
</table>

**Keyboard**

The Keyboard is a utility that displays a virtual keyboard on your screen. It enables you to insert characters that are not present on your workstation’s standard keyboard. According to the configuration settings, the Keyboard can be divided into tabs, each one displaying a group of characters.

**To use the Keyboard in the Meditor:**

1. Activate the Keyboard in one of the following three ways:
   - Select **DigiTool > Utilities > Activate Keyboard**.
   - Press the **Ctrl+K** shortcut key.
Click the **Activate Keyboard** button on the object bar. The DigiTool Keyboard is displayed in the lower pane.

The characters selected from the keyboard are automatically inserted into the metadata record being edited. These characters are added to the record at the cursor’s last position.

### Customize

You can customize the Meditor interface configuration, the appearance of the main tab, the F1 key, the assigned shortcut keys, and so forth by selecting **DigiTool > Utilities > Customize**. A three-tabbed Customize dialog box opens with the following options:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Configuration</td>
<td>F1 Invokes</td>
<td>Select Help (online, context-sensitive) or Visual Properties (to view Visual Properties window) for F1 to invoke when pressed by user</td>
</tr>
<tr>
<td></td>
<td>Display link field (at bottom of callout bubble)</td>
<td>Check box for displaying or hiding link field.</td>
</tr>
<tr>
<td>Accel. Configuration</td>
<td>Menu Items list</td>
<td>Assign, edit, or remove shortcut keys for menu items.</td>
</tr>
<tr>
<td>Main Tab Configuration</td>
<td>Back color</td>
<td>Select background color for tab in use.</td>
</tr>
</tbody>
</table>
Printing

This function enables you to print the currently displayed metadata.

**To print the currently displayed metadata:**

Press the Ctrl+P shortcut key or select DigiTool > Print.

The Print Format dialog box opens, presenting you with options for the printing format of your record. The metadata record will be printed in the format you select.
Part VI

Collection Management

Part VI contains the following:

- Section 16: Getting Started with Collections on page 185
- Section 17: Collection Maintenance on page 203
Getting Started with Collections

This section introduces the interface and functionality of the Collection Management module in DigiTool.

This section includes:
- About the Collection Management Module on page 185
- Accessing the Collection Management Module on page 186
- The Collection Management Module Interface on page 187
- Building Collections on page 189

About the Collection Management Module

This module allows the institution’s staff to organize objects available in the DigiTool Resource Discovery into structured hierarchical collections with descriptive and enhanced content.

A collection represents a compilation of digital object records or descriptive information arranged and defined in a systematic order to facilitate retrieval. A collection type defines the collection’s characteristics.

There are three collection types in DigiTool: Node, Itemized, and Logical.

- **Node**: A node collection defines a descriptive collection within a hierarchy and consists of sub-collections linked to it, but not objects (directly).

- **Itemized**: An itemized collection consists of digital object records chosen for their relevance to a particular collection’s subject.

- **Logical**: A logical collection consists of digital object records. The content of the collection is defined dynamically by execution of a search query attached to the collection.

The Collection Management module has a Web-based interface that facilitates two main functions:

- Creating collections and sub-collections
Associating objects to collections individually or in bulk

After a collection has been created in the Collection Management interface, it can be made available to Resource Discovery end users. This happens in 2 steps:

- publishing the collection (see Publishing Collections on page 203)
- integrating the collection in Resource Discovery (see Integrating Collections in Resource Discovery on page 209)

After a change in the Collections structure or content, integrating the collection in Resource Discovery should be performed.

**NOTE:**
Collections may be created in the Collection Management interface but not published to the Resource Discovery interface. These collections are known as Suppressed Collections.

---

## Accessing the Collection Management Module

You can access the Collection Management module through the Web client or through the Meditor Windows interface.

**To log on through a Web browser:**

1. In the address bar of your Web browser, enter the appropriate collection management URL set by your institution. By default, this URL is `http://<hostname>:JBOSstown Port/collection`.
   
   For instance: `http://www.university.com:8080/collection`

2. Press Enter.
   
   The Web-based Collection Manager logon form opens.

3. Enter your user name and password and click OK.
   
   If you entered valid ID information, the Collection Management module opens.

**To log on through the Meditor:**

1. Open the Meditor application on your PC.

2. From the launch bar, click the Collections button.
   
   The Windows-based Collection Manager logon form opens inside the Meditor application.
3 Enter your user name and password and click **OK**.

If you entered valid ID information, the Collection Management module opens.

**The Collection Management Module Interface**

The opening page of the Collection Management module lists existing collections in the left pane. (Initially, the right pane is blank.)

![Figure 100: Collection Management Module – Opening View (Main)](image)

The default view, the Main Collection, shows the top-level nodes of each existing collection. The three types of collections are identified by variations in their display:

- Node collections display a small folder within a larger folder (see **Art** in Figure 100, for example) and the number of sub-collections in parentheses after the collection name.

- Itemized collections display a notepad icon inside the larger folder (see **Maps** in Figure 100, for example) and the number of objects in parentheses after the collection name.

- Logical collections display a search icon beside their arrow folder (see **Mystic Seaport** in Figure 100, for example) and the word **Logical** in parentheses after the collection name.
You can view collection contents (sub-collections, objects, or queries) by clicking the arrow folders to the left of each collection name. To see the properties of each collection, click the text of the collection name.

**Collection Map**

Clicking **Collection Map** in the top right corner of the Main Collection view opens the list of collections, sub-collections, their relationships, and hierarchy in a separate window.

![Collection Map](image)

To choose a collection or sub-collection from this view, expand the tree, select the title, and click **OK**. The chosen collection or sub-collection is displayed in the Main Collection view.
**Sub-Collection View**

The sub-collection view allows you to work more closely with a limited number of collections.

Use the bread crumb path or the up arrow button in the toolbar to navigate the hierarchy in this view.

**Building Collections**

Creating individual collections and structuring groups of these collections involves:

- Locating placement or insertion of collections within the hierarchy
- Creating collection details
- Adding objects, search terms, and/or metadata as needed
- Publishing and managing existing collections
Creating Individual Collections or Sub-Collections

You can create new individual collections or sub-collections.

To create a new collection or sub-collection:

1. Navigate to the hierarchical location in which you want to add the new collection. You can do this using the Main Collection view or by using the Collection Map window and browsing to the location.

2. Click the New Collection button.

   The Details form opens.

3. Enter information in the displayed fields, as described in the following table:

   Table 16. Details Form - Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silo</td>
<td>From the drop-down list, choose the name of the silo to which the collection belongs (by default, DigiTool comes with one silo that includes objects from all admin units). The silo is defined for the main node collection and automatically applies to all sub-nodes of the entire collection.</td>
</tr>
</tbody>
</table>
Chapter 16: Getting Started with Collections

4 Click Save.

Your new collection’s detailed information is saved to the system. The collection title displays on the Collection Map and in the left-pane hierarchy of the Main Collection view. You will need this if you want to modify details, add links to digital objects (for itemized collections), connect a logical collection with search terms, or associate metadata with a collection.

To make the new collection available for Resource Discovery end users, two steps must be performed:

- Publishing Collections on page 203
- Integrating Collections in Resource Discovery on page 209

**Linking Objects to Itemized Collections**

Itemized collections contain digital objects. To find and link objects, click the Itemized Collection button beside the collection title.
Any objects already linked to the collection display in the left pane. From the right pane, you can search the Resource Discovery module to find and link additional items.

You can also organize the contents of the itemized collection using the following left-pane options:

Table 17. Itemized Collection Actions

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the full view of the record as seen in the Resource Discovery module</td>
<td>Click a title in the left pane.</td>
</tr>
</tbody>
</table>
## Chapter 16: Getting Started with Collections

### Table 17. Itemized Collection Actions

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the order by which the collections will be displayed in the Resource Discovery</td>
<td>From the header bar, click the list/down-arrow button to sort the list of collections in an A to Z order. From the header bar, click the up or down triangle to define the order of the collections manually. <strong>Note:</strong> Alphabetical order overwrites any previous manually defined collection order.</td>
</tr>
<tr>
<td>Clear the contents of the entire collection</td>
<td>From the header bar, click the Trash button.</td>
</tr>
<tr>
<td>Delete a specific item from the entire collection</td>
<td>Click the Delete button.</td>
</tr>
</tbody>
</table>

### To add items to a new itemized collection:

1. Click the **Itemized Collection** button to enter the new itemized collection.

2. In the right pane, search the Resource Discovery module to find and add additional items. Results from the search display in the right pane.

### Figure 105: Itemized Collection: Resource Discovery Search Results

3. Click the blue left arrow button of the items you want to link to transfer these items to the left pane of the screen.
Linking Objects from the Meditor's Editor

The Meditor contains an additional option for adding individual records to an itemized collection when you are using the Editor feature.

To link objects from the Editor:

1. Click the Collections tab in the lower pane of an open record in the Meditor.

2. Click Link to display the Collection Map.
Figure 107: Collections Tab Link Button

The Collection Map opens in a separate window.

3 Browse the Collection Map items and choose the relevant collection, then click OK.

The object is linked to the relevant collection.

This object is displayed in the Resource Discovery under the specific collection as soon as the collection is published and integrated in the Resource Discovery module.

**Working with Logical Collections**

The logical collection type is defined by one or more search terms. A relevant search query is linked to this collection in order to update the collection’s contents.

If you click the Logical Collection button, the search terms linked to the collection are displayed in the left pane.

From the right pane, you can search the Resource Discovery module in order to change or refine your search query.
From this view, you can also organize the contents of the logical collection using the following options:

Table 18. Logical Collection Options

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate a search in the Resource</td>
<td>Click the <strong>Search</strong> button in the left pane.</td>
</tr>
<tr>
<td>Discovery module on the search terms</td>
<td></td>
</tr>
<tr>
<td>as defined in the left pane</td>
<td></td>
</tr>
<tr>
<td>Clear the contents of the entire</td>
<td>From the header bar, click the <strong>Trash</strong> button.</td>
</tr>
<tr>
<td>collection (deletes the search query</td>
<td></td>
</tr>
<tr>
<td>linked to the entire collection)</td>
<td></td>
</tr>
</tbody>
</table>

**To change a query for a logical collection:**

1. Click the **Logical Collection** button corresponding to the title of the collection.

   The existing search query displays in the left pane. In the right pane, a Resource Discovery search interface opens (see **Figure 108**).

2. Use one of the following methods to update the search query:
Chapter 16: Getting Started with Collections

Conduct a search from the Resource Discovery search interface. This creates a query. From the Results tab of the search, click the **Refine** text link to edit the query.

![Search Interface]

Recreate the existing query by clicking the search button (magnifying glass) on the left pane. Use Refine option from the Results pane to refine the existing query. You can also define the adjacency of the search query—contains, exact, starts with. Default adjacency is contains.

3. Click the blue arrow button at the top of the screen to transfer the search query to the left pane of the screen in order to redefine the collection query. The logical collection content will be updated in Resource Discovery when the collection itself is integrated into the Resource Discovery module.

**Associating Metadata with a Collection**

You can add an object’s metadata to any collection so that the object can be found through the Resource Discovery module.
To associate metadata with a collection:

1. In the Meditor, select **Object > Insert New Object**.
2. Select **Collection_MD** from the **Entity Type** drop-down list.

![New Object Information Form](image)

Figure 109: New Object Information Form

3. Click the **Create** button to close the form and activate the Meditor menu items at the top of the window.

4. Create the object's metadata by selecting **Metadata > Insert New Metadata**, then clicking an option from the submenu.
5 Click the Collection tab in the lower pane and then click Link. The Collection Map opens in a separate window. A magnifying glass indicates that a collection has metadata assigned to it. Only one metadata object can be added to a collection.

6 Select the collection to which you want to link your object’s metadata and click OK. The object’s metadata is linked to the selected collection and can be viewed in the Collections tab in the Meditor’s lower pane.

7 (Optional) Link the object to multiple collections by repeating the above steps.
The metadata can be viewed in the Collection Management module by clicking the magnifying glass button in the Details pane.

**NOTE:**
To be able to access the Collection Management module from the Meditor interface you need to have the appropriate authorizations.

The metadata of such objects is harvested in the same way as other digital entities, providing search capability in Resource Discovery. The resulting record in the Resource Discovery module has a link to the attached collection. If a collection has metadata assigned, an i icon displays beside the collection name in the Collection view. When the user clicks the i sign, the metadata is displayed.
Managing Collections and Sub-Collections

Managing and structuring collections can be performed from the Main Collection view. All views contain the following options:

Table 19. Collection Management Organization

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the order by which the collections are displayed in the Resource Discovery</td>
<td>From the header bar, click ‼️ to sort the list of collections by alphabetical order.</td>
</tr>
<tr>
<td></td>
<td>From the header bar, click ▲▼ to manually define the order of the collections.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Alphabetical order overwrites any previous manually defined collection order.</td>
</tr>
<tr>
<td>Create a new collection</td>
<td>From the header bar, click the <strong>New Collection</strong> button ➕.</td>
</tr>
<tr>
<td>Delete a collection</td>
<td>Click the <strong>Delete</strong> button.</td>
</tr>
<tr>
<td>Publish/suppress collection</td>
<td>Click the inline <strong>Publish/Suppress</strong> button ➖.</td>
</tr>
</tbody>
</table>

After changing the collection structure, run the integration process with Resource Discovery. This will perform corresponding changes in the Resource Discovery collections structure.

Editing Collection Attributes

You can edit the attributes of an existing collection.

**To edit collection attributes:**

1. Select the collection by highlighting the collection’s name in the left pane of the Main Collection view. The collection’s details and attributes appear in the right pane.
2. Make your changes using Table 16 on page 190 as a guide.

**WARNING!**

When you change the **Collection Type** from Logical to Itemized or vice-versa, all the collection’s content is erased.
3 Click **Save**.

You changes are saved in the Collection Management module. To reflect the changes in the Resource Discovery module, run the Resource Discovery integration process.
Collection Maintenance

This section describes collection maintenance.

This section includes:
- Publishing Collections on page 203
- Creating Collections Based on Metadata Information on page 205
- Integrating Collections in Resource Discovery on page 209

Publishing Collections

When you click the Publish/Suppress button, the corresponding collection is selected for publication or non-publication (suppression) in the Resource Discovery module. The actual publication takes place during the into Resource Discovery integration process (see Integrating Collections in Resource Discovery on page 209).
To publish a collection:

1. Click the new collection’s Publish/Suppress button.

![Publish/Suppress button](image)

The following options display in the right pane:

![Publish/Suppress Options](image)

Each collection level of a hierarchy can be selected for publication in one of the following ways:

- **Publish this collection only** – publishes the specific collection only to the Resource Discovery when the actual publishing takes place.

- **Publish this collection and all sub-collections** – publishes the specific collection, including all sub-collections, to the Resource Discovery when the actual publishing takes place.

- **Suppress this collection** – suppresses the specific collection and all its sub-collections when the actual publishing takes place so that this collection and its sub-collections are not displayed in the Resource Discovery view.

**NOTE:**

If **Publish this collection and all sub collections** is selected at the highest level, any sub-collection definitions are overridden.
2 Select one of the three options for your collection and click OK.

All published collections are represented with the relevant icon, according to the collection type, and marked with an embedded blue arrow (see The Collection Management Module Interface on page 187).

Creating Collections Based on Metadata Information

The maintenance job, Build Hierarchical Structures for Collection Management, is available in the Collection Management module interface. This job automatically creates a collection based on metadata.

Prerequisites

The following attributes are required for this job:

- The Data Source defines a metadata type.
- The Field Path defines a metadata field. Any indexed metadata field can be used as a Data Source field for this service. The list of indexed field is available in the j_conf/repository_indexing_schema.xml configuration file.
- The Separator defines the hierarchical path separation. The service takes a specific field within the digital entity/metadata and uses the separator to create a tree structure in the collection from the information in the field. The collection information is added as a new top-level node with sub-collections and itemized contents.

For example, if the institution has a subject field in the structure, Classical Music\Mozart\Salzburg Symphony No. 1, the structure of the field can be leveraged to create a collection tree with three levels.

This service can be run on the entire administrative unit or any subset defined, using the additional parameters of the job.

The output of this service can be reviewed in the Collection Management module’s Collection Map.

To harvest the created collection to the Resource Discovery interface, the Collection Management related service (p_harvest_02_coll_mng or p_harvest_02_coll_mng_conv) must be run. See Services on page 163.

NOTE:

Run this job only over a population that is already harvested to the SILO. If the job runs before the objects have been harvested, the collection tree is created, but it is not populated by objects.
Loading a Hard Disk and Creating a Collection

In conjunction with the above functionality, DigiTool provides a Perl script that can run on a customer’s local PC, scanning a specific disk and/or folder (NFS) hierarchy and creating a CSV load input file. This file contains the hierarchical field, specifying the disk and/or folder (NFS) hierarchy and loading in WebIngest, with a further option to be published as a DigiTool collection.

The script is activated outside of the system on a local PC where a directory/drive is accessible. The script creates a CSV file and copies all file streams under the specified location. The hierarchical structure is stored in the CSV in a variety of different combinations to allow mapping into descriptive fields upon ingest. This field is used when publishing the collection structure.

To create a new itemized collection using a Perl script:

1. Install a Perl Package on your PC. This package can be downloaded using the following URL:

   http://downloads.activestate.com/ActivePerl/Windows/5.8/
   ActivePerl-5.8.8.820-MSWin32-x86-274739.msi

2. Double-click the installation package file to launch the installation wizard:

   ![Figure 114: Active Perl Installation Wizard](image)

3. Follow the wizard steps by reading the instructions until the installation is complete.

4. Open the Meditor and run Version Check (Digitool > Utilities > Version Check), using the default settings($dtl_dev/dtl/pc_exe/sp_exe) followed by $dtl_dev/dtl/pc_exe/sp_conf settings.
Ensure that the `\common\hdconv\` folder exists in your DigiTool installation, including:

- `hdconv.pl` – Perl script
- `params` – Text file for defining script parameters
- `mapping.xml` – The `mapping.xml` file is copied to the relevant directory in order to ensure a proper loading.

![DigiTool Directory for hdconv.pl Perl Script](image)

Edit the `params` configuration file, according to your needs. See the following table for an explanation of the available parameters:

<table>
<thead>
<tr>
<th>Name</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceDir</td>
<td>Yes</td>
<td>The source disk or folder where the files are originally located</td>
</tr>
<tr>
<td>TargetDir</td>
<td>Yes</td>
<td>The target location on a disk where csv file and streams are copied, using the scanning script, for future upload to DigiTool</td>
</tr>
<tr>
<td>TargetDirMetadata</td>
<td>No. Used when metadata files location is separate from streams location.</td>
<td>The target location on a disk dedicated for csv and <code>mapping.xml</code> files for future upload to DigiTool</td>
</tr>
<tr>
<td>TargetDirStream</td>
<td>No</td>
<td>The target location on a disk dedicated for copying streams, using unique file names, for future upload to DigiTool</td>
</tr>
<tr>
<td>MappingFile</td>
<td>Yes</td>
<td>The name of the <code>mapping.xml</code> file for future upload to DigiTool</td>
</tr>
</tbody>
</table>
The following is an example of the params file:

```perl
%params=(
    SourceDir=>"C:\Classical Music",
    TargetDir=>"C:\Classical Music 1",
    #TargetDirMetadata=>"C:\Classical Music 2\metadata",
    #TargetDirStream=>"C:\Classical Music 2\streams",
    FileFilter=>["bat", "com", "lst","db"],
    IdStartNumber=>1,
    MappingFile=>"mapping.xml",
    MultipleLoadDirectories=>N,
);
```

**NOTE:**
#TargetDirMetadata and #TargetDirStream parameters are commented out with the # sign in the beginning of the line.

In the above example, the source directory, as specified in the params SourceDir, is C:\Classical Music, which contains mp3 objects.

To publish the collection structure:

1. Double-click hdconv.pl to run the Perl script. The output of the scanning is located in the target directory folder as specified in the params TargetDir (in the above example, C:\Classical Music 1).

<table>
<thead>
<tr>
<th>Name</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileFilter</td>
<td>No</td>
<td>The parameter providing the ability to filter out certain irrelevant types of files. For example: Thumbs.db</td>
</tr>
</tbody>
</table>

![Figure 116: TargetDir Output](image-url)
2 Upload data using the CSV transformer in the DigiTool Ingest interface. For upload instructions, see Upload – Step 4 on page 89.

3 Run a new Build Hierarchical Structures for Collection Management job on the metadata field, expressing a disk and/or folder hierarchy. The default mapping.xml is configured to map the disk hierarchy as a dc:relation field, but can be edited by customer according to the institution’s requirements. The output of this service can be reviewed from the Collection Management module interface where the collections are created and published.

Integrate collections into the Resource Discovery interface using the collection management related services called by p_harvest_02. For details, see Integrating Collections in Resource Discovery on page 209.

The final output can be reviewed from the Resource Discovery interface where the collections are integrated.

**Integrating Collections in Resource Discovery**

To integrate collections that have been marked for publish in the institution’s Resource Discovery, run the p_harvest_02 service from the Meditor’s Services menu or from the command line. This service is described in detail in Services on page 163.
Part VII

Jobs and Reports

Part VII contains the following:

- Section 18: Job Management on page 213
- Section 19: Viewing Reports on page 229
This chapter describes how jobs can be refined and managed using the DigiTool Management module interface.

### How Jobs Work

Jobs are the different maintenance tasks a staff user can perform on certain types of repository items, such as digital entities, streams, metadata, deposit activities, ingest activities, or configuration files. When the target of the job is a group of digital entities, the user can also conduct a search on the existing repository database to further narrow the pool of objects on which the job will be performed.

To submit a job, from the Maintenance navigation link on the Management interface, click the **Submit a New Job** sub-navigation link. This launches the maintenance job wizard. Choose the job name. If relevant, conduct a search to limit the objects on which you want to perform the job. Then define the exact range of the job activity. After you have entered the details of your requested run, you are asked to confirm the action. After confirmation, you can follow the execution of your job using the Monitor page (which links to the specific job’s log) and the Job List page.
Accessing Jobs

To work with jobs, you must log on to the Management module. See Logging On on page 15 for general instructions on how to log on. For the Management module, use mng as your module name in the URL.

To access the job management section of the module:

1. Log on to the Management module with your user name and password.

NOTE:
You must have permission to access the Management module. If you do not, you will be unable to log on to the module.

2. From the opening page of the Management module, click Maintenance on the top-level toolbar.

   The Maintenance section opens with the Submit a new job link active. You are on the first step of the new job wizard.

---

Figure 118: Maintenance Page, Submit Job (Default View)
Job Descriptions

By default, all available jobs are listed in the left pane of the Management window. If they are not, click the **Submit a New Job** link in the toolbar and a list of jobs available on the current DigiTool server displays. (See Figure 118.)

A drop-down filter allows you to view jobs by group:

- **All**
- **General** – For details, see General on page 215.
- **Report** – For details, see Report on page 216.
- **Processing** – For details, see Processing on page 216.
- **Cleanup** – For details, see Cleanup on page 217.
- **Index** – For details, see Indexing on page 217.

**NOTE:**
For more detailed information on each job, consult the context-sensitive help file for each job in the Management module. Some jobs are run on an administrative unit basis and some are run globally in the Repository. For information on globally run jobs, see **Global Maintenance Jobs** on page 217.

**General**

- **ALEPH Enrichment** – Imports Aleph metadata to DigiTool.
- **Delete Digital Entities** – Deletes a group of digital entities. Can also delete related objects and related metadata. The range can be defined by one or more criteria such as ingest ID, creation date, and creator name.
- **Delete Unlinked Metadata Objects** – Deletes unlinked metadata records in a specific range.
- **Export Digital Entities** – Exports a range of digital entities. Output can be used to import to another DigiTool system. Streams can be exported along with digital entities.
- **Metadata Update** – Allows for adding and updating metadata in a selective batch mode, by type of metadata.
- **Metadata Global Changes** – Perform batch changes to descriptive and access rights metadata in the repository.
- **Reload Repository Configuration** – Reloads the repository configuration from **repository_configuration.xml** in the **general conf** directory (`j_conf`).
- **Repository Replication** – Allows for the replication of the repository. Important for OAI, backup, and other uses.


- **Create Link to Parent Relation** – creates a ‘Part of’ relation to objects between a Digital Entity and the given parental PID (if there are no other parent/child links).

**Report**

- **Count Repository Objects** – Counts the number of digital objects in the repository.

- **Count Repository Streams** – Counts the number of file streams in the repository.

- **Digital Entities Viewing Reports** – Allows for limited statistical reporting on the viewing of digital entities.

- **Statistic Reports for Metadata, Digital Entities, and Collections** – Allows you to create a report with information on new or updated metadata, digital entities, and collections.

**Processing**

- **Checksum** – Calculates checksum according to one of three methods and compares the result checksum stored in the technical metadata of the object, if the object has one.

- **Full Text** – Extracts all text from the stream related to the object (if there is one and only if it is Word/PDF/plain text) into a new stream (.txt file). The job then creates a new object pointing to the new stream and creates a manifestation relation between the old and new objects. The job can overwrite an already existing full text stream.

- **Generate Persistent Identifier** – Generates a persistent identifier for a resource (object), such as Handle or URN.

- **JPEG2000** – Allows the generation of JPEG2000 images from .tiff files.

- **Publish Persistent Identifier** – Publishes persistent identifiers such as those created by the Generate Persistent Identifier service.

- **Remote Stream** – Queries the remote system about URLs stored in DigiTool for validation/information/copying content.

- **Technical Metadata Extractor** – Extracts technical metadata of the stream related to the object (if there is one) and relates the metadata record to the digital entity.
Chapter 18: Job Management

- **Thumbnail** – Creates a thumbnail from the stream related to the object (if there is one and only if it is an image/PDF) into a new stream (JPG file). The job then creates a new object pointing to the new stream and creates a manifestation relation between the old and new objects. The job can overwrite the already existing thumbnail stream.

- **Assign Control Attributes** – For information on this job, see Control Section Attribute Assignment on page 88.

**Cleanup**

- **Remove Empty Storage Directories** – In the course of deleting digital entities, some directories that were created during ingest may still remain, but are now empty. This job removes these empty storage directories.

- **Remove Old Deposit Activities** – Removes deposit activities from the display of deposit jobs. The range of jobs to remove is defined by the folder to which they belong and their last modification date.

- **Remove Old Ingest Activities** – Removes ingest activities from the display of ingest jobs. The range of jobs to remove is defined by the folder to which they belong and their last modification date.

- **Remove Viewers Cache** – For faster response, DigiTool maintains a cache of viewed objects. This cache should periodically be cleared, depending on how much viewing traffic is experienced. This job clears the cache.

**Indexing**

- **Build Hierarchical Structure for Collection Management** – Builds hierarchical structure based on a number of criteria, but related to maintaining directory trees, such as in an ingest for which folder trees in e-mail boxes may need to be preserved in their original hierarchical order.

- **Metadata ReIndex** – Allows re-indexing of metadata by specific type of metadata (e.g. MARC, Dublin Core, and so forth).

- **Re-Indexing Job** – Re-indexes digital entities in a user-defined range.

**Global Maintenance Jobs**

Some maintenance jobs can be run globally—that is, across all administrative units. These are DigiTool Repository-wide jobs. In order to run these jobs, the staff user must be in the admin group and have specific permissions to run jobs on REP00.
NOTE:
These permissions are assigned to the staff user through the Meditor. All management permissions for REP00 and any Repository-specific functions should be assigned to those who need to run these jobs.

Reports, Processing, and Indexing jobs at this level are identical to those available on the administrative-unit level, except that they can be run globally, across administrative units.

Additional jobs that can be run globally are:

- **General**
  - Delete/Export Digital Entities across all Admin Units
  - Delete Unlinked Metadata across all Admin Units
  - Reload Repository Configuration
  - Repository Replication
  - Rebuild Object Cache

- **Cleanup**
  - Remove Old Deposit/Ingest Activities across all Admin Units
  - Remove Empty Storage Directories
  - Remove Viewers Cache

Unless the staff user is working in REP00 and authorized to run these jobs, the jobs do not appear in the list of available maintenance jobs.
Submitting a New Job

To submit a new job:

1. From the Maintenance job selection page, select the job you want from the list and click **Next**.

![Figure 119: New Maintenance Job, Step 1](image)

If your job performs actions on digital objects, step 2 of the wizard will open.
This step allows you to conduct a simple or advanced search to narrow the scope of digital objects for your job. If your job does not impact actual objects, the wizard moves you directly to step 3.

2 Conduct a simple or advanced search to return the objects you want. For example, if you want to perform a job on images of a certain type, perform a File Extension search using the extension for that type (see Figure 121).

**NOTE:**
For more information on searching, see Search in Repository on page 156.
When you have successfully retrieved the digital entities on which you want to perform the job, click the **Next** button.

The third page of the wizard opens (**Figure 122**). The contents of this page may vary, depending on the job you have chosen to run.

<table>
<thead>
<tr>
<th>#</th>
<th>Delivery</th>
<th>Metadata</th>
<th>PID</th>
<th>Label</th>
<th>Usage Type</th>
<th>Entity Type</th>
<th>Mime Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>DTL02001400007</td>
<td>Don Quixote VIEW</td>
<td>image/bmp</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>DTL02001400007</td>
<td>Phoenix, Blue VIEW</td>
<td>image/bmp</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To run the job immediately, leave the default **Start ASAP** in the Scheduling field. To set a precise date or a recurring run, click the calendar/clock icon.

The Scheduling dialog box opens (**Figure 123**).
6 Select the type of scheduling you want: immediate, one time only, or a regularly run job at daily, weekly, or monthly intervals. Your selection determines the remaining fields you need to enter (for example, see Figure 124).

![Scheduling Dialog — Webpage Dialog](image)

**Figure 124: Job Scheduled Monthly**

7 Enter information for the remaining scheduling details and click **OK**.

8 Enter information for any of the remaining ranges or parameters on the additional details page and click **Next**.

The confirmation page for the job wizard opens (Figure 125).
9 Confirm or cancel the job by clicking the appropriate button. Or use the Back button to return to Step 3.

The job runs as specified by you in the 4-step wizard.

**Job List Page**

You can view jobs already submitted for running by clicking **Job List**.

A search bar for choosing the jobs you want to view opens at the top of the main pane.

Choose what jobs to display and in what order you want them to be displayed and click the **List** button.

Jobs displayed on this page can be filtered by one or more of the following criteria:

- **Job Name** – Shows all jobs or jobs of one type only. For a list of jobs, see **Submitting a New Job** on page 219.
- **Admin Unit** – Shows jobs run under one specific unit or under all units.
Job Status – Shows jobs of one specific status or of all statuses. By default the Running status is selected. Possible statuses are: Aborted, Completed, Failed, Running, Scheduled, and Sys Abort.

Created – Shows jobs created on the current date, in the last week, in the last month, or all jobs.

Jobs displayed can be sorted by any of the display criteria and by job ID. as shown in Figure 127.

![Job List Display](image)

When sorting by job ID or start time, DigiTool displays the jobs in descending order (so that the last jobs are listed first). All other sort results are displayed in ascending order.

The following actions are available:

- **View (eye)** – Click to view details of any jobs, except for those with the status Scheduled.
- **Delete (X)** – Click to delete the details of completed/failed/aborted jobs.

**Monitor Page**

You can quickly view the jobs you have scheduled, the jobs you have running, and the jobs that have been processed by clicking **Monitor** on the sub-navigation bar of the Maintenance section. The three categories of jobs—scheduled, running, and processed—display on the Monitor Web page (Figure 128).
To view the details of a specific job, click the View (eye) icon on the same line as your job.

**Job Details Window**

The job details window opens when you click a job’s view button from the Job List page or from the Monitor page.

The following types of information are available in this window:

- **Monitor** – available for jobs with the Running status, it displays the name of the running job, job details (start time, status and parameters), and the last 10 messages in the job log.

- **Summary** – When a job is completed (or failed or aborted), the Monitor text link (and page view) is replaced by a Summary link. This view displays a report about the run of the job whose View button you clicked.

- **Success** – Each line represents a block of 1000 successful actions of the job. Each block can be viewed separately.

- **Failed** – Each line represents a block of 1000 failed actions of the job. Each block can be viewed separately.
Log – Each line represents a block of 1000 actions of the job. Each block can be viewed separately. If you click the View button, a separate, larger window opens to accommodate a step-by-step list of actions the job performed and the results of these actions (see Figure 129).

```
2008-10-12 15:52:27,545 - STARTED
2008-10-12 15:52:27,545 - Job ID: 2640
2008-10-12 15:52:27,545 - Job parameters;
2008-10-12 15:52:27,545 - replicationName=oai_pub, numberOfThreads=1
2008-10-12 15:52:27,545 - Beginning execute internal.
2008-10-12 15:52:27,563 - Replication job - starts
2008-10-12 15:52:27,563 - getLastUpdateDate START.
2008-10-12 15:52:27,564 - getLastUpdateDate tfile=/exlibris/dt1/j3_1/dt1
2008-10-12 15:52:27,586 - No timestamp file found, will reset
2008-10-12 15:52:27,586 - replicating from date - null
2008-10-12 15:52:27,625 - Using the following conversion Styles:
2008-10-12 15:52:27,625 - DC-->SIMPLE DC : /exlibris/dt1/j3_1/dt1
2008-10-12 15:52:27,625 - MARC-->DC : /exlibris/dt1/j3_1/dt1
2008-10-12 15:52:27,625 - MODS-->MARC : /exlibris/dt1/j3_1/dt1
2008-10-12 15:52:27,756 - Using the following conversion Styles:
2008-10-12 15:52:27,756 - DC-->MARC : /exlibris/dt1/j3_1/dt1
2008-10-12 15:52:27,757 - MODS-->MARC : /exlibris/dt1/j3_1/dt1
2008-10-12 15:52:28,142 - Get Set Iterator - starts
2008-10-12 15:52:28,142 - Get Set Iterator - finished, executed
2008-10-12 15:52:28,142 - SQL - select distinct hcs.pmd, hcs.crc
2008-10-12 15:52:28,142 - update Set - starts
2008-10-12 15:52:28,198 - write - starts
2008-10-12 15:52:28,198 - buildDB8Record - starts
```

Figure 129: Job Log
Viewing Reports

This section includes:
- Setting up BIRT Reports on page 229
- Accessing Reports on page 231
- Global Report Functions on page 232
- Viewing the Collection Distribution Summary Report on page 233
- Viewing the Delivery Usage Statistics Report on page 235

Setting up BIRT Reports

The following components are essential to the setup and function of all BIRT reports.

**New Database Schema: rpt00**

A new database schema, rpt00, contains views that facilitate a BIRT report creation. The schema has select permissions on rep00 tables.

The username and password of the rpt00 schema are defined in the global.properties file as:

- `dbconnection.report.username=d3@_AL_COPY_rpt00`
- `dbconnection.report.password=d3@_AL_COPY_rpt00`

When running `set_globals.sh` script, the parameters are overwritten in `$jdtl_jb_def_deploy\digitool-report.war\report\digitoollib.rptlibrary:`
Reports Location

BIRT reports are located in $jdtl_jb_def_deploy\digitool-report.war\report.

Reports Tab Contents

The content of the Reports tab (see Figure 130) is defined in the birt_reports_list.xml file, which is located in j_conf.

For example:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<rb:rb_reports_configuration xmlns:rb="http://com/exlibris/digitool/common/birt/reports/xmlbeans">
  <birt_reports_list>
    <birt_report>
      <report_name>Collection Distribution Summary</report_name>
    </birt_report>
  </birt_reports_list>
</rb:rb_reports_configuration>
```

New Report Creation

To create a new BIRT report, the following tasks must be performed:

- Download the BIRT Report Designer from http://download.eclipse.org/birt/downloads/ (requirement: JAVA 1.5 runtime)
Chapter 19: Viewing Reports

- Create new report using $jdtl_jb_def_deploy\digitool-report.war\report\digitoollib.rptlibrary data sources
- Place the new report in $jdtl_jb_def_deploy\digitool-report.war\report
- Update birt_reports_list.xml with the new report url
- Run the Reload configuration job to update the content of the Reports page on the Management interface.

Accessing Reports

Reports are available to any staff user, with any type of authorization, from DigiTool’s Management module.

To log on to the Management module and access the reports:

1. In your Web browser, enter the appropriate URL set by your institution. By default, this URL is:
   http://<hostname>:JBOSS_PORT/mng
   For example:
   http://www.university.com:1801/mng
   Alternatively, enter the general DigiTool URL set by your institution and then select the Management interface. By default, this URL is:
   http://<hostname>:HTTPD_PORT/main
   For example:
   http://www.university.com:8881/main
   A login box opens.
2. Type your staff user name and password.
3. Click OK.
   An opening page with the default view in the repository search appears.

NOTE:
You can also enter the Management interface from the DigiTool Meditor GUI. (On the launch bar, click the Management button.)
4 To view the reports, click **Reports** on the top-level navigation bar.

![ExLibris DigiTool – Management](image)

**Report selection**

- Collection Distribution Summary
- Delivery Usage Statistics

![Figure 130: Accessing Reports](image)

The available reports are listed under **Report selection**. Click the name of a report to display it in the BIRT Report Viewer (Figure 131).

![BIRT Report Viewer](image)

**Collection Distribution Summary**

<table>
<thead>
<tr>
<th>Collection ID</th>
<th>Collection Name</th>
<th>Number of Files</th>
<th>Size of Collection in MB</th>
</tr>
</thead>
</table>

![Figure 131: BIRT Report Viewer](image)

**Global Report Functions**

The following functions can be performed for each report using the buttons in the top-level toolbar:

- **Toggle table of contents** – shows/hides the report’s table of contents in the left pane
- **Run report** – enables you to regenerate the current report
- **Export data** – enables you to export the data in the report to a CSV file
- **Export report** – enables you to export either the entire report or specific pages of the report to one of the following types of files: Word, PowerPoint, PDF, PostScript, or Excel
- **Print report** – enables you to print the entire report or specific pages of the report, in either HTML or PDF format, to your local printer
- **Print report on the server** – enables you to print the report to a network printer

If a report contains multiple pages, you can navigate between these pages using the **First page, Previous page, Next page, and Last page** buttons in the top right corner of the report. To navigate to a specific page, enter this page number in the **Go to page** box and click the **Go to** arrow.

**NOTE:**
If a job fails, this failure will appear on the maintenance monitoring pages with failed status and exception details (job’s name and exception). From the Management module, click the **Maintenance** navigation text, then the **Monitoring** sub-navigation text.

---

### Viewing the Collection Distribution Summary Report

By default, if you have not created customized reports, the Collection Distribution Summary report will be available on the **Reports** tab (along with the Delivery Usage Statistics report).

When you click the **Collection Distribution Summary** link from the **Reports** tab, the BIRT Report Viewer opens, displaying the following information for each itemized or logical collection:

- collection ID number
- collection name
- the number of digital objects contained in the collection (which includes the actual number of digital entities in the collection and sub-collections)
- the size of the collection, in MB (which also includes the file size of digital entities related to the collection and sub-collections)

See **Figure 132** below.
If a collection contains other collections, the data in the **Number of Digital Objects and Size of Collection in MB** columns is a summary of the data in each of the collection’s sub-collections. In addition, the ID of a collection with sub-collections is clickable. When you click the collection’s ID, an additional window opens, displaying data for each sub-collection.

You can sort the information displayed in the table by ID number, collection name, the number of digital objects contained in the collection, or the size of the collection by clicking the appropriate column title. The information is sorted in ascending order.

Below the table are pie charts that display the percentage share of each collection (and sub-collection, if a collection contains other collections) in the total number of collection digital objects and total size of all collections.
NOTES:

- You can search a logical collection using the Resource Discovery.

- The information displayed in the Collection Distribution Summary report is a result of the Collection Distribution job (which cannot be maintained using the Management module’s Job List) that runs nightly at 2 AM. Collection changes that occur after this time will be included in the following day’s updated report. The report’s date is indicated in the top right corner of the report.

- The information displayed in the Collection Distribution Summary report is based on data from the following tables: RPTCollectionDistribution, HdeStreamRef, and HRdCollectionItem. The data in the RPTCollectionDistribution table is saved for three months. Data that is older than three months is deleted from this table and does not appear in the Collection Distribution Summary report.

### Viewing the Delivery Usage Statistics Report

The Delivery Usage Statistics report (Figure 133) contains information about used and unused objects in Delivery.

**NOTE:**

Depending on your user logon rights, you may see additional information and graphics to those shown in Figure 133 in your Delivery Usage report.
Used Delivery objects are counted on runtime from requests received by the Delivery Manager.

Unused Delivery objects are calculated once a month (last day of the month) by the batch job.

The report is able to show results:

- for defined dates
- and by admin unit and/or collection (only top level of collections)

**Restrictions**

- The unused report of collection usage is created for itemized collections only (not logical)
- The report data on unused objects is generated once a month (at 23:50 of the last day of every month)
- The request from RD contains the top collection ID if it came from the collection browsing flow
The report data is stored in the database for 12 months. This value is configurable. Batch job removes objects from summary tables that are older than `usage_report_expiration_date*31 days` (new parameter in `repository_configuration.xml`).

New and Updated Tables

Table 21. Tables for Delivery Usage Report

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPTDeliverableDE</td>
<td>Contains the summary of unrequested and requested objects</td>
</tr>
<tr>
<td>RPTCollectionDelivery Usage</td>
<td>Contains data collection browsing usage, received from resource discovery</td>
</tr>
<tr>
<td>HdeAccessLog</td>
<td>Additional columns to support report needs</td>
</tr>
<tr>
<td>SUM_ACCESS_TRG</td>
<td>Trigger that catches requests for delivery and updates the number of requests fields in the RPTDeliverableDE and RPTCollectionDeliveryUsage tables</td>
</tr>
</tbody>
</table>

Adding More Tablespace

You might consider adding tablespace for the following new tables:

- RPTDeliverableDE: (number of rows in HdeControl)*12*(0.0002) MB
- RPTCollectionDeliveryUsage: (size of HRDCOLLECTION table)*90

Command line scripts

`j_bin -> batchJobInvoker.sh`
Index

A
Access Rights
  copyright, 148
  editing, expression, 149
  enable/disable, 148
  expressions
    editing, 148
    grouping/ungrouping, 150
    new, 148
  insert snippet, 149
  metadata form, 147
  negating condition, 148
  Within/Equals, 148
Approver
  deposits
    approve, 63
    decline, 63
    filter, 60
    notes, 58
    return, 62
    reviewing, 60
    status, 56
  e-mail notification, 58
Files tab, 61
folders, 56
information table, 44
metadata form, 44
module, 31
notes, 46
preview, 42
process, 32
profile, 33
registration, 32
status, 45
submission, 37
tracking, 55
upload files, 41
wizard, 37
Managing, 201
map, 188
objects
  linking, 191
  metadata, 197
  Resource Discovery, 192
  publishing, 203
  Resource Discovery, 209
  sub-collections, 189
  types, 185, 187
Collection Distribution Summary report, 233
Collection Management, 185
  accessing, 186
  interface, 187
  sub-collection view, 189
Collection Map, 194
collection
context-sensitive help, 18
copyright declaration, 148
D
deleting metadata, 152
Delivery Usage Statistics report, 235
Deposit
  editing, 48
e-mail notifications, 46
Folders view, 44
full view, 57
information table, 44
metadata form, 44
module, 31
notes, 46
preview, 42
process, 32
profile, 33
registration, 32
status, 45
submission, 37
tracking, 55
upload files, 41
wizard, 37
digital entities, 101
Dublin Core, editing, 146
E
editing
Access Rights, 147
Access Rights expression, 148, 149
collection attributes, 201
Dublin Core, 146
Ingest activity, 97
MARC
  contents, 133
  forms, 138
  indicator, 133
  metadata, 131
  records, 132
  subfield code, 133
  tag, 132
metadata, 126
  description, 152
  locking/unlocking, 151
  saving, 150
XML tags, 127

I
Ingest
  activity, 70–72, 97
  Activate, 71
  assign, 78
  defining, 73
  Delete, 71
  Edit, 71
  parameters, 84
  Rollback, 71
  Track Activities, 72
  View, 72
availability of URLs, 93
Create a New Task Chain, 83
default view, 68
download remote files, 93
flows, 95
folder view, 68
interface, 68
local files, 89
logging on, 68
module, 67
note, 79
post-upload, 93, 94
remote files, 92
scheduling, 78
server files, 91
status
  Failed, 70
  Not Scheduled, 69
  Running, 69
  Scheduled, 69
  Success, 70
task
  Add History Event, 87
  Add Metadata, 85
chain, 79–83, 96
Control Section Attribute Assignment, 88
Full Text Extraction, 88
Premis Metadata Creation with PI, 86
Remote Stream Download, 87
Technical Metadata Extraction, 86
Thumbnail Creation, 85
Tiff to Jp2 converter, 87
type, 75
coma separated value (.csv), 77
Dublin Core XML, 76
exported DigiTool repository elements, 77
file stream, 75, 78
MARC XML, 76
METS XML, 77
MODS XML, 78
upload, 89
Upload page, 96
Ingest Flows section, 95

J
Job List page, 213, 224
jobs, 213
  accessing, 214
  cleanup, 217
  descriptions, 215
  general, 215
  global maintenance, 217
  indexing, 217
  Monitor page, 225
  new, 219
  processing, 216
  reports, 216
  repository search, 220
  Scheduling dialog box, 222
  view details, 226

L
logging off, 18
logging on, 15
  Approver, 54
  Ingest, 68
  Meditor, 17
  Web interface, 16
logon box
  Meditor, 17
  Web, 17
M
Management jobs, 213
MARC
   editing functions, 134–138
   forms, 138
   metadata, 131
Meditor
   accessing, 107
   administration, 166–172
   patron, 168
   staff privileges, 166
   Web profiles, 170
Collection Management, 200
   create new metadata, 121
   digital entities, 101
   insert new metadata, 122
   interface, 102–106
   launch bar, 105
   linking objects to collections, 194
   menu bar, 103
   navigation tree, 105
   object bar, 104
   objects, 101, 109–120
      adding, 109
      duplicate, 112
      Includes, 118
      Last Accessed, 116
      linking to collections, 119
      Manifestations, 118
      navigation tree, 116
      Open on Local Drive, 117
      Part of, 118
      services, 115
      view/refresh, 119
   operations bar, 104
   search, 155
      add object to collection, 161
      Collection Manager, 160
      collections, 160
      external databases, 158
      from Management, 161
      metadata, 125
      repository, 156
      Resource Discovery, 158
   services, 163–166
      build indexes, 164
      general, 165
      history list, 163
      print records, 164
      retrieve records from silo, 164
   templates, 123
   title bar, 103
   upload metadata, 124
   utilities, 172–182
   customize, 181
   keyboard, 180
   print history, 179
   printing, 182
   Task Manager, 173
   version check, 172
XML editor, 127
metadata
   Access Rights, 147
   create, 121
   creating collections, 205–209
   Dublin Core, 146
   editing, 126
      locking/unlocking, 151
   insert new, 122
   link/copy to object, 125
   MARC, 131
   saving, 150
      on local drive, 150
      on server, 150
   search, 125
   templates, 123
   types, 102
   updating, 152
   upload from local drive, 124
module
   Approver, 53
   Collection Management, 185
   Deposit, 31
   Ingest, 67
   main menu, 16

R
registration form, 34
reports, 231–237
   access, 231
   BIRT, 232, 233
   Collection Distribution Summary, 233
   Delivery Usage Statistics, 235
   functions, 232

S
search, 19–28
   advanced
      digital entity, 23
      metadata, 26
   exact, 22
   metadata, 125
   repository, 21
      digital entity, 21
      jobs wizard, 220
      metadata, 25
   Resource Discovery, 19
   results
digital entity, 24
metadata, 27
simple
digital entity, 21
metadata, 25

U
upload
local files, 89
remote files, 92
server files, 91

X
XML
editor, 127
functions, 128–131
tags, 127